
 User Guide

Using and Removing the User Guide

Printing

Printer Driver

Paper

Troubleshooting

Replacing a Print Cartridge

Sharing the Printer

Inquiries and Consumables

Additional Information

Copyright © 2004 All rights reserved.

Contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index.htm2005/10/05 11:21:16

Contents All Titles Settings

javascript:SetWord2_i();


Using and Removing the User Guide

Using the User Guide

Removing the User Guide

Top

Copyright © 2004 All rights reserved.

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_01.htm2005/10/05 11:21:18

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Printing

Printing on Various Paper Types

Printing on Plain Paper

Printing on Thick Paper

Printing on Inkjet Plain Paper

Printing on Inkjet Transparency

Printing on Semi-gloss Photo Paper

Printing on Envelopes

Canceling Printing

Canceling Printing from the Printer Status Monitor

Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing from the Taskbar

Adjusting Print Quality

Printing Using Preset Print Quality Settings

Printing in Black and White

Saving Color Ink When Printing

Printing with Print Quality Settings You Want

Changing Image Printing Method

Correcting the Hue of Digital Photos

Printing Low Resolution Images Smoothly

Changing the Dither Pattern

Changing the Color Profiling Pattern

Printing Grayscale Images Using Black or CMYK

Printing Text in Black

Using ICM

Adjusting Brightness, Contrast, and Saturation

Adjusting Color Balance

Printing a Whole Page as an Image

Changing the Image Data Process

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_02.htm (1 of 3)2005/10/05 11:21:20

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Chapter contents - - User Guide

Printing with Particular CMYK Colors

Printing Images Vividly

Various Print Functions

Printing Multiple Document Sets

Collating

Printing Web Pages

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Reducing to A4/Letter Automatically

Rotating the Image by 180 Degrees

Printing on Registered Custom Size Paper

Printing on Unregistered Custom Size Paper

Printing on Both Sides of Paper

Printing Multiple Document Pages per Sheet (Layout)

Splitting the Document Image across Multiple Sheets (Poster)

Printing from the Last Page

Creating a Binding Margin

Printing Documents with a Header and Footer

Printing with a Layout Suitable for Making Booklets

Printing Images or Text Superimposed on Prints

Creating a New Watermark

Printing Documents with an Overlay Image Superimposed (Overlay)

Creating a New Overlay Image File

Deleting an Overlay Image File

Creating a New Overlay Set

Custom Settings

Printing

Registering

Changing the Name

Deleting

Updating Custom Settings According to the Current Printer Configuration

Changing the Custom Settings Display Order

Saving a Registered Custom Setting in a File

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_02.htm (2 of 3)2005/10/05 11:21:20



Chapter contents - - User Guide

Registering a Custom Setting Using a Custom Setting File

Top

Copyright © 2004 All rights reserved.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_02.htm (3 of 3)2005/10/05 11:21:20



Printer Driver

Opening the Printer Properties Dialog Box

Opening from the Start Menu

For Windows 95/98/Me

For Windows 2000, Windows NT 4.0

For Windows XP, Windows Server 2003

 Opening from an Application

Displaying the Printer Status

Opening the Printer Status Monitor

Printer Properties Settings

Using Help

Displaying an Explanation for Each Setting Item (Context Help)

Displaying Help in a Help Window (Content Help)

 Checking Whether Bidirectional Communication is Working or Not

Maintaining the Printer Using Utilities

Nozzle Check

Clean Print-heads (Normal)

Clean Print-heads (Full)

Adjust Print-head Positions

Registration

Adjust Paper Feed

Restore Defaults/Other Settings

Restoring the Settings to Their Defaults

Specifying an I/O Timeout

Checking the Current Printer Driver Version

Uninstalling the Printer Driver

Top

Copyright © 2004 All rights reserved.

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_03.htm2005/10/05 11:21:21

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Paper

Loading Paper

Loading Paper into Tray 1

Loading Paper into Tray 2 (optional)

Loading Paper Larger than A4 (Letter)

Compatible Paper

Compatible Paper Types

Compatible Paper Sizes

Paper Handling Precautions

Printable Area

Non-compatible Paper

Top

Copyright © 2004 All rights reserved.

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_04.htm2005/10/05 11:21:22

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Troubleshooting

Printing Will Not Start

Power Cannot Be Turned On

Paper Will Not Feed Even When the Power Is On

Paper Is Not Fed or Delivered Normally

Paper Jam

Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed under the Top Cover

Removing Paper Jammed around the Guide Board

Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Output Tray

Print Results Are Not Satisfactory

Printing Is Uneven, Too Heavy, or Too Light

Dirty or Blotted Prints

Print Results Do Not Match the Displayed Image

Characters and Colors Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

Printer Status Monitor Does Not Open

Printer Status Monitor Errors

No Response from Printer

No Paper/Tray Not Detected (Bypass Tray)

No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 2)

Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 2)

Cover Open

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_05.htm (1 of 2)2005/10/05 11:21:23

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Chapter contents - - User Guide

Duplex Unit Not Detected

Print Cartridge(s) Not Detected

Paper in Bypass Tray

Cartridge End

Ink End

Out of Printable Temperature Range

Printer Error

Adjusting the Printer

Error Indicator Summary

Top

Copyright © 2004 All rights reserved.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_05.htm (2 of 2)2005/10/05 11:21:23



Replacing a Print Cartridge

Checking the Remaining Ink

Replacing a Print Cartridge

Handling Print Cartridges

Top

Copyright © 2004 All rights reserved.

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_06.htm2005/10/05 11:21:24

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Sharing the Printer

Setting Up a Server

Setting Up a Client Computer

Top

Copyright © 2004 All rights reserved.

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_07.htm2005/10/05 11:21:25

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Inquiries and Consumables

Where to Inquire

Recommended Consumables

Option and Consumables

Top

Copyright © 2004 All rights reserved.

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_08.htm2005/10/05 11:21:25

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Additional Information

Color Guide

Color Printing Mechanism

Color Production Method of Printers

Guide to Components

Printer Body

Printer Rear

Control Panel

Option

Cleaning

Moving

Moving a Short Distance

Moving a Long Distance

When Not Using for a Long Period of Time

Specifications

Printer Body

Option (Paper Feed Unit)

Electromagnetic Interference

About NetBSD

Trademarks

Top

Copyright © 2004 All rights reserved.

Chapter contents - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_chap_09.htm2005/10/05 11:21:26

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Using and Removing the User Guide

Using the User Guide

Removing the User Guide

Printing

Printing on Various Paper Types

Printing on Plain Paper

Printing on Thick Paper

Printing on Inkjet Plain Paper

Printing on Inkjet Transparency

Printing on Semi-gloss Photo Paper

Printing on Envelopes

Canceling Printing

Canceling Printing from the Printer Status Monitor

Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing from the Taskbar

Adjusting Print Quality

Printing Using Preset Print Quality Settings

Printing in Black and White

Saving Color Ink When Printing

Printing with Print Quality Settings You Want

Changing Image Printing Method

Correcting the Hue of Digital Photos

Printing Low Resolution Images Smoothly

Changing the Dither Pattern

Changing the Color Profiling Pattern

Printing Grayscale Images Using Black or CMYK

Printing Text in Black

Using ICM

All titles - - User Guide

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_list.htm (1 of 6)2005/10/05 11:21:29

Contents Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


All titles - - User Guide

Adjusting Brightness, Contrast, and Saturation

Adjusting Color Balance

Printing a Whole Page as an Image

Changing the Image Data Process

Printing with Particular CMYK Colors

Printing Images Vividly

Various Print Functions

Printing Multiple Document Sets

Collating

Printing Web Pages

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Reducing to A4/Letter Automatically

Rotating the Image by 180 Degrees

Printing on Registered Custom Size Paper

Printing on Unregistered Custom Size Paper

Printing on Both Sides of Paper

Printing Multiple Document Pages per Sheet (Layout)

Splitting the Document Image across Multiple Sheets (Poster)

Printing from the Last Page

Creating a Binding Margin

Printing Documents with a Header and Footer

Printing with a Layout Suitable for Making Booklets

Printing Images or Text Superimposed on Prints

Creating a New Watermark

Printing Documents with an Overlay Image Superimposed (Overlay)

Creating a New Overlay Image File

Deleting an Overlay Image File

Creating a New Overlay Set

Custom Settings

Printing

Registering

Changing the Name

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_list.htm (2 of 6)2005/10/05 11:21:29



All titles - - User Guide

Deleting

Updating Custom Settings According to the Current Printer Configuration

Changing the Custom Settings Display Order

Saving a Registered Custom Setting in a File

Registering a Custom Setting Using a Custom Setting File

Printer Driver

Opening the Printer Properties Dialog Box

Opening from the Start Menu

For Windows 95/98/Me

For Windows 2000, Windows NT 4.0

For Windows XP, Windows Server 2003

 Opening from an Application

Displaying the Printer Status

Opening the Printer Status Monitor

Printer Properties Settings

Using Help

Displaying an Explanation for Each Setting Item (Context Help)

Displaying Help in a Help Window (Content Help)

 Checking Whether Bidirectional Communication is Working or Not

Maintaining the Printer Using Utilities

Nozzle Check

Clean Print-heads (Normal)

Clean Print-heads (Full)

Adjust Print-head Positions

Registration

Adjust Paper Feed

Restore Defaults/Other Settings

Restoring the Settings to Their Defaults

Specifying an I/O Timeout

Checking the Current Printer Driver Version

Uninstalling the Printer Driver

Paper

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_list.htm (3 of 6)2005/10/05 11:21:29



All titles - - User Guide

Loading Paper

Loading Paper into Tray 1

Loading Paper into Tray 2 (optional)

Loading Paper Larger than A4 (Letter)

Compatible Paper

Compatible Paper Types

Compatible Paper Sizes

Paper Handling Precautions

Printable Area

Non-compatible Paper

Troubleshooting

Printing Will Not Start

Power Cannot Be Turned On

Paper Will Not Feed Even When the Power Is On

Paper Is Not Fed or Delivered Normally

Paper Jam

Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed under the Top Cover

Removing Paper Jammed around the Guide Board

Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Output Tray

Print Results Are Not Satisfactory

Printing Is Uneven, Too Heavy, or Too Light

Dirty or Blotted Prints

Print Results Do Not Match the Displayed Image

Characters and Colors Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

Printer Status Monitor Does Not Open

Printer Status Monitor Errors

No Response from Printer

No Paper/Tray Not Detected (Bypass Tray)

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_list.htm (4 of 6)2005/10/05 11:21:29



All titles - - User Guide

No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 2)

Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 2)

Cover Open

Duplex Unit Not Detected

Print Cartridge(s) Not Detected

Paper in Bypass Tray

Cartridge End

Ink End

Out of Printable Temperature Range

Printer Error

Adjusting the Printer

Error Indicator Summary

Replacing a Print Cartridge

Checking the Remaining Ink

Replacing a Print Cartridge

Handling Print Cartridges

Sharing the Printer

Setting Up a Server

Setting Up a Client Computer

Inquiries and Consumables

Where to Inquire

Recommended Consumables

Option and Consumables

Additional Information

Color Guide

Color Printing Mechanism

Color Production Method of Printers

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_list.htm (5 of 6)2005/10/05 11:21:29



All titles - - User Guide

Guide to Components

Printer Body

Printer Rear

Control Panel

Option

Cleaning

Moving

Moving a Short Distance

Moving a Long Distance

When Not Using for a Long Period of Time

Specifications

Printer Body

Option (Paper Feed Unit)

Electromagnetic Interference

About NetBSD

Trademarks

Top

Copyright © 2004 All rights reserved.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/index_list.htm (6 of 6)2005/10/05 11:21:29



help

For how to use this manual, see "Using the User Guide".
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Using and Removing the User Guide > Using the User Guide

Using the User Guide

Read this manual carefully before you use this product and keep it handy for future reference. For safe and correct use, 
please be sure to read the Safety Information in the Setup Guide before using the machine.

This section describes the items that appear in the User Guide.

Click to display the standard version of the User Guide.

Click to display the screen-reader version of the User Guide.

Click to display the [Settings] page. On this page, you can select the display color and whether or not to 

hide illustrations for procedures.

Enter a word you want to search for.

If you point to a character string, it turns blue and is underlined. Click the string to jump to the linked 

page.

Click to display the contents.

Click to display the previous topic.

Click to display the next topic.

Click to return to the top of the displayed page.

If a description contains a hyperlink, the hyperlink appears at the bottom of each page.

●     Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

●     Some illustrations in this manual might be slightly different from the machine.

●     Certain options might not be available in some countries. For details, please contact your local dealer.

Using the User Guide
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Using and Removing the User Guide > Removing the User Guide

Removing the User Guide

Follow the procedure below to remove the User Guide installed on your computer.

Removing the User Guide using its [Uninstall] function

Click [Start], and then point to [Programs].

Point to the installed [Product name], and then click [Uninstall].

Follow the instructions that appear to remove the User Guide.

Removing the User Guide using [Add/Remove Programs]

Open [My Computer], and then open [Control Panel].

Double-click [Add/Remove Programs].

Select the installed [Product name User Guide], and then click [Add/Remove...].

Follow the instructions that appear to remove the User Guide.

●     As well as removing the entire the User Guide, you can also remove selected manuals from the guide.

Top Previous Next
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Printing > Printing on Various Paper Types

Printing on Various Paper Types

The print method differs depending on the type of paper used for printing. Use a print method appropriate for each 
paper type.

Related topics

Printing on Plain Paper  

Printing on Thick Paper  

Printing on Inkjet Plain Paper  

Printing on Inkjet Transparency  

Printing on Semi-gloss Photo Paper  

Printing on Envelopes  
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Printing > Printing on Various Paper Types > Printing on Plain Paper

Printing on Plain Paper

Follow the procedure below to print on plain paper. Plain paper are fed from tray 1 or tray 2 (optional).

Load plain paper into tray 1 or tray 2 (optional).

Open the printer properties dialog box from the application.

On the [Setup] tab, click [Plain] in the [Paper type:] list.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

●     Paper Handling Precautions

●     Loading Paper

Top Previous Next
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Printing > Printing on Various Paper Types > Printing on Thick Paper

Printing on Thick Paper

Follow the procedure below to print on thick paper and label paper. Thick paper and label paper are fed from the 
bypass tray.

●     Paper heavier than 105 g/m2 (198.5 lb.) is inserted into the bypass tray one sheet at a time. Paper lighter than that can be loaded into 

tray 1 or tray 2 (optional).

Open the printer properties dialog box from the application.

On the [Setup] tab, click [Thick] in the [Paper type:] list.

Make the necessary settings, and then click [OK].

A confirmation message appears.

Check the message, and then click [OK].

Make print settings, and then click [OK].

●     The [Test Paper Feed/Resume] key lights.

Slide the envelope selector to the forward position .

Slide the bypass tray guides into position according to the paper size, and then pull the bypass tray 

extension out.

Printing on Thick Paper
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Printing on Thick Paper

Insert a sheet of paper into the bypass tray with the print side face up.

●     Paper can only be inserted one sheet at a time.

●     Support the sheet with your hands to keep it from sliding out and dropping.

●     Insert the sheet straight into the bypass tray.

●     The thick paper should be between the top and bottom of the bypass tray guides.

Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.
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Printing on Thick Paper

Printing starts.

●     Opening from an Application

●     Paper Handling Precautions

Top Previous Next
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Printing > Printing on Various Paper Types > Printing on Inkjet Plain Paper

Printing on Inkjet Plain Paper

Follow the procedure below to print on inkjet plain paper.

Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

Hold both sides of tray 1, and pull it toward you.

●     Tray 1 cannot be detached. Do not pull it forcefully.

Squeeze the paper guide release, and then slide the side paper guides into position according to the 

paper size.

Printing on Inkjet Plain Paper
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Printing on Inkjet Plain Paper

●     Before loading paper, make sure to squeeze the front end paper guide and slide it to an open position.

Load inkjet plain paper with the print side face down but not over the limit mark.

●     Curled paper may jam. Straighten any curls before loading.

Squeeze the front end paper guide, and then slide it to meet the edge of the paper.
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Printing on Inkjet Plain Paper

Hold both sides of tray 1, and push it gently in until it stops.

Lower the output tray.

Slide the envelope selector to the forward position . 

Open the printer properties dialog box from the application.

On the [Setup] tab, click [Inkjet Plain Paper] in the [Paper type:] list.

●     Only one-sided printing is possible when [Inkjet Plain Paper] is selected. For duplex printing, click [Plain].
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Printing on Inkjet Plain Paper

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

●     Paper Handling Precautions

Top Previous Next
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Printing > Printing on Various Paper Types > Printing on Inkjet Transparency

Printing on Inkjet Transparency

Follow the procedure below to print on inkjet transparency.

●     Ink on an inkjet transparency takes some time to dry. We recommend that you remove a printed inkjet transparency from the output tray 

before the next inkjet transparency is delivered.

●     The print delivery time interval can be set longer to avoid printed inkjet transparency from sticking together due to wet ink.

Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

Hold both sides of tray 1, and pull it toward you.

●     Tray 1 cannot be detached. Do not pull it forcefully.

Printing on Inkjet Transparency
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Printing on Inkjet Transparency

Squeeze the paper guide release, and then slide the side paper guides into position according to the 

inkjet transparency size.

●     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

Load inkjet transparency into tray 1 with the notched corner in the right front corner of the tray. Do 

not load transparencies over the limit mark.

●     Curled inkjet transparency may jam. Straighten any curls before loading.

●     If other paper is loaded, remove it, and then load inkjet transparency.

●     To prevent the leading edge of transparencies from being scratched, place transparencies one at a time.

Squeeze the front end paper guide, and then slide it to meet the edge of the inkjet transparency.
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Printing on Inkjet Transparency

Hold both sides of tray 1, and push it gently in until it stops.

Lower the output tray.

Slide the envelope selector to the forward position .

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0007.htm (3 of 4)2005/10/05 11:21:42



Printing on Inkjet Transparency

Open the printer properties dialog box from the application.

On the [Setup] tab, click [Inkjet Transparency] in the [Paper type:] list.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

●     Paper Handling Precautions

Top Previous Next
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Printing > Printing on Various Paper Types > Printing on Semi-gloss Photo Paper

Printing on Semi-gloss Photo Paper

Follow the procedure below to print on semi-gloss photo paper.

Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

Hold both sides of tray 1, and pull it toward you.

●     Tray 1 cannot be detached. Do not pull it forcefully.

Squeeze the paper guide release, and then slide the side paper guides into position according to the 

paper size.

Printing on Semi-gloss Photo Paper
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Printing on Semi-gloss Photo Paper

●     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

Load semi-gloss photo paper with the print side face down but not over the limit mark.

●     The print side is rough and white-coated.

●     Curled paper may jam. Straighten any curls before loading.

Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0008.htm (2 of 4)2005/10/05 11:21:43



Printing on Semi-gloss Photo Paper

Hold both sides of tray 1, and push it gently in until it stops.

Lower the output tray.

Slide the envelope selector to the forward position .
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Printing on Semi-gloss Photo Paper

Open the printer properties dialog box from the application.

On the [Setup] tab, click [Semi-gloss Photo Paper] in the [Paper type:] list.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     The output tray can hold up to 20 sheets of semi-gloss photo paper at a time.

●     Opening from an Application

●     Paper Handling Precautions

Top Previous Next
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file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0008.htm (4 of 4)2005/10/05 11:21:43



Printing > Printing on Various Paper Types > Printing on Envelopes

Printing on Envelopes

Follow the procedure below to print on envelopes. The envelopes are fed from the bypass tray.

●     Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or similar object.

●     Load them properly because the printable area depends on the orientation.

Open the printer properties dialog box from the application.

On the [Setup] tab, click [Envelope] in the [Paper type:] list. 

Make the necessary settings, and then click [OK].

A confirmation message appears.

Check the message, and then click [OK].

Make print settings, and then click [OK].

●     The [Test Paper Feed/Resume] key lights.

Slide the envelope selector to the rear position .

Open up the bypass tray guides as far as they will go, and then pull the bypass tray extension out.

Printing on Envelopes
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Printing on Envelopes

Insert an envelope as illustrated with the front-side up and the folded flap on the left side when the 

machine is viewed from the back, and then slide the bypass tray guides up against the edges of the envelope.

●     If the envelope has a short-edge flap, the envelope should be inserted bottom first with the flap unfolded as illustrated.

●     Envelopes can only be inserted one at a time.

●     Support the envelope with your hands to keep it from sliding out and dropping.

●     Insert the envelope straight into the bypass tray.
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Printing on Envelopes

●     The envelope should be between the top and bottom of the bypass tray guides.

Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

Printing starts.

●     Opening from an Application

●     Paper Handling Precautions

●     Printable Area

Top Previous Next
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Printing > Canceling Printing

Canceling Printing

Print jobs can be canceled from either a printer or computer. How to cancel print jobs differs according to their job 
status. Check the job status first.

Canceling a print job being printed

Cancel the print job from the Printer Status monitor or by pressing the [Cancel] key of the printer.

Canceling a print job in queue

Cancel the print job from the taskbar of the computer.

Related topics

Canceling Printing from the Printer Status Monitor  

Canceling Printing Using the [Cancel] Key of the Printer  

Canceling Printing from the Taskbar  

Top Previous Next

Copyright © 2004 All rights reserved.

Canceling Printing
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Printing > Canceling Printing > Canceling Printing from the Printer Status Monitor

Canceling Printing from the Printer Status Monitor

Follow the procedure below to cancel a print job being printed.

Check that printing and the Printer Status monitor have started.

Click [Stop Printing].

●     It will take a few moments for printing to stop.

●     Displaying the Printer Status

Top Previous Next

Copyright © 2004 All rights reserved.

Canceling Printing from the Printer Status Monitor
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Printing > Canceling Printing > Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing Using the [Cancel] Key of the Printer

Follow the procedure below to cancel a print job being printed.

Check that printing has started.

●     Not only the print job being printed but also the print jobs in queue will be canceled.

●     If you press the [Cancel] key while the printer is receiving print data for a print job (the [Power] key is blinking), that print job is also 

canceled.

Press the [Cancel] key.

●     It will take a few moments for printing to stop.

Top Previous Next

Copyright © 2004 All rights reserved.

Canceling Printing Using the [Cancel] Key of the Printer

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0012.htm2005/10/05 11:21:48

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Printing > Canceling Printing > Canceling Printing from the Taskbar

Canceling Printing from the Taskbar

Follow the procedure below to cancel a print job in queue.

Double-click the icon of the printer on the taskbar.

Select the print job you want to cancel, and then click [Cancel Printing] (Windows 2000/XP, Windows 

Server 2003: [Cancel]) on the [Document] menu.

Top Previous Next

Copyright © 2004 All rights reserved.

Canceling Printing from the Taskbar
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Printing > Adjusting Print Quality

Adjusting Print Quality

Print quality and color tone can be adjusted to suit the print data.

Related topics

Printing Using Preset Print Quality Settings  

Printing in Black and White  

Saving Color Ink When Printing  

Printing with Print Quality Settings You Want  

Printing Images Vividly  

Top Previous Next

Copyright © 2004 All rights reserved.

Adjusting Print Quality
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Printing > Adjusting Print Quality > Printing Using Preset Print Quality Settings

Printing Using Preset Print Quality Settings

With preset print quality settings, you do not have to make print quality settings every time you print. Follow the 
procedure below to print using a preset print quality setting.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, select a print quality setting in the [Print Quality] area.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.

Printing Using Preset Print Quality Settings
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Printing > Adjusting Print Quality > Printing in Black and White

Printing in Black and White

Follow the procedure below to print using only black ink.

Since black and white printing is faster than color printing, it is efficient for printing color documents that do not need 
to be printed in color. Also, the black produced by black and white printing is a more distinct black than that produced 
by color printing.

●     Be sure to select black and white printing if you specified black and white printing in an application.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [Black and White] in the [Color/Black and White] area.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing in Black and White
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Printing > Adjusting Print Quality > Saving Color Ink When Printing

Saving Color Ink When Printing

Follow the procedure below to save color ink by printing graphics and images with less than the usual amount of ink. 
Text is printed as usual so that it can remain clear and easy to read.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [Color] in the [Color/Black and White] area.

Select the [Level color] check box.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Overall color, except for text, will be lighter.

●     The color of text may be printed lighter depending on the application used.

●     Opening from an Application

Top Previous Next
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Saving Color Ink When Printing
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want

Printing with Print Quality Settings You Want

You can make print quality settings more in details.

Related topics

Changing Image Printing Method  

Correcting the Hue of Digital Photos  

Printing Low Resolution Images Smoothly  

Changing the Dither Pattern  

Changing the Color Profiling Pattern  

Printing Grayscale Images Using Black or CMYK  

Printing Text in Black  

Using ICM  

Adjusting Brightness, Contrast, and Saturation  

Adjusting Color Balance  

Printing a Whole Page as an Image  

Changing the Image Data Process  

Printing with Particular CMYK Colors  

Top Previous Next
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Printing with Print Quality Settings You Want
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing Image Printing Method

Changing Image Printing Method

When printing images, the higher the resolution of images, the longer the time required for printing. Follow the 
procedure below to print with priority on print quality or print speed.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select an image printing method in the [Image processing priority] 

list.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Changing Image Printing Method
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Correcting the Hue of Digital Photos

Correcting the Hue of Digital Photos

Correct the hue of digital photos. This is effective especially for overexposed or underexposed images.

●     Exposure is affected by the levels of light in which the photo was taken. If there are extreme light and shade differences between object and 

background, the object may be underexposed (too dark) or overexposed (too light).

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select the [Adjust photos and images] check box.

●     If the [Adjust photos and images] check box is selected, the [Use ICM] check box is unavailable.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.

Correcting the Hue of Digital Photos
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing Low Resolution Images Smoothly

Printing Low Resolution Images Smoothly

Follow the procedure below to print outlines of low resolution images, which often appear on Web pages, smoothly.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select the [Smooth low resolution images] check box.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.

Printing Low Resolution Images Smoothly
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Dither Pattern

Changing the Dither Pattern

A dither pattern is a pattern of dots used to simulate a color or shade of an image. If the pattern is changed, the 
characteristics of the image will also change. Follow the procedure below to select a pattern suitable for the image to 
be printed.

●     Dithering is a technique where tiny dots are printed in patterns in order to create the illusion of tones and colors that cannot be physically 

reproduced.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select a dither pattern in the [Dithering] list.

●     Thin lines may break depending on the pattern used. If this happens, select another pattern.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Changing the Dither Pattern
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Color Profiling Pattern

Changing the Color Profiling Pattern

Follow the procedure below to select a color profiling pattern to adjust the tone of colors for prints according to the 
colors displayed on the computer screen.

Colors on the computer screen are expressed using the three RGB colors, but colors used for printing are composed of 
the four CMYK colors. When printing, RGB colors are converted to CMYK colors.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select a color profiling pattern in the [Color profile:] list.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

●     Color Guide

Top Previous Next
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Changing the Color Profiling Pattern
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing Grayscale Images Using Black or CMYK

Printing Grayscale Images Using Black or CMYK

Follow the procedure below to print black or gray parts of an image using black or CMYK.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select a gray reproduction method in the [Gray reproduction (Text/

Line Art):] list.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing Grayscale Images Using Black or CMYK
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing Text in Black

Printing Text in Black

Follow the procedure below to print text other than black in black. This is useful when text other than black looks 
lighter when printed.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select the [Print all texts in black] check box.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing Text in Black
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Using ICM

Using ICM

Follow the procedure below to correct colors using the Windows ICM (Image Color Matching) function.

●     ICM is a color management system that adjusts colors between I/O devices. Use this function to produce print results with colors as close as 

possible to those displayed on the computer screen. To use this function, the color profile must be added to the printer.

●     You can find the color profile in the ICM folder stored on the CD-ROM provided. For information about adding a color profile, search for 

the words "color profile" in Windows Help, and then see the appropriate topic.

●     This function is unavailable under Windows 95 or Windows NT 4.0.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

On the [Image Adjustments] tab, select the [Use ICM] check box.

●     If the [Use ICM] check box is selected, the [Color profile:] list on the [Image Adjustments] tab is unavailable. Windows performs color 

correction using the profile specified on the [Color Management] tab.

●     If the [Use ICM] check box is selected, the [Adjust photos and images] check box is unavailable.

In the [ICM method:] and [ICM intent:] lists, select a color correction process.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Using ICM
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Using ICM
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Adjusting Brightness, Contrast, and Saturation

Adjusting Brightness, Contrast, and Saturation

Follow the procedure below to adjust brightness, contrast, and saturation for printing.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

Click the [Balance Adjustments] tab.

Adjust the brightness, contrast, and saturation.

●     Make adjustments by moving the slider or clicking [-] or [+].

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Adjusting Brightness, Contrast, and Saturation
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Adjusting Color Balance

Adjusting Color Balance

Follow the procedure below to adjust color balance by changing the mixture of red (R), green (G), and blue (B).

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

Click the [Balance Adjustments] tab.

Adjust color balances.

●     Make adjustments by moving the slider or clicking [-] or [+]. Click [ ] and [ ] to move all sliders at the same time.

●     Cyan (C) and red (R), magenta (M) and green (G), and yellow (Y) and blue (B) are pairs of complementary colors.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

Complementary Colors

It is helpful to understand the concept of complementary colors when adjusting color balance. When two 
primary colors of the primary colors of light (RGB) or primary colors of pigment (CMY) are mixed, the 
resulting color is the complimentary color of the remaining primary color. Red and cyan, green and magenta, 
and blue and yellow are pairs of complementary colors.

Hints for Adjusting Color Balance

The following methods are available to make a specific color stronger: decreasing the color's complementary 
color or decreasing the other colors (that is, decreasing complementary colors relatively). A combination of 
both methods can be used.

For example, to make red more vivid, make red stronger (by decreasing cyan) or decrease green and blue 
(making magenta and yellow stronger). The more red is used, the brighter the image looks. This is useful to 
adjust the color of a dark image. On the contrary, the less green and blue are used, the duller the image looks. 
Use this method to make a bright image dull.

Adjusting Color Balance

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0028.htm (1 of 2)2005/10/05 11:22:05

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Adjusting Color Balance

●     Opening from an Application
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing a Whole Page as an Image

Printing a Whole Page as an Image

This section explains how to convert a print job to image data using a Windows application, and then print the image 
using the printer driver. Follow the procedure below to print a whole page as an image. This will allow you to get print 
results that resemble the display image more closely. Since more data has to be processed, printing will take much 
longer. Use this function if the printed image differs from the display image.

●     Black or gray parts will be printed with the four CMYK colors regardless of the settings made in the [Gray reproduction (Text/Line Art):] list 

on the [Image Adjustments] tab in the [Change User Settings] dialog box.

●     This setting overrides the watermark setting.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

Click the [Misc.] tab.

Select the [Print as bitmap] check box.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

●     Printing Images or Text Superimposed on Prints

Top Previous Next
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Printing a Whole Page as an Image
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Image Data Process

Changing the Image Data Process

Depending on the application, there may be cases where printing takes a long time or colors are not printed correctly. 
Follow the procedure below to change the image data process to solve the problem.

●     Since changing the image data processing method may cause printing not to be performed correctly with some applications, you should 

normally leave this option unselected.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

Click the [Misc.] tab.

Select the [Change data processing] check box.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Changing the Image Data Process
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Printing

Printing on Various Paper Types

Printing on Plain Paper

Printing on Thick Paper

Printing on Inkjet Plain Paper

Printing on Inkjet Transparency

Printing on Semi-gloss Photo Paper

Printing on Envelopes

Canceling Printing

Canceling Printing from the Printer Status Monitor

Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing from the Taskbar

Adjusting Print Quality

Printing Using Preset Print Quality Settings

Printing in Black and White

Saving Color Ink When Printing

Printing with Print Quality Settings You Want

Changing Image Printing Method

Correcting the Hue of Digital Photos

Printing Low Resolution Images Smoothly

Changing the Dither Pattern

Changing the Color Profiling Pattern

Printing Grayscale Images Using Black or CMYK

Printing Text in Black

Using ICM

Adjusting Brightness, Contrast, and Saturation

Adjusting Color Balance

Printing a Whole Page as an Image

Changing the Image Data Process
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing with Particular CMYK Colors

Printing with Particular CMYK Colors

Normally full color (CMYK) is used for color printing. Follow the procedure below to print using particular CMYK 
colors.

●     These settings are unavailable when black and white printing is specified.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

Click [Change...].

The [Change User Settings] dialog box appears.

Click the [Misc.] tab.

In the [Separate into CMYK, then print in designated color only] area, select colors.

●     Select colors you want to use.

Click [OK].

The [Change User Settings] dialog box closes.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing with Particular CMYK Colors
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Printing > Adjusting Print Quality > Printing Images Vividly

Printing Images Vividly

By changing the printer properties settings or using special paper, vivid images can be printed.

Changing the printer properties settings

Prints can be made with priority on print quality. Change print quality settings in the printer properties dialog 
box.

Using special paper

Printing on special paper will look more vivid compared to printing on plain paper. Use inkjet plain paper or 
semi-gloss photo paper.

●     Printing Using Preset Print Quality Settings

●     Recommended Consumables

Top Previous Next
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Printing > Various Print Functions

Various Print Functions

By using various print functions, you can make prints appropriate for your purposes.

●     Printing on Various Paper Types

Related topics

Printing Multiple Document Sets  

Collating  

Printing Web Pages  

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)  

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)  

Reducing to A4/Letter Automatically  

Rotating the Image by 180 Degrees  

Printing on Registered Custom Size Paper  

Printing on Unregistered Custom Size Paper  

Printing on Both Sides of Paper  

Printing Multiple Document Pages per Sheet (Layout)  

Splitting the Document Image across Multiple Sheets (Poster)  

Printing from the Last Page  

Creating a Binding Margin  

Printing Documents with a Header and Footer  

Printing with a Layout Suitable for Making Booklets  

Printing Images or Text Superimposed on Prints  

Printing Documents with an Overlay Image Superimposed (Overlay)  

Top Previous Next

Copyright © 2004 All rights reserved.

Various Print Functions

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0033.htm2005/10/05 11:22:12

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Printing > Various Print Functions > Printing Multiple Document Sets

Printing Multiple Document Sets

Follow the procedure below to print multiple sets of the same document.

●     If you do not use the Collate function, prints will be delivered in page batches (P1, P1, P2, P2 ...). If you use the Collate function, prints will 

be delivered in document batches (P1, P2, P1, P2 ...).

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.

In the [Copies] box, enter the number of sets you want to print between 1 and 999.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Collating

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Collating

Collating

Follow the procedure below to print complete sets of prints one set at a time when printing multiple sets such as for 
presentation materials.

●     Even when using the Collate function with Layout, Poster, or Duplex, document boundaries are correctly recognized so problems like the 

first page and last page being printed on the same sheet do not occur.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.

In the [Copies] box, enter the number of sets you want to print between 1 and 999.

Select the [Collate] check box.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing Web Pages

Printing Web Pages

Use the procedures described below to make settings for printing Web pages.

When a Web page is printed, it may not fit on the paper used or it may not be printed as it looks on the screen. Use the 
information below to print Web pages correctly.

Printing low resolution images smoothly

Images displayed on Web sites tend to be low resolution images to reduce data size. Before printing, be sure to 
make the setting to print low resolution images smoothly.

Printing a whole Web page fit to the paper size

When a whole Web page cannot be printed on the paper size used, reduce it using [Fit to paper size] or [Scale] 
under the Reduce/Enlarge function. If [A3 (297 x 420 mm)] or [B4 JIS (257 x 364 mm)] is selected for 
[Original size:] and the [Reduce automatically to fit A4]/[Reduce automatically to fit Letter] check box is 
selected, the print image will be reduced automatically to fit A4/Letter size paper.

●     When a Web page is printed over multiple sheets, images or text where any two sheets are connected may not be printed.

Printing the background color of a Web page

The background color of a Web page may not be printed. Make the settings to print the background color using 
a Web browser.

Internet Explorer

On the [View] or [Tools] menu of the browser, click [Internet Options...].

Click the [Advanced] tab.

In the [Settings] list, select the [Print background colors and images] check box under [Printing].

Click [OK].

Netscape Navigator

On the [File] menu of the browser, click [Page Setup].

On the [Format & Options] tab, select the [Print Background (colors & images)] check box in the 

[Options] area.

Click [OK].

●     Printing Low Resolution Images Smoothly

●     Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

●     Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Printing Web Pages
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Printing Web Pages

●     Reducing to A4/Letter Automatically

Top Previous Next
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Printing > Various Print Functions > Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Follow the procedure below to print document pages reduced or enlarged to fit the paper size. By specifying a 
document and paper size, an appropriate reduction or enlargement ratio is selected automatically. This is useful when 
reducing or enlarging from or to standard paper sizes such as when reducing an A3 document to A5 paper.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.

Check that the document orientation and size are the same as those selected in the application.

●     Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected, 

make the correct settings.

Select the [Reduce/Enlarge] check box, and then click [Fit to paper size] in the list.

In the [Printout paper size:] list, select a paper size.

Select the size of paper loaded in the paper tray.

●     An automatically selected ratio appears in the [Scaling(%):] box.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Follow the procedure below to print with a reduction or enlargement ratio in the range of 20-300% adjustable in 1% 
increments. Use this to reduce the size of the print image slightly to insert a margin, for example.

Two methods are available: scale and directional magnification. Scale is used to specify the same ratio in both 
horizontal and vertical directions while directional magnification is used to specify a different ratio for each direction.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.

Select the [Reduce/Enlarge] check box, and then click [Scale] or [Directional magnification...] in the list.

If [Scale] is selected, enter a ratio in the [Scaling(%):] box.

●     Enter a number between 20 and 300.

●     In the [Printout paper size:] list, you can change the paper size.

If [Directional magnification...] is selected, enter ratios in the [Vertical:] and [Horizontal:] boxes, and 

then click [OK].

Select the [Centering] check box to center an image.

●     If [Scale] or [Directional magnification...] is selected, a wide margin may be created on the right or bottom of the paper. If this happens, 

select the [Centering] check box to center an image and create margins of the same width.

●     If the [Centering] check box is not selected, the reduced or enlarged image is positioned in the upper left of the paper.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)
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Printing > Various Print Functions > Reducing to A4/Letter Automatically

Reducing to A4/Letter Automatically

Follow the procedure below to print a document larger than A4/Letter onto A4/Letter size paper by reducing it. For 
example, if a document is A3/Legal size, the document is reduced to A4/Letter automatically and printed.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.

Check that the document orientation and size are the same as those selected in the application.

●     Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected, 

make the correct settings.

In the [Printout paper size:] list, [Reduce to fit A4]/[Reduce to fit Letter] appears.

●     If [Reduce to fit A4]/[Reduce to fit Letter] does not appear, select the [Reduce automatically to fit A4]/[Reduce automatically to fit 

Letter] check box in the [Printer Configuration] dialog box.

Click [OK].

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     When you do not want to reduce images from documents larger than A4/Letter, clear the [Reduce automatically to fit A4]/[Reduce 

automatically to fit Letter] check box in the [Printer Configuration] dialog box. For example, this is done when you want to print document 

images at full size even if they run off the paper.

●     Opening from an Application

Top Previous Next
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Reducing to A4/Letter Automatically
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Printing > Various Print Functions > Rotating the Image by 180 Degrees

Rotating the Image by 180 Degrees

Follow the procedure below to print images rotated by 180 degrees. Use this function if paper loaded in the paper tray 
has a distinct top and bottom and printing with the paper in that orientation would otherwise make the image upside-
down.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.

Select the [Rotate by 180 degrees] check box.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing on Registered Custom Size Paper

Printing on Registered Custom Size Paper

Follow the procedure below to print on registered custom size paper.

Register the size of the custom size paper loaded in the paper tray in the [Printer Configuration] dialog box.

Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to 
open it may differ in some applications. Open the dialog box according to the application being used.

Open the printer properties dialog box from the [Page Setup] dialog box.

Click the [Page Settings] tab.

In the [Original size:] list, select a custom paper size.

Select from the sizes already registered.

Click [Portrait] or [Landscape].

Select the orientation that matches the document orientation and feeding direction.

Click the [Setup] tab.

Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Check that the orientation selected in the [Setup] dialog box of the application is the same as that 

selected in step .

If it is not, make the correct setting.

Close the [Page Setup] dialog box of the application.

Create a file in the application.

In the printer properties dialog box, make the print settings for the printer selected in step , and 

then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing on Unregistered Custom Size Paper

Printing on Unregistered Custom Size Paper

Follow the procedure below to print on unregistered custom size paper.

Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to 
open it may differ in some applications. Open the dialog box according to the application being used.

Open the printer properties dialog box from the [Page Setup] dialog box.

Click the [Page Settings] tab.

In the [Original size:] list, click [Custom paper size...].

The [Custom Paper Size] dialog box appears.

In the [Long edge:] and [Short edge:] boxes, enter values.

●     To change the measurement unit, click [Measurement Unit...].

In the [Paper source tray:] list, select a paper tray.

In the [Paper Position in Tray] area, select a paper orientation.

Click [OK].

●     To register the paper size as a custom paper size, click [Open [Custom Paper Sizes]...].

Click the [Setup] tab.

Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.

Click the [Page Settings] tab.

Click [Portrait] or [Landscape].

Select the orientation that matches the document orientation and feeding direction.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Check that the orientation selected in the [Page Setup] dialog box of the application is the same as that 

selected in step .

If it is not, make the correct setting.

Printing on Unregistered Custom Size Paper
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Printing on Unregistered Custom Size Paper

Close the [Page Setup] dialog box of the application.

Create a file in the application.

In the printer properties dialog box, make the print settings for the printer selected in step , and 

then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing on Both Sides of Paper

Printing on Both Sides of Paper

Follow the procedure below to print on both sides of paper.

●     If the page size varies within a document, a page break will occur before the page where the size changes.

●     When printing solid color using a lot of ink, we recommend that you use one-sided printing.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Duplex/Booklet] check box.

●     If you select the [Create margin] check box when printing on plain paper, the machine automatically reduces the size of the page images 

and centers them on the paper.

Click the icon representing the binding method you want to use.

●     The icons are displayed in either landscape or portrait depending on the document orientation.

Select the [Header/Footer/Adjust image position/Binding margins] check box to create a binding 

margin.

Click [Details...] to specify a margin in the [Binding Margins for Duplex Printing] area.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

●     Printing with a Layout Suitable for Making Booklets

●     Creating a Binding Margin
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Printing > Various Print Functions > Printing Multiple Document Pages per Sheet (Layout)

Printing Multiple Document Pages per Sheet (Layout)

Follow the procedure below to print multiple document pages per sheet.

●     When using Layout, a suitable reduction or enlargement ratio is selected automatically based on the paper size and the number of pages you 

want to fit on each sheet.

●     If the page orientation varies within a document, a page break will occur before a page where the orientation changes.

●     If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Layout/Poster] check box, and then select the number of document pages you want to fit on 

each sheet in the list.

●     Do not click [Poster] since it is a different function.

Click the icon that matches the page flow you want to use.

●     The icons show the available page flows for the number of pages selected.

●     The icons are displayed in either landscape or portrait depending on the document orientation.

Select the [Draw border] check box to print borders.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Splitting the Document Image across Multiple Sheets (Poster)

Splitting the Document Image across Multiple Sheets (Poster)

Follow the procedure below to print a single document page over multiple sheets to make a poster size print.

●     The enlargement ratio used is based on the specified paper size and the number of sheets you want to split the image over.

●     Prints are made with a 15 mm (0.6 inches) overlap margin. When pasting sheets together, overlap them to hide this margin.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Layout/Poster] check box, and then click [Poster] in the list.

Click the icon representing the number of sheets you want to split the image over.

●     The icons are displayed in either landscape or portrait depending on the document orientation.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.

Splitting the Document Image across Multiple Sheets (Poster)
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Printing > Various Print Functions > Printing from the Last Page

Printing from the Last Page

Follow the procedure below to start printing from the last page of a document. Use this function when prints come out 
face up in the output tray. This allows a printed document to be assembled in page order.

●     If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.

Select the [Reverse order printing] check box.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing from the Last Page
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Printing > Various Print Functions > Creating a Binding Margin

Creating a Binding Margin

Follow the procedure below to print with a binding margin. If you create a binding margin, it is offset from the 
document margin set from the application.

●     Since the margin opposite the binding margin will be shifted toward the paper edge, be sure to make this margin wide enough when making 

the document.

●     If a binding margin is set in an application, do not make this setting in the printer properties. This would result in a binding margin twice as 

wide as expected.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Header/Footer/Adjust image position/Binding margins] check box.

Click [Details...].

The [Header/Footer/Adjust Image Position/Binding Margins] dialog box appears.

In the [Adjust Image Position] area, select the direction in which you want to shift the print area in the 

[Direction:] list.

●     Margins (top, bottom, left, right) change according to the selected direction.

Enter a binding margin width, and then click [OK].

●     To change the measurement unit, click [Measurement Unit...].

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next

Creating a Binding Margin
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Printing > Various Print Functions > Printing Documents with a Header and Footer

Printing Documents with a Header and Footer

Follow the procedure below to print documents with character strings in the top and bottom margins.

●     Besides date, page number, and file name, text of up to 32 characters can be inserted into these areas.

●     If you print a document using the Reduce/Enlarge function, the header and footer will also be reduced or enlarged.

●     A header and footer will be printed on every page. For example, if you print several document pages on a sheet of paper (Layout), a header 

and footer will appear for every page.

●     If a header and footer are set in an application, do not make this setting in the printer properties.

 Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Header/Footer/Adjust image position/Binding margins] check box.

Click [Details...].

The [Header/Footer/Adjust Image Position/Binding Margins] dialog box appears.

In the [Header/Footer] area, make the necessary settings, and then click [OK].

●     If the same position is selected for the date and time, page number, or text, the printing order is as follows: date and time, text, page 

number.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.

Printing Documents with a Header and Footer
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Printing > Various Print Functions > Printing with a Layout Suitable for Making Booklets

Printing with a Layout Suitable for Making Booklets

Follow the procedure below to print on both sides of paper using a layout suitable for making booklets.

●     There are two kinds of booklet layout: [Booklet 1] and [Booklet 2]. With [Booklet 1], each sheet is folded in half separately, then the folded 

sheets are stacked and bound. With [Booklet 2], the whole stack is folded in half in a similar way to a magazine.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Duplex/Booklet] check box.

Click the icon representing the booklet format you want to use.

●     The icons are displayed in either landscape or portrait depending on the document orientation.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

●     Printing on Both Sides of Paper

Top Previous Next
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Printing with a Layout Suitable for Making Booklets
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Printing > Various Print Functions > Printing Images or Text Superimposed on Prints

Printing Images or Text Superimposed on Prints

Follow the procedure below to print an image or text superimposed on prints. The image or text is referred to as a 
watermark.

●     A watermark made up of a bitmap file (extension .bmp) is referred to as an image watermark. A watermark made up of text data is referred to 

as a text watermark. You cannot use both together.

●     Various predefined watermarks are provided. You can also create your own watermarks.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Watermarks/Overlay] check box, and then select a watermark in the list.

●     To edit the watermark, click [Edit...].

●     To create a new watermark, click [Add Bitmap...] or [Add Text...].

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Related topics

Creating a New Watermark  

Top Previous Next

Copyright © 2004 All rights reserved.

Printing Images or Text Superimposed on Prints
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Printing > Various Print Functions > Printing Images or Text Superimposed on Prints > Creating a New Watermark

Creating a New Watermark

Follow the procedure below to create a new watermark.

●     There are two kinds of watermarks: image watermarks made up of a bitmap file (extension .bmp) and text watermarks made up of text data.

Open the printer properties dialog box.

Click the [Edit] tab.

Select the [Watermarks/Overlay] check box.

Click [Add Bitmap...] to create an image watermark, or click [Add Text...] to create a text watermark.

Make the necessary settings in the [Add Bitmap Watermark] or [Add Text Watermark] dialog box, 

and then click [OK].

The watermark is registered and added to the list.

●     Opening from the Start Menu

●     Opening from an Application

●     Printing Images or Text Superimposed on Prints

Top Previous Next
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Creating a New Watermark
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay)

Printing Documents with an Overlay Image Superimposed (Overlay)

Follow the procedure below to print a document with an overlay image superimposed.

●     Before printing using the Overlay function, an overlay image file and overlay set must be created.

●     A superimposing image will be aligned with the document page at the upper left corner. If the document to be printed and superimposing 

image differ in size and orientation, the superimposing image may be cut or run off.

●     Depending on the application, you may not get the expected result.

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Edit] tab.

Select the [Watermarks/Overlay] check box, and then select an overlay set in the list.

●     To edit the overlay set, click [Edit...].

●     To create a new overlay set, click [Add Overlay....].

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

Overlay image file:

Data saved in a format allowing it to be used as a superimposing image.

Overlay set:

An overlay image file and setting details (such as how and which page an overlay image is superimposed on) are 
combined, named, and registered as a set. Each set registered is called an overlay set.

When printing, select an overlay set.

●     Opening from an Application

Related topics

Printing Documents with an Overlay Image Superimposed (Overlay)
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Printing Documents with an Overlay Image Superimposed (Overlay)

Creating a New Overlay Image File  

Deleting an Overlay Image File  

Creating a New Overlay Set  

Top Previous Next
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Creating a New Overlay Image File

Creating a New Overlay Image File

Follow the procedure below to create an overlay image file.

●     You can create an overlay image file with any application.

●     When an overlay image file is created using a multiple-page document, only the first page will be saved as an overlay image.

Open the file with which you want to create an overlay image file, and then open the printer properties 

dialog box.

On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.

The [Job Type Details] dialog box appears.

In the [File name:] box, enter a file name.

●     Enter a name using up to 32 characters.

●     Under Windows 95/98/Me, enter a name using up to eight characters.

Click [OK].

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

●     When creating an overlay image file (when [Save as Overlay Data...] is selected in the [Job type:] list), only print quality settings are 

available.

Click [OK] in the [Print] dialog box.

The overlay image file is created.

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.

Creating a New Overlay Image File
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Deleting an Overlay Image File

Deleting an Overlay Image File

Follow the procedure below to delete an overlay image file.

Open the printer properties dialog box.

On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.

Select the overlay image file you want to delete.

Click [Delete...].

A confirmation message appears.

Click [OK].

The overlay image file is deleted.

●     You can also delete overlay image files (extension .rpo) using Windows Explorer.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Deleting an Overlay Image File
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Creating a New Overlay Set

Creating a New Overlay Set

Follow the procedure below to combine an overlay image file and setting details (such as how and which page an 
overlay image is superimposed on), name it, and register it as a set. Each set registered is called an overlay set.

●     For printing the same overlay image with different setting details, set different combinations of setting details for the same overlay image 

file, and then register each set as a different overlay set.

Open the printer properties dialog box.

Click the [Edit] tab.

Select the [Watermarks/Overlay] check box.

Click [Add Overlay....].

In the [Add Overlay] dialog box, make the necessary settings, and then click [OK].

The overlay set is registered and added to the list.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Creating a New Overlay Set
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Printing > Custom Settings

Custom Settings

In [Custom Settings:], frequently used printer properties settings can be registered as a custom setting.

Since custom settings can be saved in a file and recalled from that file, multiple users can share that file to print with 
the same printer properties settings.

Related topics

Printing  

Registering  

Changing the Name  

Deleting  

Updating Custom Settings According to the Current Printer Configuration  

Changing the Custom Settings Display Order  

Saving a Registered Custom Setting in a File  

Registering a Custom Setting Using a Custom Setting File  

Top Previous Next
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Custom Settings
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Printing > Custom Settings > Printing

Printing

Follow the procedure below to print with the registered custom settings.

The printer configuration settings must be made beforehand.

Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, select a setting in the [Custom Settings:] list.

Click [No setting] to print with the standard settings.

On the [Page Settings] tab, check that the document orientation and size are the same as those selected 

in the application.

●     Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected, 

make the correct settings.

To print multiple sets, enter the number of sets in the [Copies] box.

On the [Setup] tab, click [Normal Print] in the [Job type:] list.

●     A paper tray and paper type are included in a registered custom setting. If you want to print on paper that is different from the one in the 

selected custom setting, you can select the paper tray and paper type you want to use on the [Setup] tab.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.

Printing
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Printing > Custom Settings > Registering

Registering

Follow the procedure below to register a new custom setting.

●     Up to 16 custom settings can be registered.

Open the printer properties dialog box.

Click the [Setup], [Page Settings], or [Edit] tab.

In the [Custom Settings:] list, select the custom setting on which you want to base the new custom 

setting.

●     To base the new setting on the default settings, click [No setting].

●     When creating a new custom setting based on an existing custom setting, select the custom setting from which you can make the new 

setting with the least changes.

Make the settings on the [Setup], [Page Settings], and [Edit] tabs.

●     Settings not included in a custom setting are as follows: [Job type:] on the [Setup] tab, [Original orientation:], [Original size:], [Printout 

paper size:], and [Copies] on the [Page Settings] tab, and all settings in the [Printer Configuration] dialog box.

Click [Save...].

The [Save New Custom Setting] dialog box appears.

In the [Custom Setting name:] box, enter a custom setting name.

●     Up to 36 characters can be entered.

Click [OK].

The custom setting is registered and added to the list.

Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

Registering
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Registering

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings > Changing the Name

Changing the Name

Follow the procedure below to change a name of a registered custom setting.

Open the printer properties dialog box.

Click the [Setup], [Page Settings], or [Edit] tab.

Click [Manage...].

The [Manage Custom Settings] dialog box appears.

Select the custom setting whose name you want to change.

●     [No setting] cannot be changed.

In the [Custom Setting name:] box, enter a new name.

●     Up to 36 characters can be entered.

Click [Close].

The custom setting name is changed.

Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Changing the Name
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Printing > Custom Settings > Deleting

Deleting

Follow the procedure below to delete a registered custom setting.

●     If you delete the custom settings that were registered automatically during installation of the printer driver, they will reappear when the 

custom settings display is updated.

Open the printer properties dialog box.

Click the [Setup], [Page Settings], or [Edit] tab.

Click [Manage...].

The [Manage Custom Settings] dialog box appears.

Select the custom setting you want to delete.

●     [No setting] cannot be deleted.

Click [Delete Custom Setting].

A confirmation message appears.

Click [OK].

Click [Close].

Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Deleting
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Printing > Custom Settings > Updating Custom Settings According to the Current Printer Configuration

Updating Custom Settings According to the Current Printer Configuration

There are two kinds of custom settings displayed in the printer properties dialog box: those registered automatically 
during installation of the printer driver and custom settings added later by the user. Since these custom settings are not 
deleted automatically, depending on the installed options, some custom settings that cannot be used to print may 
remain.

To keep only custom settings that can be used with the options installed, follow the procedure below to update custom 
settings after you install or uninstall options. The following is how each kind of custom settings will be updated:

●     Custom settings registered automatically during printer driver installation

Custom settings that can still be used remain registered. Custom settings that cannot be used are deleted.

●     Custom settings registered by user

Custom settings that cannot be used are deleted. Deleted custom settings cannot be recovered.

●     If bidirectional communication is not working, you must configure installed options in the [Printer Configuration] dialog box before 

performing this procedure.

Open the printer properties dialog box.

Click the [Setup], [Page Settings], or [Edit] tab.

Click [Manage...].

The [Manage Custom Settings] dialog box appears.

Click [Refresh Printer Information].

●     If bidirectional communication is working, printer configuration settings in the [Accessories] area and custom settings in the [Custom 

Settings:] list are updated.

●     If bidirectional communication is not working, custom settings in the [Custom Settings:] list are updated according to the current printer 

configuration settings in the [Accessories] area.

Click [Close].

Click [OK].

The printer properties dialog box closes.

●     Checking Whether Bidirectional Communication is Working or Not

●     Opening from the Start Menu

Updating Custom Settings According to the Current Printer Configuration

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0061.htm (1 of 2)2005/10/05 11:22:44

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Updating Custom Settings According to the Current Printer Configuration

●     Opening from an Application
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Printing > Custom Settings > Changing the Custom Settings Display Order

Changing the Custom Settings Display Order

Follow the procedure below to change the display order in the [Custom Settings:] list. For optimal ease-of-use, change 
the order according to the setting type and how often you use them.

Open the printer properties dialog box.

Click the [Setup], [Page Settings], or [Edit] tab.

Click [Manage...].

The [Manage Custom Settings] dialog box appears.

Select the custom setting you want to move.

●     [No setting] cannot be moved.

Click [Move Up] or [Move Down].

Click [Close].

Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Changing the Custom Settings Display Order
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Printing > Custom Settings > Saving a Registered Custom Setting in a File

Saving a Registered Custom Setting in a File

Follow the procedure below to save a registered custom setting in a custom setting file.

●     Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, this function is unavailable.

Open the printer properties dialog box.

Click the [Setup], [Page Settings], or [Edit] tab.

Click [Manage...].

The [Manage Custom Settings] dialog box appears.

Select the custom setting you want to save.

Click [Save Custom Setting...].

The [Save Custom Setting] dialog box appears.

In the [File name:] box, enter a file name.

●     Up to eight characters can be entered.

●     The extension is .rst.

Click [OK].

The [Save Custom Setting] dialog box closes. The custom setting is saved in a custom setting file.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Saving a Registered Custom Setting in a File
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Printing > Custom Settings > Registering a Custom Setting Using a Custom Setting File

Registering a Custom Setting Using a Custom Setting File

Follow the procedure below to register a custom setting from a custom setting file. This file would be provided by an 
administrator, for example.

●     The custom settings file name can be up to eight characters.

Open the printer properties dialog box.

Click the [Setup], [Page Settings], or [Edit] tab.

Click [Manage...].

The [Manage Custom Settings] dialog box appears.

Click [Load Custom Setting].

The [Load Custom Setting...] dialog box appears.

Select the file containing the custom setting you want to register.

Click [OK].

The custom setting is imported and registered.

Click [Close].

Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Registering a Custom Setting Using a Custom Setting File
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Printer Driver > Opening the Printer Properties Dialog Box

Opening the Printer Properties Dialog Box

The printer properties dialog box can be opened from an application or from the [Start] menu of Windows. Depending 
on how you open it, the available tabs vary.

Related topics

Opening from the Start Menu  

Opening from an Application  

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu

Opening from the Start Menu

All printer properties settings can be changed if the printer properties dialog box is opened from the [Printers] folder 
(Windows XP, Windows Server 2003: the [Printers and Faxes] folder).

●     The printer properties settings made here are displayed as the default when the printer properties dialog box is opened from an application.

Related topics

For Windows 95/98/Me  

For Windows 2000, Windows NT 4.0  

For Windows XP, Windows Server 2003  

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows 95/98/Me

For Windows 95/98/Me

Follow the procedure below to open the printer properties dialog box from the [Start] menu.

On the [Start] menu, point to [Settings], and then click [Printers].

Click the icon of the printer, and then click [Properties] on the [File] menu.

The printer properties dialog box appears.

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows 2000, Windows NT 4.0

For Windows 2000, Windows NT 4.0

Follow the procedure below to open the printer properties dialog box (Windows NT 4.0: the [Default] dialog box) 
from the [Start] menu.

On the [Start] menu, point to [Settings], and then click [Printers].

●     Under Windows Server 2003, click [Printers and Faxes].

Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

●     Under Windows NT 4.0, click [Document Defaults...] on the [File] menu.

●     To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box (Windows NT 4.0: the [Default] dialog box) appears.

Top Previous Next
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For Windows 2000, Windows NT 4.0
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows XP, Windows Server 2003

For Windows XP, Windows Server 2003

Follow the procedure below to open the printer properties dialog box from the [Start] menu.

Windows XP Home Edition

On the [Start] menu, click [Control Panel].

Click [Printers and Other Hardware].

Click [Printers and Faxes].

Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

●     To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box appears.

Windows XP Professional

On the [Start] menu, click [Printers and Faxes].

Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

●     To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box appears.

Top Previous Next
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For Windows XP, Windows Server 2003
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Printer Driver > Opening the Printer Properties Dialog Box >  Opening from an Application

Opening from an Application

Follow the procedure below to open the printer properties dialog box from an application. The default properties 
settings are displayed when opened from an application. Change the settings as necessary.

●     Changes made here are only applicable with that application and only as long as that application stays open.

●     Some applications may automatically change the printer properties settings.

●     The procedure below is an example for Paint (included in the standard Windows package).

●     How to open the printer properties dialog box differs depending on the application. From most applications, the printer properties dialog box 

can be opened by clicking [Print...] or [Page Setup...] on the [File] menu, and then clicking [Properties] (Windows 2000/XP, Windows Server 

2003: [Preferences]). For details, see Help of the application.

On the [File] menu, click [Print...].

In the [Name] list, select the name of this printer, and then click [Properties] (Windows 2000/XP, 

Windows Server 2003: [Preferences]).

The printer properties dialog box (Windows 2000/XP, Windows Server 2003: the [Printing Preferences] dialog 
box) appears.

Top Previous Next
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Opening from an Application
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Printer Driver > Displaying the Printer Status

Displaying the Printer Status

Using the Printer Status monitor, printer conditions such as the print jobs or remaining ink can be checked from the 
computer. Also, when errors occur, the status of the printer and the solution to the problem can be checked quickly.

Related topics

Opening the Printer Status Monitor  

Top Previous Next
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Printer Driver > Displaying the Printer Status > Opening the Printer Status Monitor

Opening the Printer Status Monitor

The Printer Status monitor automatically opens when printing starts. It can also be opened when not printing. Follow 
the procedure below to open the Printer Status monitor.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Printer Status].

The Printer Status monitor dialog box appears.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Printer Properties Settings

Printer Properties Settings

Make various print settings in the printer properties dialog box.

Related topics

Using Help  

Checking Whether Bidirectional Communication is Working or Not  

Top Previous Next
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Printer Driver > Printer Properties Settings > Using Help

Using Help

For information about setting items and how to make settings, see Help.

Two types of the printer driver Help are available: context Help and content Help.

Related topics

Displaying an Explanation for Each Setting Item (Context Help)  

Displaying Help in a Help Window (Content Help)  

Top Previous Next
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Printer Driver > Printer Properties Settings > Using Help > Displaying an Explanation for Each Setting Item (Context Help)

Displaying an Explanation for Each Setting Item (Context Help)

Follow the procedure below to display Help for each setting item.

Click the [?] button found at the upper right of each dialog box.

A question mark appears beside the pointer.

Move the pointer over the setting item for which you want to read Help.

●     You can also display Help for the setting item by right-clicking the setting item, and then clicking [Help] on the shortcut menu that 

appears.

Top Previous Next

Copyright © 2004 All rights reserved.

Displaying an Explanation for Each Setting Item (Context Help)

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0075.htm2005/10/05 11:22:59

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Printer Driver > Printer Properties Settings > Using Help > Displaying Help in a Help Window (Content Help)

Displaying Help in a Help Window (Content Help)

Follow the procedure below to display Help.

Click [Help] found at the lower right in each dialog box.

Help for the open dialog box appears.

To display the contents, click [Help Topics].

In the [Help Topic] dialog box, select a topic.

Click [Display].

●     To print the currently displayed Help topic, click [Print] at the top.

●     To print from the [Help Topics] dialog box, select a topic, and then click [Print].

●     In the [Help Topics] dialog box, selecting a book and printing it will print all topics in that book.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Printer Properties Settings >  Checking Whether Bidirectional Communication is Working or Not

Checking Whether Bidirectional Communication is Working or Not

Follow the procedure below to check if bidirectional communication is working by obtaining the printer version 
information.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [About].

The [About] dialog box appears.

Check that the printer version is displayed.

When bidirectional communication is working, the printer version is displayed.

Click [OK].

●     The printer version appears under [System Version:].

Requirements for Bidirectional Communication

If bidirectional communication is working between the printer and computer, information about the paper loaded 
in the printer is sent to the computer and is applied automatically to the printer properties settings. In addition to 
that, the printer status can be checked from the computer.

●     The computer must support bidirectional communication.

●     The bidirectional communication settings must be enabled in the printer properties.

●     The printer and computer must be connected using a USB cable.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities

Maintaining the Printer Using Utilities

If you repeatedly print, the inside of the printer will get dirty and print quality may degrade. Perform printer 
maintenance from the [Maintenance] tab in the printer properties dialog box.

Related topics

Nozzle Check  

Clean Print-heads (Normal)  

Clean Print-heads (Full)  

Adjust Print-head Positions  

Registration  

Adjust Paper Feed  

Restore Defaults/Other Settings  

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Nozzle Check

Nozzle Check

Follow the procedure below to check whether the print-head nozzles are clogged up or not by printing a nozzle check 
test pattern.

●     To check the printed test pattern, proceed to step .

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Nozzle Check].

Click [Next >].

Check that A4/Letter size paper is loaded in the paper tray.

Click [Next >].

Check the printed test pattern.

Normal

When print-heads are clogged

Click [Finish].

●     If the printed test pattern is not clear, select the [Clean print-heads (normal)] check box, and then click [Next >].

Nozzle Check
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Nozzle Check

●     Opening from the Start Menu

●     Opening from an Application

●     Clean Print-heads (Normal)

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Normal)

Clean Print-heads (Normal)

Follow the procedure below to perform a normal print-head cleaning. Perform a head cleaning when a particular color 
cannot be printed or print images are blurred. Head cleaning consumes ink.

●     When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head 

cleaning will be automatically performed.

Slide the envelope selector  to the forward position.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Clean Print-heads (Normal)].

In the [Select print-head(s)] area, select a color.

Click [Next >].

Click [Next >].

●     Do not perform another operation before cleaning is complete.

Click [Finish].

●     To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >]. 

Nozzle check starts.

Clean Print-heads (Normal)
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Clean Print-heads (Normal)

●     If the condition of the print-heads is not satisfactory, perform head cleaning again. However, the heads may remain clogged and the 

printer may not print properly even if you clean the heads multiple times. If this happens, perform a full print head cleaning. If there is 

still no improvement, turn the printer off, and then leave it overnight or longer. This may solve the problem.

●     Opening from the Start Menu

●     Opening from an Application

●     Nozzle Check

●     Clean Print-heads (Full)

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Full)

Clean Print-heads (Full)

Follow the procedure below to perform a thorough print-head cleaning. Since this consumes more ink than a normal 
head cleaning does, perform this when the problem persists after performing a normal head cleaning.

●     When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head 

cleaning will be automatically performed.

Slide the envelope selector  to the forward position.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Clean Print-heads (Full)].

In the [Select print-head(s)] area, select a color.

Click [Next >].

Select the [Clean print-heads (full)] check box.

Click [Next >].

Head cleaning starts.

●     Do not perform another operation before cleaning is complete.

Click [Finish].

Clean Print-heads (Full)
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Clean Print-heads (Full)

●     To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >]. The 

nozzle check starts.

●     A full print-head cleaning consumes a lot of ink. Perform it only when necessary. 

●     A full print-head cleaning may deplete the ink before the Print cartridge is expected to need to be changed.

●     Opening from the Start Menu

●     Opening from an Application

●     Nozzle Check

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Adjust Print-head Positions

Adjust Print-head Positions

Follow the procedure below to print a test pattern and adjust the print-head positions if vertical lines are printed 
unaligned or printed colors look blurred.

●     To check the printed test pattern, proceed to step .

●     When the envelope selector is not at the correct position, the colors may be printed unaligned.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Adjust Print-head Positions].

In the [Select a test pattern:] list, select a test pattern.

●     Select a resolution. To adjust print-head positions for all resolutions, repeat this procedure selecting the other resolution.

[High speed/ Standard (speed priority)] is selected here as an example.

Click [Next >].

Check that A4/Letter size paper is loaded in the paper tray.

Click [Next >].

A test pattern to adjust print-head positions is printed.

●     Do not perform other operations during printing.

●     The "High quality" test pattern differs from the "Standard" test pattern.

Check the optimal adjustment values on the printed test pattern.

●     The optimal adjustment value is the column number that appears above the lightest gray square with straight vertical lines on both sides. 

When the column number is "+2" for the "A" line, the optimal adjustment value is "+2" for "A".

Adjust Print-head Positions
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Adjust Print-head Positions

Enter the optimal adjustment values.

Click [Finish].

●     Repeat steps  to  to print the "High quality" or "Standard" test pattern and enter the optimal adjustment values.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Registration

Registration

Follow the procedure below to adjust where to start printing on paper loaded in each paper tray after checking the test 
pattern printed.

●     To check the printed test pattern, proceed to step .

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Registration].

In the [Unit type:] list, select a paper tray. In the [Paper type:] list, select a paper type.

Click [Next >].

Check that A4/Letter size paper is loaded in the paper tray.

Click [Next >].

A test pattern to adjust the print start position is printed.

●     Do not perform other operations during printing.

Check the optimal adjustment values on the printed test pattern.

●     Fold the test pattern sheet in half lengthwise.

●     The optimal adjustment value is the difference between the single vertical line and the cross's vertical line that you can see when the 

Registration
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Registration

folded paper is held up to light. When the difference is one calibration mark in the "+" direction, the optimal adjustment value for the 

[Printing direction:] is "+1.0".

●     Fold the test pattern sheet in half widthwise, and then check the adjustment value for the [Paper feed direction:].

●     Adjustment values are in 0.1 increments.

In the [Printing direction:] and [Paper feed direction:] boxes, enter the adjustment values (-4.0 to +4.0) 

from step .

Click [Finish].

●     If a test pattern does not print or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then click 

[Next >]. A registration test pattern is printed and the dialog box displayed in step .

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Adjust Paper Feed

Adjust Paper Feed

If horizontal lines are printed unaligned or print images are patchy, print a test pattern, and then adjust the paper feed 
setting.

●     To check the printed test pattern, proceed to step .

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Adjust Paper Feed].

Click [Next >].

Check that A4/Letter size paper is loaded in the paper tray.

Click [Next >].

A test pattern to adjust paper feed is printed.

●     Do not perform other operations during printing.

Check the optimal adjustment values on the printed test pattern.

●     The optimal adjustment value is the number that appears on the left of the lightest gray square with straight horizontal lines on both 

sides. When this number is "+2", the optimal adjustment value is "+2".

●     When horizontal lines beside the lightest gray square are broken, select the optimal adjustment value by referring to the lines broken in 

Adjust Paper Feed
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Adjust Paper Feed

the opposite direction. When the "+2" square is the lightest gray square and the "+6" horizontal lines are broken in the opposite 

direction, the optimal adjustment value is between "+3" and "+5". After adjustment, check the adjustment result.

In the [Paper feed value:] box, enter the adjustment value (-14 to +14) from step .

Click [Finish].

●     If a test pattern is not printed or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then click 

[Next >].

●     Opening from the Start Menu

●     Opening from an Application
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings

Restore Defaults/Other Settings

Follow the procedure below to restore the settings to their defaults or specify the amount of time the printer will wait 
for more information from the computer sending the print data before it times out (I/O timeout).

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Restore Defaults/Other Settings].

The [Restore Defaults/Other Settings] dialog box appears.

●     Opening from the Start Menu

●     Opening from an Application

Related topics

Restoring the Settings to Their Defaults  

Specifying an I/O Timeout  

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings > Restoring the Settings to Their Defaults

Restoring the Settings to Their Defaults

Follow the procedure below to restore the settings for [Adjust Print-head Positions], [Registration], [Adjust Paper 
Feed], and [I/O Timeout:] to their defaults.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Restore Defaults/Other Settings].

Click [Restore Defaults]

A confirmation message appears.

Click [OK].

●     The settings currently made for [Adjust Print-head Positions], [Registration], [Adjust Paper Feed], and [I/O Timeout:] will be lost. These 

settings cannot be restored. 

●     Opening from the Start Menu

●     Opening from an Application

●     Adjust Print-head Positions

●     Registration

●     Adjust Paper Feed

●     Specifying an I/O Timeout
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings > Specifying an I/O Timeout

Specifying an I/O Timeout

Follow the procedure below to specify the amount of time the printer will wait for more information from the 
computer sending the print data before it times out.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Restore Defaults/Other Settings].

The [Restore Defaults/Other Settings] dialog box appears.

In the [Select a time period] area, select the amount of time in the [I/O Timeout:] list.

Click [OK].

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Checking the Current Printer Driver Version

Checking the Current Printer Driver Version

Follow the procedure below to check the version of the printer driver currently installed.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [About].

The [About] dialog box appears.

Check the version.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Uninstalling the Printer Driver

Uninstalling the Printer Driver

Follow the procedure below to uninstall the current printer driver before installing the new version of the printer driver.

●     The Printer Status monitor installed with the current printer driver will be uninstalled when the current printer driver is uninstalled.

●     Custom settings registered are also deleted. To continue using the registered custom settings, save them as custom setting files before 

uninstalling.

On the [Start] menu, point to [Settings], and then click [Printers].

●     Under Windows XP Professional, click [Printers and Faxes] on the [Start] menu.

●     Under Windows XP Home Edition, click [Control Panel] on the [Start] menu. Click [Printers and Other Hardware], and then click 

[Printers and Faxes].

Click the icon of the printer, and then click [Delete] on the [File] menu.

A confirmation message appears. Click [Yes].

The printer driver is uninstalled.

●     Saving a Registered Custom Setting in a File

Top Previous Next
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Printer Driver

Opening the Printer Properties Dialog Box

Opening from the Start Menu

For Windows 95/98/Me

For Windows 2000, Windows NT 4.0

For Windows XP, Windows Server 2003

 Opening from an Application

Displaying the Printer Status

Opening the Printer Status Monitor

Printer Properties Settings

Using Help

Displaying an Explanation for Each Setting Item (Context Help)

Displaying Help in a Help Window (Content Help)

 Checking Whether Bidirectional Communication is Working or Not

Maintaining the Printer Using Utilities

Nozzle Check

Clean Print-heads (Normal)

Clean Print-heads (Full)

Adjust Print-head Positions

Registration

Adjust Paper Feed

Restore Defaults/Other Settings

Restoring the Settings to Their Defaults

Specifying an I/O Timeout

Checking the Current Printer Driver Version

Uninstalling the Printer Driver
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Paper > Loading Paper

Loading Paper

Load paper into the paper tray.

Normally, load paper into tray 1. Tray 2 (optional) can be used if installed.

●     Load paper with the paper grain parallel to the feed direction.

●     Printing on Thick Paper

Related topics

Loading Paper into Tray 1  

Loading Paper into Tray 2 (optional)  

Top Previous Next
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Paper > Loading Paper > Loading Paper into Tray 1

Loading Paper into Tray 1

Follow the procedure below to load paper into tray 1.

Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

Hold both sides of tray 1, and pull it toward you.

●     Tray 1 cannot be detached. Do not pull it forcefully.

Squeeze the paper guide release, and then slide the side paper guides into position according to the 

paper size.

Loading Paper into Tray 1
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Loading Paper into Tray 1

●     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

Load paper with the print side face down but not over the limit mark.

Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

Hold both sides of tray 1, and push it gently in until it stops.
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Loading Paper into Tray 1

Lower the output tray.

Top Previous Next
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Paper > Loading Paper > Loading Paper into Tray 2 (optional)

Loading Paper into Tray 2 (optional)

Follow the procedure below to load paper into tray 2.

●     Only plain paper can be loaded in tray 2.

Hold both sides of tray 2, lift it slightly, and pull it toward you.

●     Pull tray 2 completely out. Take care not to drop it.

Lift off the cover.

Squeeze the paper guide release, and then slide the paper guides into position according to the paper 

size.

Loading Paper into Tray 2 (optional)
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Loading Paper into Tray 2 (optional)

Load paper with the print side face down but not over the limit mark.

Re-attach the cover.

Hold both sides of tray 2, and push it gently in until it stops.
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Loading Paper into Tray 2 (optional)

Related topics

Loading Paper Larger than A4 (Letter)  

Top Previous Next
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Paper > Loading Paper > Loading Paper into Tray 2 (optional) > Loading Paper Larger than A4 (Letter)

Loading Paper Larger than A4 (Letter)

Follow the procedure below to use the paper tray extension for paper larger than A4 (Letter) size, such as legal size 
paper.

Pull tray 2 toward you, until it is completely out of the printer, and then lift off the cover.

Slide the tabs on both sides of the tray's interior to the unlocked position.

Pull out the paper tray extension.

Loading Paper Larger than A4 (Letter)
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Loading Paper Larger than A4 (Letter)

Slide the tabs back into place to lock the paper tray extension into position.

Squeeze the paper guide release, and then slide the paper guides into position according to the paper 

size.

●     Do not use the paper tray extension for A4 (Letter) size paper or smaller paper. Use it only for long paper.

Top Previous Next
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Paper > Compatible Paper

Compatible Paper

Before printing, check the paper types compatible with this printer.

Related topics

Compatible Paper Types  

Compatible Paper Sizes  

Paper Handling Precautions  

Printable Area  

Top Previous Next
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Paper > Compatible Paper > Compatible Paper Types

Compatible Paper Types

You can use various types of paper.

●     Plain paper

This paper is normally used for copying and printing. Unlike inkjet plain paper or semi-gloss photo paper, it is 
uncoated.

●     Inkjet plain paper

This extra-white plain paper makes the printed colors appear more vivid. Since it does not have an ink-
absorbent coating, you can write on it and use it for photocopying, just like regular plain paper.

●     Semi-gloss photo paper

Glossy photo paper with reduced reflection is a good match for the pigmented inks used by the machine. Paper 
for dye inks is not recommended because the machine's pigmented inks may not take properly to it or may 
smear or rub off. Glossy photo paper can be used in this machine provided it is compatible with pigmented inks.

●     Inkjet transparency

Transparency film for equipment such as overhead projectors is designed for the pigmented inks used by the 
machine. Film for plain paper copiers cannot be used because it does not absorb ink. Film for dye inks is not 
recommended because the machine's pigmented inks may not take properly to it or may smear or rub off. 
Transparency film can be used in this machine provided it is compatible with pigmented inks.

●     Envelopes

For details about the types of envelope that can be used, see Paper Handling Precautions. Paper Handling 

Precautions

●     Thick paper

For details about the types of thick paper that can be used, see Paper Handling Precautions. Paper Handling 

Precautions

●     All types of paper besides thick paper can be loaded in tray 1.

●     Only plain paper can be loaded in tray 2 (optional).

●     Printing on Various Paper Types

Top Previous Next
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Paper > Compatible Paper > Compatible Paper Sizes

Compatible Paper Sizes

You can use various sizes of paper.

Standard Sizes

●     A4*1

●     A5 (landscape)

●     A6

●     B5*1

●     Exective (184.2 × 266.7 mm (7.3 × 10.5 inches))*1

●     F (203.2 × 330.2 mm (8.0 × 13.0 inches))*1

●     Foolscap (F4) (215.9 × 330.2 mm (8.5 × 13.0 inches))*1

●     Folio (209.5 × 330.2 mm (8.3 × 13.0 inches))*1

●     Letter*1

●     Legal*1

●     5 1/2" × 8 1/2" (landscape)

Custom paper sizes

●     Custom paper sizes: 148-356mm (length) × 90-216mm (width), (5.9-14.1 inches (length) × 3.6-8.5 
inches (width))

●     Custom paper sizes with the bypass tray: 148-1295.4mm (length) × 90-216mm (width), (5.9-51.0 inches 
(lengths) × 3.6-8.5 inches (width))

Envelopes

●     Com10 (104.8 × 241.3 mm (4.2 × 9.5 inches))

●     Monarch (98.4 × 190.5 mm (3.9 × 7.5 inches))

●     C6 (114 × 162 mm (4.5 × 6.4 inches))

●     C5 (162 × 229 mm (6.4 × 9.1 inches))

●     DL Env (110 × 220 mm (4.4 × 8.7 inches))

*1 Can also be loaded in Tray 2 (optional).
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Paper > Compatible Paper > Paper Handling Precautions

Paper Handling Precautions

To ensure optimum print results, take care when handling paper before and after printing.

Loading precautions

●     Use compatible paper.

●     Load paper with the print side face down in the paper trays.

●     Load paper with the paper grain parallel to the feed direction.

●     Do not load paper of different types at the same time.

●     Do not stack paper over the limit mark.

●     Curled paper may jam. Straighten any curls before loading.

●     Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or 
similar object.

●     When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of 

Paper Handling Precautions
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Paper Handling Precautions

the bypass tray guides.

Paper storage precautions

●     Do not store paper in humid places.

●     Do not store paper in direct sunlight.

●     Store paper flat.

●     Store unused paper in the original package.

Paper type precautions

Plain paper

●     Use the bypass tray to print on paper heavier than 105 g/m2 (198.5 lb.).

●     Depending on the type of paper, the ink may take time to dry. With duplex printing, the ink may 
smear or rub off. Using the printer driver, specify how long to wait for the ink to dry between 
printing each side of a duplex sheet. For details, see the printer driver Help. Opening the Printer 

Properties Dialog Box

Inkjet plain paper

●     When printing on inkjet plain paper, in the printer properties dialog box, click [Inkjet Plain Paper]. 
This allows printing at higher quality.

●     In the printer properties dialog box, when [Inkjet Plain Paper] is selected, only one-sided printing 
is possible. To print on both sides of a sheet, click [Plain].

●     The ink may smear depending on the type of image. If this happens, set the envelope selector to 
the rear position .

●     Use as soon as possible after opening the package.

Semi-gloss photo paper

●     The glossy side (or the pearl side) of the paper is the printing surface.

●     Handle paper by the edges so as not to dirty or leave fingerprints on the print side.

●     Make sure that sheets are not badly bent or scratched, and the print side is not damaged.

●     Only one-sided printing is possible.

●     After printing, do not touch the printed side until the ink has fully dried.

●     If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

●     Make sure that the output tray has no more than twenty sheets stacked on it.

●     Semi-gloss photo paper is designed for photograph printing. For graphics, we recommend plain or 
inkjet plain paper.
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Paper Handling Precautions

●     When using these sheets, see the instructions supplied with them.

Inkjet transparency

●     Identify the print side by orientating the sheet vertically, so that the notched corner is at the bottom 
left. The side facing you is the print side.

●     Load one sheet at a time. If multiple sheets are loaded, the leading edge of transparencies may get 
scratched.

●     Handle sheets by the edges so as not to dirty or leave fingerprints on the print side.

●     Make sure that sheets are not badly bent or scratched, and the print side is not damaged.

●     Only one-sided printing is possible.

●     Remove sheets from the output tray individually, as they come out.

●     After printing, do not touch the printed side until the ink has fully dried.

●     If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

●     Ink takes time to dry. To prevent sheets from sticking together, remove them from the output tray 
individually, as they come out.

●     If printing comes out streaked, adjust the paper feed level. See Adjust Paper Feed .

●     Use at 15-25°C (59-77°F) and 30-70% humidity.

●     Use as soon as possible after opening the package.

●     When using these sheets, see the instructions supplied with them.

Envelopes

●     Feed envelopes one by one into the bypass tray at the back of the machine.

●     Squeeze the excess air from the envelopes, making them as flat as possible.

●     Load them properly, because the printable area depends on the orientation. See Printable Area .

Thick paper

●     Use tray 1 to load paper lighter than 105 g/m2 (198.5 lb.).

●     You can insert paper with weights up to 163 g/m2 (308.7 lb.) into the bypass tray.

●     Insert paper with the print side face up into the bypass tray.

Cautions to Observe After Printing

Depending on the paper type, the ink may take a while to dry. After printing, be careful not to touch the printed 
side until the ink has dried properly; otherwise, the ink may smudge.

●     Printing on Various Paper Types

Top Previous Next
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Paper > Compatible Paper > Printable Area

Printable Area

Printable and unprintable areas

1.  Feed Direction

2.  Printable Area

3.  3 mm (0.12 inches)

●     Do not attempt to print beyond the guaranteed printable area. Paper feed precision is reduced around the printable area limits, resulting in 

lower print quality.

●     When printing on envelopes, the following print area limitations apply.

1.  Feed Direction

2.  Printable Area

3.  8 mm (0.4 inches)

4.  38 mm (1.5 inches)

5.  5 mm (0.2 inches)

Top Previous Next
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Paper > Non-compatible Paper

Non-compatible Paper

Check if the paper is compatible.

Do not use paper that is:

●     wrinkled, folded, or damaged

●     wavy at the ends

●     curled

●     absorbent

●     dry and conducive to static buildup

●     already printed on

●     preprinted (unless specified)

●     heat sensitive/non-carbon

●     too thick or thin

●     pre-stitched or hole-punched

●     glued or tacked

●     stapled or clipped together

●     dark in places

●     irregular in length and proportion

●     Even if compatible paper types are used, print quality may be lower than usual or paper jams may occur if the paper was improperly stored.
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Troubleshooting > Printing Will Not Start

Printing Will Not Start

If printing will not start, check whether the power of the printer is on or whether the power can be turned on or not.

Related topics

Power Cannot Be Turned On  

Paper Will Not Feed Even When the Power Is On  

Top Previous Next
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Troubleshooting > Printing Will Not Start > Power Cannot Be Turned On

Power Cannot Be Turned On

If the [Power] key does not light or does not blink when it is pressed, check if there is something wrong with the 
power cord or wall outlet.

Check the following:

●     Make sure that the power plug is firmly inserted into the wall outlet.

●     Check if there is something wrong with the wall outlet. Do this by connecting another electronic product whose 
operation you are familiar with.

Top Previous Next
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Troubleshooting > Printing Will Not Start > Paper Will Not Feed Even When the Power Is On

Paper Will Not Feed Even When the Power Is On

If printing will not start even when the power is on, check if an error has occurred using the indicators or Printer Status 
monitor.

An indicator is lit or blinking

Only the [Power] key is blinking.

The printer may be receiving data or replenishing its ink. Wait momentarily for the blinking [Power] key to stop 

and stay lit.

The [Test Paper Feed/Resume] key or a low ink indicator is blinking or lit.

An error has occurred. See Error Indicator Summary .

An error message is displayed on the Printer Status monitor.

Click [User Guide...] to display the page corresponding to the error where you can check how to solve the problem in 

more detail. See Printer Status Monitor Errors .

 

A print sample can be printed using keys on the control panel to check that the printer is not out of order.

When the power is off, while holding down the [Cancel] key and the [Test Paper Feed/Resume] key, press and 
hold down the [Power] key for over three seconds. The low ink indicators will light once and a print sample will 
be delivered.
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Troubleshooting > Paper Is Not Fed or Delivered Normally

Paper Is Not Fed or Delivered Normally

If the printer is operating but paper will not feed or paper jams multiple times, check the condition of the printer and 
paper.

Paper does not feed smoothly.

Paper guides are not adjusted properly.

●     The paper guides of the paper tray do not match the paper loaded. Adjust the paper guides and load the paper 

again. See Loading Paper .

Paper is not loaded properly.

●     The paper is not loaded properly. Load the paper correctly. See Loading Paper .

Paper is curled.

●     Remove the loaded paper and check if it is curled. If it is, straighten the curl.

Paper that is not compatible is loaded.

●     Remove the loaded paper and replace it with compatible paper. See Non-compatible Paper .

Paper jams multiple times.

The guide board is not closed.

●     Make sure that the guide board is closed. Remove the duplex unit and press both sides of the guide board until 

it clicks closed.

Multiple sheets are inserted in the bypass tray.

●     When using the bypass tray, insert paper one sheet at a time. See Printing on Thick Paper .

The tray 2 rear cover is not closed.

●     Make sure that the tray 2 rear cover is closed. Press both sides of the cover until it clicks closed.

Paper Is Not Fed or Delivered Normally
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Paper Is Not Fed or Delivered Normally

Printing densely colored images on both sides.

●     When printing images containing areas of solid color that consume a lot of ink, we recommend single-sided 

printing.

Multiple sheets of paper are fed at one time.

Load the paper again. Remove the paper from the paper tray, fan it well, and tap it on a flat surface such as a desk to 

even the edges. Check the position of the paper guides of the paper tray, and then load the paper again.

Though a paper jam is cleared, paper does not feed.

When a paper jam occurs, clear the paper jam, and then press the [Test Paper Feed/Resume] key. See Paper Jam .

●     If an error is displayed on the Printer Status monitor, follow the instructions to solve the problem.Printer Status Monitor Errors .
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Troubleshooting > Paper Jam

Paper Jam

This explains how to remove a paper jam. When a paper jam error appears in the Printer Status monitor, remove the 
paper from the location indicated.

●     If you cannot locate paper jams or jammed paper cannot be removed easily, you can check the condition of paper from the top of the printer.

Related topics

Removing Paper Jammed in the Paper Tray (Tray 1)  

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)  

Removing Paper Jammed in the Bypass Tray  

Removing Paper Jammed under the Top Cover  

Removing Paper Jammed around the Guide Board  

Removing Paper Jammed in the Duplex Unit  

Removing Paper Jammed in the Output Tray  
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Paper Tray (Tray 1)

Follow the procedure below to remove paper jammed in tray 1.

Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

Hold both sides of tray 1, and then pull it toward you.

●     Tray 1 cannot be detached. Do not pull it forcefully.

Remove jammed paper.

●     If you cannot remove the jammed paper or it is difficult to remove, the paper may be jammed inside the printer. Examine the paper 

carefully and remove.

●     If you cannot locate jammed paper, it may be jammed inside the printer.

Hold both sides of tray 1, and push it gently in until it stops.

Lower the output tray.

Press the [Test Paper Feed/Resume] key.

Printing starts.

Removing Paper Jammed in the Paper Tray (Tray 1)
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Removing Paper Jammed in the Paper Tray (Tray 1)

●     Blank paper may be delivered after printing resumes.

●     Removing Paper Jammed around the Guide Board

●     Paper Is Not Fed or Delivered Normally
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Follow the procedure below to remove paper jammed in tray 2 (optional).

Hold both sides of tray 2, lift it slightly, and pull it toward you.

●     Pull tray 2 completely out. Take care not to drop it.

Lift off the cover.

Remove jammed paper.

Re-attach the cover.

Hold both sides of tray 2, and push it gently in until it stops.

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Blank paper may be delivered after printing resumes.

If you cannot locate paper jammed in tray 2, follow the procedure below to remove the paper jammed.

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

While pushing the tabs on both sides of the tray 2 rear cover toward the inside, open the tray 2 rear 

cover.

Remove jammed paper.

Close the tray 2 rear cover.

●     Press both sides of the cover until it clicks closed.

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Blank paper may be delivered after printing resumes.

●     Paper Is Not Fed or Delivered Normally
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed in the Bypass Tray

Follow the procedure below to remove paper jammed in the bypass tray.

Remove jammed paper.

Press the [Test Paper Feed/Resume] key.

●     The [Test Paper Feed/Resume] key stops blinking and stays lit.

Insert a sheet of paper into the bypass tray with the print side face up.

Press the [Test Paper Feed/Resume] key.

Printing starts.

If it is difficult to remove jammed paper, follow the procedure below to remove it.

Removing Paper Jammed in the Bypass Tray
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Removing Paper Jammed in the Bypass Tray

Move the duplex unit locks to the unlocked position, and then detach the duplex unit.

Remove jammed paper.

Attach the duplex unit, and then move the duplex unit locks to the locked position.

Press the [Test Paper Feed/Resume] key.

●     The [Test Paper Feed/Resume] key stops blinking and stays lit.

Insert a sheet of paper into the bypass tray with the print side face up.

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Paper Is Not Fed or Delivered Normally

Top Previous Next
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Troubleshooting > Paper Jam > Removing Paper Jammed under the Top Cover

Removing Paper Jammed under the Top Cover

Follow the procedure below to remove paper jammed under the top cover.

Open the top cover.

If the carriage stops in the middle, move it to whichever side is easier to move it to.

Remove jammed paper.

●     Take care not to snag the sleeves of your clothing on the cord.

●     Do not touch the feed belt.

Close the top cover.

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

Top Previous Next
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Removing Paper Jammed under the Top Cover
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Troubleshooting > Paper Jam > Removing Paper Jammed around the Guide Board

Removing Paper Jammed around the Guide Board

Follow the procedure below to remove paper jammed around the guide board.

Move the duplex unit locks to the unlocked position, and then detach the duplex unit.

Unlock the guide board by moving the tabs on both sides toward the middle, and then open the guide 

board.

Turn the paper feed wheel to release paper from the feed belt.

Release paper from the roller to make it removable.

Insert your finger between the paper and the roller, and then remove the paper slowly.

●     Do not touch the feed belt.

Close the guide board.

●     Push the PUSH area on both sides of the guide board until it firmly closes.

Attach the duplex unit, and then move the duplex unit locks to the locked position.

Press the [Test Paper Feed/Resume] key.

Printing starts.

Removing Paper Jammed around the Guide Board
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Removing Paper Jammed around the Guide Board

●     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

●     Paper Is Not Fed or Delivered Normally

Top Previous Next
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Duplex Unit

Follow the procedure below to remove paper jammed in the duplex unit.

Press the duplex unit cover button, and then open the duplex unit.

Remove jammed paper.

Close the duplex unit cover.

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

Top Previous Next
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Removing Paper Jammed in the Duplex Unit
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Output Tray

Removing Paper Jammed in the Output Tray

Follow the procedure below to remove paper jammed in the output tray.

Remove jammed paper.

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

Top Previous Next

Copyright © 2004 All rights reserved.

Removing Paper Jammed in the Output Tray
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Troubleshooting > Print Results Are Not Satisfactory

Print Results Are Not Satisfactory

If there is a problem with the quality of the printing such as dirty or faint and patchy prints, first check the condition of 
the printer.

Check the following:

Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position ; for 

everything else, set the lever to the forward position . See Printing on Various Paper Types .

Has the printer not been used for a long time?

The ink may be dry or the nozzles of the print-heads may be clogged. Print the nozzle check test pattern and clean the 

print-heads as necessary. See Nozzle Check  and Clean Print-heads (Normal) .

Has the nozzle check test pattern been printed?

Print the nozzle check test pattern and check whether the print-heads are clogged. Clean the print-heads as necessary. 

See Nozzle Check  and Clean Print-heads (Normal) .

Have the print-heads been aligned?

If the image is fuzzy or lines are doubled, align the print-heads. If the problem persists, print the nozzle check test 

pattern and clean the print-heads as necessary. See Adjust Print-head Positions , Nozzle Check , and Clean Print-

heads (Normal) .

Is there a problem with the printer's location?

Make sure that the printer is level. Place the printer in a location where it will not be subject to shaking or excessive 

force.

Related topics

Printing Is Uneven, Too Heavy, or Too Light  

Dirty or Blotted Prints  

Top Previous Next
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Troubleshooting > Print Results Are Not Satisfactory > Printing Is Uneven, Too Heavy, or Too Light

Printing Is Uneven, Too Heavy, or Too Light

If there is a problem with the quality of the printing such as uneven printing or an inappropriate amount of ink being 
used, the following questions should be addressed.

Is an old Print cartridge being used?

Print cartridges should be opened before their expiration date and used within six months of being opened.

Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various 

Paper Types .

Are you printing on the wrong side of the paper?

Check which side should be printed on when using inkjet plain paper. If you print on the wrong side, the quality of the 

printing may be lower and the inside of the printer may get dirty. See Paper Handling Precautions .

Is the setting of the envelope selector suitable?

The printed side may become worn depending on the type of image. If this happens, set the envelope selector to the 

rear position .

Is the brightness of the image suitable?

If the printing is being smeared even when the envelope selector is set to the rear position , the density of the 

printing may be too high. Increase the brightness of the image.

Is the [Duplex/Booklet] check box selected?

Duplex printing tends to produce fainter prints than single-sided printing. When performing single-sided printing, 

make sure the [Duplex/Booklet] check box is not selected. 

Top Previous Next
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Troubleshooting > Print Results Are Not Satisfactory > Dirty or Blotted Prints

Dirty or Blotted Prints

If prints are dirty or blotted, the following questions should be addressed.

Is the paper being used too thick or thin?

Check if the paper is compatible. If extremely thick or thin paper is used, the print-heads will rub the paper and ink 

will leak. See Compatible Paper .

Does the print-heads rub when plain paper is used?

Set the envelope selector to the rear position .

Have you touched the printed side of paper?

Avoid touching the printed side of paper. Particularly, avoid touching semi-gloss photo paper and inkjet transparency 

that have just been printed because the ink takes time to dry. Remove them one at a time from the output tray without 

touching the printed side, and then let them dry fully. See Paper Handling Precautions .

Is the inside of the printer dirty?

If the leading edge or back side of printed paper is dirty, the inside of the printer may be dirty. Also, if black vertical 

lines appear on the printed side of paper, the delivery rollers may be dirty. Turn the power off, and then while pressing 

the [Test Paper Feed/Resume] key, press and hold down the [Power] key for over three seconds. A blank sheet of 

paper will be delivered to clean the delivery rollers. Repeat this operation multiple times.

Is the paper loaded in the correct orientation?

Some paper cannot be loaded lengthwise depending on the size of the paper. Check the orientation in which the paper 

is loaded. See Compatible Paper Sizes .

Is a genuine Print cartridge being used?

Using a cartridge other than a genuine Print cartridge or using a cartridge refilled with ink will lower the print quality 

and could cause a breakdown. Use a genuine Print cartridge. See Recommended Consumables .

Are you printing densely colored images on both sides of paper?

When a large amount of ink is used to completely cover a side, one-sided printing is recommended.

When duplex printing, after printing one side of a sheet, does the machine wait for the ink to dry before 

printing the other side?

Depending on the type of paper, the ink may not have enough time to dry properly and so may smear or rub off. Using 

Dirty or Blotted Prints
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Dirty or Blotted Prints

the printer driver, specify how long to wait for the ink to dry between printing each side. For details, see the printer 

driver Help.Opening the Printer Properties Dialog Box
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Troubleshooting > Print Results Do Not Match the Displayed Image

Print Results Do Not Match the Displayed Image

If there are differences between the print results and the displayed image, first check the printer driver.

Check the following:

Does the printer driver of the printer support the application used?

Check if an application other than a Windows operating system application is being used.

Is the printer driver of the printer being used?

Make sure that the printer you want to use for printing is selected. See Opening from an Application .

Does data from a failed print job or canceled print job remain in memory?

Check whether data from a failed print job or canceled print job remains in memory. See Canceling Printing .

Related topics

Characters and Colors Do Not Match the Displayed Image  

Positions Do Not Match the Displayed Image  

Top Previous Next
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Troubleshooting > Print Results Do Not Match the Displayed Image > Characters and Colors Do Not Match the Displayed Image

Characters and Colors Do Not Match the Displayed Image

If there are differences between the characters and colors of the print results and the displayed image, the following 
questions should be addressed.

Has the hue of colors been adjusted?

Since printed colors and screen colors are produced by different methods, a color printed and a color displayed on a 

screen can have different hues even though they are the "same" color. Use the color matching function to make the 

hue of printed colors and displayed colors closer. See Changing the Color Profiling Pattern .

Has the nozzle check been performed?

The print-heads may be clogged and the amount of ink may not be able to be regulated. Print the nozzle check test 

pattern and clean the print-heads as necessary. See Clean Print-heads (Normal)  and Nozzle Check .

Was printing done in black and white?

Check the color setting of the application and the color print setting of the printer driver. See Printing in Black and 

White .

Have the print quality settings been made?

Set the printing resolution to an appropriate level. See Printing Using Preset Print Quality Settings .

Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various 

Paper Types .

Have you tried printing with inkjet plain paper?

Try printing with inkjet plain paper. The print results should be clearer. See Printing on Various Paper Types .

Top Previous Next
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Troubleshooting > Print Results Do Not Match the Displayed Image > Positions Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

If the position of printed items differs from the position of displayed items, the following questions should be 
addressed.

Have the settings for page layout been made?

Check whether page layout settings have been made with the application.

Does the paper size setting match?

Make sure that the paper size selected in the [Printout paper size:] list of the printer properties dialog box matches the 

size of the paper loaded.

Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position ; for 

everything else, set the lever to the forward position . See Printing on Various Paper Types .

Have the print-heads been aligned?

When bidirectional printing is performed, and lines and characters are blurred, align the print-heads. If the problem 

persists, print the nozzle check test pattern and clean the print-heads as necessary. See Adjust Print-head Positions , 

Nozzle Check , and Clean Print-heads (Normal) .
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Troubleshooting > Printer Status Monitor Does Not Open

Printer Status Monitor Does Not Open

If the Printer Status monitor does not open for a shared printer, the following questions should be addressed.

Are the share settings correct?

Check the share settings of the printer. The printer driver must also be installed on the client computer. See Setting Up 

a Server  and Setting Up a Client Computer .

Does your Web browser support Printer Status Monitor?

Internet Explorer version 4.0 or later is required to display Printer Status Monitor and the dialog boxes displayed from 

the [Maintenance] tab of the printer driver.

Top Previous Next
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Troubleshooting > Printer Status Monitor Errors

Printer Status Monitor Errors

If an error occurs with the printer, Printer Status Monitor displays an error message. Click [User Guide...] to display 
the page corresponding to the error where you can check how to solve the problem in more detail.

Related topics

No Response from Printer  

No Paper/Tray Not Detected (Bypass Tray)  

No Paper/Tray Not Detected (Tray 1)  

No Paper/Tray Not Detected (Tray 2)  

Paper Size Mismatch (Bypass Tray)  

Paper Size Mismatch (Tray 1)  

Paper Size Mismatch (Tray 2)  

Cover Open  

Duplex Unit Not Detected  

Print Cartridge(s) Not Detected  

Paper in Bypass Tray  

Cartridge End  

Ink End  

Out of Printable Temperature Range  

Printer Error  
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Troubleshooting > Printer Status Monitor Errors > No Response from Printer

No Response from Printer

Follow the procedure below to check the port settings and the connection between the printer and computer.

Check that the power of the printer is on.

Make sure that the computer and printer are properly connected using a USB cable.

Open the printer properties dialog box.

Click the [Details] tab.

Check that USB is selected in the [Print to the following port:] list.

●     Under Windows 2000/XP or Windows Server 2003, check that USB is selected in the list on the [Port] tab.

●     Opening from the Start Menu

Top Previous Next
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Bypass Tray)

No Paper/Tray Not Detected (Bypass Tray)

If no paper is ready to be fed in the bypass tray, this message appears. Follow the procedure below to insert paper into 
the bypass tray.

Slide the bypass tray guides into position according to the paper size.

Insert a sheet of paper into the bypass tray with the print side face up.

●     Support the sheet with your hands to keep it from sliding out and dropping.

●     Insert the sheet straight into the bypass tray.

Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

No Paper/Tray Not Detected (Bypass Tray)
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No Paper/Tray Not Detected (Bypass Tray)

Printing starts.
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 1)

No paper is loaded in tray 1 or paper is not loaded properly. Follow the procedure below to load paper properly.

Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

Hold both sides of tray 1, and pull it toward you.

●     Tray 1 cannot be detached. Do not pull it forcefully.

Squeeze the paper guide release, and then slide the side paper guides into position according to the 

paper size.

No Paper/Tray Not Detected (Tray 1)
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No Paper/Tray Not Detected (Tray 1)

●     If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges. Check 

that the position of the paper guides and the front end guide match the paper size.

●     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

Load paper with the print side face down but not over the limit mark.

Squeeze the front end paper guide, and then slide it to meet the edge of the paper.
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No Paper/Tray Not Detected (Tray 1)

Hold both sides of tray 1, and push it gently in until it stops.

Lower the output tray.

Press the [Test Paper Feed/Resume] key.

Printing starts.
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Tray 2)

No Paper/Tray Not Detected (Tray 2)

No paper is loaded in tray 2 (optional) or paper is not loaded properly. Follow the procedure below to load paper 
properly.

Hold both sides of tray 2, lift it slightly, and pull it toward you.

●     Pull tray 2 completely out. Take care not to drop it.

Lift off the cover.

Squeeze the paper guide release, and then slide the paper guides into position according to the paper 

size.

No Paper/Tray Not Detected (Tray 2)
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No Paper/Tray Not Detected (Tray 2)

●     If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges. Check 

that the position of the paper guides and the front end guide match the paper size.

Load paper with the print side face down but not over the limit mark.

Re-attach the cover.

Hold both sides of tray 2, and push it gently in until it stops.
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No Paper/Tray Not Detected (Tray 2)

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Loading Paper Larger than A4 (Letter)

Top Previous Next

Copyright © 2004 All rights reserved.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/t0011.htm (3 of 3)2005/10/05 11:23:58



Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Bypass Tray)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper 
size in the printer properties settings.

Open the printer properties dialog box from the application.

Click the [Page Settings] tab.

In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the 

paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

●     If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then select 

the correct sizes.

●     If paper of the incorrect size is loaded, proceed to the next step.

Slide the bypass tray guides into position according to the paper size.

Insert a sheet of paper into the bypass tray with the print side face up.

Paper Size Mismatch (Bypass Tray)
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Paper Size Mismatch (Bypass Tray)

●     Support the sheet with your hands to keep it from sliding out and dropping.

●     Insert the sheet straight into the bypass tray.

Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

Printing starts.

●     Opening from an Application

●     Canceling Printing
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Paper Size Mismatch (Bypass Tray)
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 1)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper 
size in the printer properties settings.

Open the printer properties dialog box from the application.

Click the [Page Settings] tab.

In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the 

paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

●     If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then select 

the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.

Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

Hold both sides of tray 1, and pull it toward you.

Paper Size Mismatch (Tray 1)
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Paper Size Mismatch (Tray 1)

●     Tray 1 cannot be detached. Do not pull it forcefully.

Remove loaded paper.

Squeeze the paper guide release, and then slide the side paper guides into position according to the 

paper size.

●     The front end paper guide may also need to be adjusted.

Load paper with the print side face down but not over the limit mark.
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Paper Size Mismatch (Tray 1)

Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

Hold both sides of tray 1, and push it gently in until it stops.

Lower the output tray.
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Paper Size Mismatch (Tray 1)

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Opening from an Application

●     Canceling Printing
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Tray 2)

Paper Size Mismatch (Tray 2)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper 
size in the printer properties settings.

Open the printer properties dialog box from the application.

Click the [Page Settings] tab.

In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the 

paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

●     If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then select 

the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.

Hold both sides of tray 2, lift it slightly, and pull it toward you.

●     When the output tray is lifted, tray 2 will pop out slightly. Pull tray 2 completely out. Take care not to drop it.

Lift off the cover.

Paper Size Mismatch (Tray 2)
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Paper Size Mismatch (Tray 2)

Remove loaded paper.

Squeeze the paper guide release, and then slide the paper guides into position according to the paper 

size.

Load paper with the print side face down but not over the limit mark.

Re-attach the cover.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/t0014.htm (2 of 4)2005/10/05 11:24:01



Paper Size Mismatch (Tray 2)

Hold both sides of tray 2, and push it gently in until it stops.

Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Loading Paper Larger than A4 (Letter)

●     Opening from an Application

●     Canceling Printing

Top Previous Next
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Paper Size Mismatch (Tray 2)
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Troubleshooting > Printer Status Monitor Errors > Cover Open

Cover Open

A cover is open. Close the cover.

Follow the procedure below to close the top cover or duplex unit cover.

Close the cover.

●     Check that the duplex unit is correctly attached and the duplex unit cover is closed.

If the [Test Paper Feed/Resume] key lights, press that key.

Cover Open

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/t0015.htm (1 of 2)2005/10/05 11:24:03

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Cover Open
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Troubleshooting

Printing Will Not Start

Power Cannot Be Turned On

Paper Will Not Feed Even When the Power Is On

Paper Is Not Fed or Delivered Normally

Paper Jam

Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed under the Top Cover

Removing Paper Jammed around the Guide Board

Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Output Tray

Print Results Are Not Satisfactory

Printing Is Uneven, Too Heavy, or Too Light

Dirty or Blotted Prints

Print Results Do Not Match the Displayed Image

Characters and Colors Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

Printer Status Monitor Does Not Open

Printer Status Monitor Errors

No Response from Printer

No Paper/Tray Not Detected (Bypass Tray)

No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 2)

Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 2)

Cover Open

Chapter contents - - User Guide
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Chapter contents - - User Guide

Duplex Unit Not Detected

Print Cartridge(s) Not Detected

Paper in Bypass Tray

Cartridge End

Ink End

Out of Printable Temperature Range

Printer Error

Adjusting the Printer

Error Indicator Summary
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Troubleshooting > Printer Status Monitor Errors > Duplex Unit Not Detected

Duplex Unit Not Detected

The duplex unit is not attached correctly. Follow the procedure below to attach the duplex unit correctly.

Re-attach the duplex unit.

Move the duplex unit locks to the locked position.

If the [Test Paper Feed/Resume] key lights, press that key.

●     Even if you are not duplex printing, the duplex unit must be attached. Otherwise printing will not start.

Top Previous Next
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Duplex Unit Not Detected
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Duplex Unit Not Detected
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Troubleshooting > Printer Status Monitor Errors > Print Cartridge(s) Not Detected

Print Cartridge(s) Not Detected

A Print cartridge is not installed correctly. Follow the procedure below to install the Print cartridge correctly.

Open the right front cover.

Push in the cartridge using the PUSH area.

Close the right front cover.

Print Cartridge(s) Not Detected
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Print Cartridge(s) Not Detected

●     If the error persists, take the Print cartridge out once, and then install it again. The procedure above should be performed only once.

Top Previous Next
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Troubleshooting > Printer Status Monitor Errors > Paper in Bypass Tray

Paper in Bypass Tray

This appears if paper is set before printing from the bypass tray starts. Follow the procedure below to remove the 
paper in the bypass tray.

Remove paper.

Press the [Test Paper Feed/Resume] key.

●     The [Test Paper Feed/Resume] key stops blinking and stays lit.

Insert a sheet of paper into the bypass tray with the print side face up.

Paper in Bypass Tray
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Paper in Bypass Tray

●     Support the sheet with your hands to keep it from sliding out and dropping.

●     Insert the sheet straight into the bypass tray.

Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

Printing starts.

Top Previous Next
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Paper in Bypass Tray
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Troubleshooting > Printer Status Monitor Errors > Cartridge End

Cartridge End

A Print cartridge is empty. Printing can continue using ink remaining in the printer; however, no ink is left in the Print 
cartridge. Check which color of cartridge needs to be replaced, and then replace it.

Checking ink color

●     Checking using the Printer Status monitor

❍     In the illustration above, the cyan Print cartridge is empty.

●     Checking the low ink indicators

❍     Blinking

In the illustration above, the cyan Print cartridge is empty.

❍     From left to right, the low ink indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print 

cartridges.

Cartridge End
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Cartridge End

❍     Since solid color printing on semi-gloss photo paper consumes a lot of ink of that color, printing may stop in the middle of 

the printing process because ink of that color is depleted.

❍     Do not perform a normal head cleaning or a full head cleaning unless it is necessary. Ink may run out making printing 

impossible.

❍     If you turn the power off and then on again, ink adjustment is performed in the printer which may result in the ink running 

out.

●     Replacing a Print Cartridge

●     Displaying the Printer Status

Top Previous Next
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Troubleshooting > Printer Status Monitor Errors > Ink End

Ink End

The ink is completely depleted. Printing cannot be performed. Replace the Print cartridge.

Checking ink colors

●     Checking using the Printer Status monitor

❍     In this illustration, the cyan Print cartridge has completely run out.

●     Checking the low ink indicators

❍     Lit

In this illustration, the cyan Print cartridge has completely run out.

❍     From left to right, the low ink indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print 

cartridges.

Ink End
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Ink End

❍     Head cleaning cannot be performed.

●     Replacing a Print Cartridge

●     Displaying the Printer Status

Top Previous Next
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Troubleshooting > Printer Status Monitor Errors > Out of Printable Temperature Range

Out of Printable Temperature Range

Follow the procedure below to relocate the printer when the temperature inside the printer is inappropriate, extremely 
high or low, for printing.

Turn off the power of the printer.

Place the printer in a 10 to 32°C (50 to 89.6°F) environment.

Turn on the power of the printer.

●     If humidity is more than 54%, the high end of the appropriate temperature range will be lower than usual.

●     Even after the power is turned on, the printer may remain in the standby mode until it acclimates to the room temperature. If this happens, 

wait until the [Power] key stops blinking and stays lit.

●     For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation 

Area", the Setup Guide.

Top Previous Next
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Out of Printable Temperature Range
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Troubleshooting > Printer Status Monitor Errors > Printer Error

Printer Error

An error has occurred in the printer. Turn the power off once, and then turn it back on.

●     If the printer is relocated from a cold area to a warm area or the printer is placed in a room where the temperature varies greatly, 

condensation may form inside the printer causing errors. If this happens, an error might not clear if the power is turned off and then on. Wait 

until the printer acclimates and the condensation disappears. This should take about one hour.

●     If the error still does not clear after the printer acclimates to room temperature and the power is turned back on, contact your sales or service 

representative.

Top Previous Next
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Printer Error
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Troubleshooting > Adjusting the Printer

Adjusting the Printer

Adjust the printer from the [Maintenance] tab in the printer properties dialog box.

●     Clean Print-heads (Normal)

●     Clean Print-heads (Full)

●     Adjust Print-head Positions

●     Registration

●     Adjust Paper Feed

Top Previous Next
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Adjusting the Printer
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Troubleshooting > Error Indicator Summary

Error Indicator Summary

You can check the status of the printer using the lit or blinking indicators on the control panel.

1.  Low ink indicators

2.  [Power] key

3.  [Test Paper Feed/Resume] key

4.  [Cancel] key

Status of Indicators Status/Solutions

A low ink indicator is lit.

(The [Power] key may be lit or blinking at the same time.)

The printer has completely run out of the indicated ink.

(In the illustration, the printer has run out of cyan ink.)

Further printing is impossible. Check the color 
indicated, and replace the corresponding print cartridge 
immediately.

Ink End .

Error Indicator Summary
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Error Indicator Summary

A low ink indicator is blinking.

(The [Power] key may be lit or blinking at the same time.)

The corresponding print cartridge has run out of ink.

(In the illustration, the cyan print cartridge has run out 
of ink.)

Printing can continue with the ink remaining in the 
printer, but there is no more ink in the print cartridge. 
Check the color indicated, and replace the 
corresponding print cartridge.

Cartridge End .

All the low ink indicators are lit.

(The [Power] key may be lit or blinking at the same time.)

The print cartridges are not installed or are not installed 
correctly.

Install the print cartridges correctly.

Print Cartridge(s) Not Detected .

All the indicators are blinking.

A maintenance error has occurred.

Turn the power off, and then on.

If that does not clear the error, contact your sales or 
service representative.

Where to Inquire .

The [Test Paper Feed/Resume] key is lit.

(The [Power] key may be lit or blinking at the same time.) There may be a problem with feeding paper.

Check the printer and paper, and then press the [Test 
Paper Feed/Resume] key.

Paper Is Not Fed or Delivered Normally .
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Error Indicator Summary

The paper tray may be empty.

Load the paper tray, and then press the [Test Paper 
Feed/Resume] key.

Loading Paper .

The [Power] key is blinking.

The printer is either warming up or receiving print data.

(If the blinking is slow, the printer is in standby mode 
with its main power off.)

If the blinking continues, the temperature inside the 
printer may be outside of the operating temperature 
range.

Turn the power off, move the printer to a location 
where the temperature is within the range 10-32°C (50-
89.6°F), and then turn the power on.

Out of Printable Temperature Range .

The [Test Paper Feed/Resume] key is blinking.

(The [Power] key may be lit or blinking at the same time.)

The duplex unit may not be installed correctly.

Install the duplex unit correctly, and then press the 
[Test Paper Feed/Resume] key.

Duplex Unit Not Detected .

A cover may be open.

Close the cover, and then press the [Test Paper Feed/
Resume] key.

Cover Open .

Paper may be jammed.

Remove the jammed paper, and then press the [Test 
Paper Feed/Resume] key.

Paper Jam .

The temperature inside the printer may have gone 
outside of the operating temperature range while the 
power was on, or the temperature may be outside of the 
operating temperature range now.

Turn the power off, move the printer to a location 
where the temperature within the range 10-32°C (50-
89.6°F), and then turn the power on.

Out of Printable Temperature Range .
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Error Indicator Summary

Paper of the correct size may not be loaded.

Load paper of the correct size, or change the printer 
driver settings.

Paper Size Mismatch (Bypass Tray) ,Paper Size 

Mismatch (Tray 1) , and Paper Size Mismatch (Tray 

2) .

●     For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation 

Area", the Setup Guide.
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Replacing a Print Cartridge > Checking the Remaining Ink

Checking the Remaining Ink

Follow the procedure below to check when to replace Print cartridges using the Printer Status monitor or the low ink 
indicators.

Checking using the Printer Status monitor

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Printer Status].

The Printer Status monitor dialog box appears.

Check the ink level illustration.

In the illustration above, the cyan Print cartridge is empty.

If the background of the image in the top left corner of dialog box is yellow, the indicated cartridge is empty. 
Replace the cartridge.

Checking the Remaining Ink

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0137.htm (1 of 3)2005/10/05 11:24:17

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Checking the Remaining Ink

In this illustration, the cyan ink has completely run out.

If the background of the image in the top left corner of dialog box is red, the printer has run out of the indicated 
ink. Replace the cartridge.

Checking the low ink indicators of the printer

●     Blinking

In the illustration above, the cyan Print cartridge is empty.

●     Lit

In the illustration above, the cyan ink has completely run out.

●     From left to right, the low ink indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print cartridges.

●     Opening the Printer Status Monitor

Top Previous Next
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Checking the Remaining Ink
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Replacing a Print Cartridge > Replacing a Print Cartridge

Replacing a Print Cartridge

Follow the procedure below to replace an empty Print cartridge.

Clear any errors, such as when there is a paper jam or when no paper is loaded, before replacing a Print cartridge.

Remove the Print cartridges' packaging.

●     If multiple cartridges are empty, replace all the empty cartridges. You can shorten the time for needed replacement.

Open the right front cover.

Take out the empty cartridges.

Check the cartridges' orientation, and then install them gently.

Install in the following order from the left: black, cyan, magenta, and yellow.

●     Take care to install the cartridges in the correct position.

Push in the cartridge using the PUSH area.

Close the right front cover.

●     Recommended Consumables

Replacing a Print Cartridge
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Replacing a Print Cartridge
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Replacing a Print Cartridge > Handling Print Cartridges

Handling Print Cartridges

Important points about handling Print cartridges are explained.

 
●     If ink comes into contact with your eyes, rinse immediately in running water. For other symptoms, consult a doctor.

 
●     If ink is ingested, induce vomiting by drinking a strong saline solution. Consult a doctor immediately.

 
●     If your skin comes into contact with ink, immediately wash the affected area with water or soap and water.

 
●     Keep the ink or ink container out of reach of children.

About Print cartridges

●     Print cartridges comply with the manufacturer's safety specifications. To ensure safety and reliability, 
use genuine Print cartridges.

●     When using the printer for the first time, install the Print cartridges supplied with the printer.

Using Print cartridges

●     Print cartridges should be opened before their expiration date and used within six months of being 
opened.

●     Do not open the package of a Print cartridge until the cartridge will be installed in the printer.

●     Do not touch the ink supply port of Print cartridges.

●     Do not shake Print cartridges strongly. Ink may leak out. 

●     Do not take apart Print cartridges.

●     Do not open the right front cover except when installing Print cartridges. Do not turn off the power or 
unplug the power cord during the process of installing the cartridges.

●     Always confirm the color of a Print cartridge before installing it.

●     Do not remove a Print cartridge once it has been installed unless necessary.

●     Do not remove a Print cartridge while printing is being performed. Printing will stop.

Storing Print cartridges

●     Avoid storing Print cartridges in hot or freezing places.

Ink consumption

●     In addition to printing, ink is consumed when the power is turned on, head cleaning is performed, or 
Print cartridges are installed.

Handling Print Cartridges
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Handling Print Cartridges
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Replacing a Print Cartridge

Checking the Remaining Ink

Replacing a Print Cartridge

Handling Print Cartridges
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Sharing the Printer > Setting Up a Server

Setting Up a Server

Follow the procedure below to set up a print server so that the printer can be shared by users.

●     Configure a computer connected to the printer as the print server.

●     The print server is a computer used to manage the shared printer on the network.

On the [Start] menu, point to [Settings], and then click [Control Panel].

Double-click [Network].

Click [File and Print Sharing...].

Select the [I want to be able to allow others to print to my printer(s).] check box.

Click [OK].

Install the printer driver.

On the [Start] menu, point to [Settings], and then click [Printers].

●     Under Windows XP Professional, click [Printers and Faxes] on the [Start] menu.

●     Under Windows XP Home Edition, click [Control Panel] on the [Start] menu. Click [Printers and Other Hardware], and then click 

[Printers and Faxes].

 Click the icon of the printer, and then click [Sharing...] on the [File] menu.

Click [Shared as:], and then enter a name in the [Shared as:] box.

Click [OK].

●     Configure a computer connected to the network, where the print server is connected, as a client computer.

●     For details about installing the printer driver, see "Installing the Printer Driver", the Setup Guide.

●     Setting Up a Client Computer

Setting Up a Server
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Setting Up a Server
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Sharing the Printer > Setting Up a Client Computer

Setting Up a Client Computer

Follow the procedure below to configure a computer as a client computer and connect it to the shared printer. Make 
this setting when installing the printer driver from the CD-ROM provided.

●     For Windows 2000/XP, Windows Server 2003, and Windows NT 4.0, log on as an administrator (a user with an administrator right).

●     Configure a computer connected to the network where the print server is connected.

Start Windows, and then insert the "Drivers & Manual" CD-ROM into the CD-ROM drive.

●     Quit all other applications currently running.

●     When starting Windows, a wizard for adding new hardware may open. If this happens, click [Cancel]. Check again that the power is 

off, and then proceed to step .

●     When the CD-ROM is inserted, the [Drivers and Manual] dialog box appears. If it does not, double-click the CD-ROM drive icon under 

[My Computer] or [Explorer], and then double-click [SETUP.EXE].

Select a language for the interface, and then click [OK].

The following languages are available:

Deutsch (German), English (English), Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch) 
The default interface language is English.

Click [Printer Driver].

Read the license agreement, and then click [I accept the agreement.].

Click [Next >].

Click [Connected via LAN].

Click [Next >].

Click the plus mark next to a printer name.

Click [Port:] under [Printer Name:].

Click [Add].

The [Add Port] dialog box appears.

Setting Up a Client Computer
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Setting Up a Client Computer

Click [Network Printer].

Click [OK].

Select a shared printer.

Click [OK].

Check that [<\\servername\sharedprintername>] appears after [Port:].

Installation starts.

Click [Finish].

Check the installation result, and then click [Finish].

●     If the message prompting you to restart the computer appears, restart the computer.

●     For details about installing the printer driver, see "Installing the Printer Driver", the Setup Guide.

●     Setting Up a Server

Top Previous Next
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Sharing the Printer

Setting Up a Server

Setting Up a Client Computer
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Inquiries and Consumables > Where to Inquire

Where to Inquire

For inquiries, contact your sales or service representative.

Top Previous Next
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Inquiries and Consumables > Recommended Consumables

Recommended Consumables

Consumables recommended for this printer are listed.

Purchase necessary consumables before your supply runs out.

For information about consumables, contact your sales or service representative.

Print cartridges

●     Large capacity type

●     Regular type

Top Previous Next
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Inquiries and Consumables > Option and Consumables

Option and Consumables

The optional PAPER FEED UNIT TYPE700 is available. If installed, a large number of prints can be made at one 
time using plain paper.

●     For information about options and consumables, contact your service representative.

Top Previous Next
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Inquiries and Consumables

Where to Inquire

Recommended Consumables

Option and Consumables

Top
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Additional Information > Color Guide

Color Guide

The RGB and CMYK color models are explained.

Related topics

Color Printing Mechanism  

Color Production Method of Printers  

Top Previous Next
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Additional Information > Color Guide > Color Printing Mechanism

Color Printing Mechanism

The three primary colors of light (RGB) and the three primary colors of Pigment (CMY)

All light can be produced using a mixture of three colors known collectively as RGB. R stands for red, G for 
green, and B for blue. When mixed in the same proportion, white light is created.

●     The three RGB colors are called the primary colors of light. The RGB colors are also used to produce the colors displayed on the 

screen of a computer.

Printed colors are produced using a mixture of the three CMY colors. C stands for cyan, M for magenta, and Y 
for yellow. When mixed in the same proportion, black is created.

●     The CMY colors are called the primary colors of pigment. Printers use CMY colored ink plus K (black) colored ink to print in full 

color.

The primary colors of light (RGB) can be mixed to produce the secondary colors of cyan, magenta, and yellow. 
Conversely, the primary colors of pigment (CMY) can be mixed to produce red, green, and blue. When two 
primary colors are mixed, the resulting color is the complimentary color of the remaining primary color. Red 
and cyan, green and magenta, and blue and yellow are pairs of complementary colors.

Top Previous Next
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Color Printing Mechanism
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Additional Information > Color Guide > Color Production Method of Printers

Color Production Method of Printers

Printers use cyan (C), magenta (M), and yellow (Y) colored ink plus black (K) colored ink to print in full color.

●     If equal proportions of the three CMY colors are mixed, in theory, pure black should be produced. In practice, the resulting printed color is 

not pure black and has an inferior feel due to the limitations of printing. In order to reproduce a distinct black color, normally black ink is 

used when printing color images.

For example, a cyan image can be printed using only cyan ink without any complications; however, a full color image 
can be made up of over 16 million subtlety different colors. These complicated colors are produced by translating 
them into proportions of CMYK ink dots per unit area.

In addition, the same color in an image can have lighter and darker parts. These shades of color are produced by 
varying the amount of ink dots per unit area.
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Additional Information > Guide to Components

Guide to Components

The names and functions of parts of the printer body, control panel, and options are explained.

Related topics

Printer Body  

Printer Rear  

Control Panel  

Option  

Top Previous Next
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Additional Information > Guide to Components > Printer Body

Printer Body

1.  Top cover

Keep this cover closed during printing. If you cannot locate paper jams, or jammed paper cannot be removed easily, you 
can check the condition of paper from the top of the printer.

2.  Envelope selector

For envelopes, set the lever to the rear position ; for everything else, set the lever to the forward position .

3.  Print cartridge (yellow)

4.  Print cartridge (magenta)

5.  Print cartridge (cyan)

6.  Print cartridge (black)

7.  Right front cover

Open to install or replace Print cartridges.

8.  Tray 1

Load paper here.

9.  Output tray extension

Pull out when using paper larger than A4 to keep the printed paper from falling.

10.  Output tray

Prints are delivered to this tray.

When using paper larger than A4, pull out the output tray extension.

Top Previous Next
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Additional Information > Guide to Components > Printer Rear

Printer Rear

1.  USB slot

Connect the USB cable from the computer here.

2.  Duplex unit cover button

Press to open the duplex unit cover.

3.  Bypass tray

Insert paper by hand here. Insert thick paper and label paper.

4.  Power cord

Plug the power cord into a wall outlet.

Connect the grounding wire attached to the power plug directly to a grounding terminal.

5.  Duplex unit locks

Use to lock or unlock the duplex unit when attaching or detaching it.

6.  Duplex unit cover

Open to remove paper jammed inside the duplex unit.

7.  Vent

Air is vented here to prevent the inside of the printer from getting too warm. Do not lean anything against the vent or block 
it in any way. If the inside of the printer gets too warm, a breakdown could occur.

8.  Guide board

Open to remove paper jammed inside the printer.

9.  Paper feed wheel

Printer Rear
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Printer Rear

Use to wind out paper jammed around the guide board.

10.  Bypass tray guides

Slide the left and right guides in to match the size of paper being used in the bypass tray.

11.  Bypass tray extension

Pull this out when printing using the bypass tray.

12.  Duplex unit

Turns the paper over when performing duplex printing.
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Additional Information > Guide to Components > Control Panel

Control Panel

1.  Low ink indicators

❍     The indicators correspond to the positions of the Print cartridges. From left to right, the low ink indicators display 
the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print cartridges.

❍     When an indicator is blinking, the corresponding Print cartridge is empty. Printing can continue using the ink 
remaining in the printer, but the Print cartridge should be replaced soon.

❍     When an indicator is lit, the ink of the corresponding color has completely run out. Printing cannot be performed. 
The Print cartridge should be replaced immediately.

❍     When all ink indicators are lit, a Print cartridge is not installed or is incorrectly installed. Make sure that the Print 
cartridges are correctly installed.

2.  [Power] key

❍     Press to turn the power on and off.

❍     To turn the power on, press the key for one second until it lights.

❍     After the power is turned on, the [Power] key will blink until the printer is ready for printing at which point the key 
will stop blinking and stay lit.

❍     The [Power] key will also blink when the printer is processing data.

❍     When the power is turned off, the key will blink slowly until the printer has completely shut down at which point 
the key will be dark.

❍     When the power is off, while holding down the [Cancel] key and the [Test Paper Feed/Resume] key, press and hold 
down the [Power] key for over three seconds. The low ink indicators will light once and a print sample will be 
delivered.

❍      means "standby".

3.  [Test Paper Feed/Resume] key

❍     Press to resume printing after dealing with an error.

❍     This key lights or blinks when paper runs out or a paper jam or error occurs.

❍     When using the bypass tray, press this key to start printing after inserting paper.

❍     When the power is off, while holding down the [Test Paper Feed/Resume] key, press and hold down the [Power] 
key for over three seconds. The low ink indicators will light once and a blank sheet will be delivered.

4.  [Cancel] key

❍     Press to cancel printing.

❍     If the [Cancel] key is pressed and held down for over three seconds, the [Power] key will blink and head cleaning 

Control Panel
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Control Panel

will be performed for all four colors.

❍     When the power is off, while holding down the [Cancel] key, press and hold down the [Power] key for over three 
seconds. The low ink indicators will light once and the nozzle check test pattern will be printed.
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Additional Information > Guide to Components > Option

Option

PAPER FEED UNIT TYPE700

1.  Tray 2

Load plain paper here.

2.  Tray 2 rear cover

Open to remove paper jammed in tray 2.

3.  Tray cover

This is attached to tray 2.

Take this cover off when loading paper.

Top Previous Next

Copyright © 2004 All rights reserved.

Option

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/int/0152.htm2005/10/05 11:24:37

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();


Additional Information > Cleaning

Cleaning

Clean the outside of the printer regularly to maintain the condition of the printer.

 
●     To avoid hazardous electric shock, do not remove any covers or screws other than those specified in this manual. When 

the machine needs to be checked, adjusted, or repaired, contact your service representative.

●     Do not take apart or attempt any modifications to this machine. There is a risk of fire, electric shock, explosion or loss 
of sight.

To clean the exterior of the printer, wipe it with a soft, dry or damp cloth. If the dirt does not come off, wipe the 
printer first with a cloth moistened with a neutral detergent, then with a damp cloth, and finally with a dry cloth.

●     Do not use volatile chemicals like benzene or thinner, or insecticides on the printer. Using these chemicals could deform, crack, or change 

the color of the printer.

●     When wiping the printer with a cloth moistened with detergent, be sure to wipe only the exterior.
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Additional Information > Moving

Moving

The precautions when moving the printer a short distance or long distance are explained.

Related topics

Moving a Short Distance  

Moving a Long Distance  
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Additional Information > Moving > Moving a Short Distance

Moving a Short Distance

The precautions when moving the printer a short distance or long distance are explained.

 
●     The printer weighs approximately 11 kg (24.3 lb.).

●     When moving the machine, hold the machine by the bottom below the two indentations. Lift the machine slowly in 
order to avoid straining your body. Lifting the machine without sufficient strength or assistance or handling it roughly 
and dropping it could cause an injury.

 
●     Unplug the power cord from the wall outlet before you move the machine. While moving the machine, you should take 

care that the power cord will not be damaged under the machine.

 
●     When you disconnect the power plug from the wall outlet, always pull the plug (not the cable).

Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet.

●     To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching off 

in any other way may leave the print heads uncapped, possibly leading to printing problems.

Hold the bottom of the printer below the indents on the lower sides of the printer, and then slowly lift 

and move the printer without tilting it.

Moving a Short Distance
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Moving a Short Distance
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Additional Information > Moving > Moving a Long Distance

Moving a Long Distance

Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet.

●     To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching off 

in any other way may leave the print heads uncapped, possibly leading to printing problems.

Pack the printer for transport when moving it a long distance such as when changing office or 

residence. Disconnect all cables, place the printer in the box it was in when purchased, and transport in a 

level manner.

Contact sales or service representative for details.

●     The inside of the printer may become dirty if the printer is not level when transported.
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Additional Information > When Not Using for a Long Period of Time

When Not Using for a Long Period of Time

When the printer will not be used for a long period of time, turn the power off, disconnect the USB cable, and unplug 
the power cable from the wall outlet.

Be careful of the following:

●     The nozzles of the print-heads may dry out and become clogged. To prevent this, periodically print something. 
Even if you do not print anything, turn the printer on for a few minutes once a month.

●     If you do not use the printer for a long period of time, always check if the nozzles are clogged by printing a 
nozzle check test pattern. Clean the print-heads as necessary, and then begin printing.

●     If you do not use the printer for a long period of time, printing may not be performed normally even if head 
cleaning is performed multiple times. If this happens, turn the power off and leave the printer alone for a while. 
Then, turn the power on again and perform the nozzle check and head cleaning.

●     After head cleaning is performed multiple times, clogged ink will dissolve over time, and normal printing may become possible.

●     If there is no improvement after performing the steps above, contact sales or service representative.

●     Where to Inquire

●     Nozzle Check

●     Clean Print-heads (Normal)

●     Clean Print-heads (Full)
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Additional Information > Specifications

Specifications

Specifications of the printer and options are listed.

Related topics

Printer Body  

Option (Paper Feed Unit)  
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Additional Information > Specifications > Printer Body

Printer Body

Print speed

Measurements according to the manufacturer's measurement system

Black draft: 20 ppm

Black standard (speed priority): 19 ppm

Color draft: 20 ppm

Color standard (speed priority): 18 ppm

Depending on the operating environment, printing may take longer than normal.

Print direction

Supports bidirectional, minimum distance printing

Print resolution

Max 3600 × 1200 dpi equivalent

Nozzles

Black: 384 nozzles

Cyan, magenta, and yellow: 384 nozzles per color

Paper sizes (Tray 1 : standard)

A4 (portrait), B5 (portrait), A5 (landscape), A6 (portrait), Legal (portrait), Letter (portrait), 5 1/2"×8 

1/2" (landscape), Exective (portrait) (184.2 mm × 266.7 mm (7.3 × 10.5 inches)), F (portrait) (203.2 mm × 330.2 

mm (8.0 × 13.0 inches)), Foolscap (F4) (portrait) (215.9 mm × 330.2 mm (8.5 × 13.0 inches)), Folio (portrait) 
(209.5 mm × 330.2 mm (8.3 × 13.0 inches)),

Custom paper sizes: 148-356 mm (length) × 90-216 mm (width), (5.9-14.1 inches (length) × 3.6-8.5 inches 
(width))

Paper sizes (Bypass tray)

Standard paper size: A4 (portrait), B5 (portrait), A5 (landscape), A6 (portrait), Legal (portrait), Letter (portrait), 

5 1/2"×8 1/2" (landscape), Exective (portrait) (184.2 mm × 266.7 mm (7.3 × 10.5 inches)), F (portrait) (203.2 

mm × 330.2 mm (8.0 × 13.0 inches)), Foolscap (F4) (portrait) (215.9 mm × 330.2 mm (8.5 × 13.0 inches)), 
Folio (portrait) (209.5 mm × 330.2 mm (8.3 × 13.0 inches)), Com10 (portrait) (104.8 mm × 241.3 mm (4.2 × 
9.5 inches)), Monarch (portrait) (98.4 mm × 190.5 mm (3.9 × 7.5 inches)), C6 (portrait) (114 mm × 162 mm 
(4.5 × 6.4 inches)), C5 (portrait) (162 mm × 229 mm (6.4 × 9.1 inches)), DL Env (portrait) (110 mm × 220 mm 
(4.4 × 8.7 inches))

Custom paper sizes: 148-1295.4 mm (length) × 90-216 mm (width), (5.9-51.0 inches (length) × 3.6-8.5 inches 
(width))

Paper sizes (Duplex unit)

A4 (portrait), B5 (portrait), A5 (horizontal), A6 (portrait), Letter (portrait), 5 1/2"× 8 1/2" (horizontal), Exective 

(portrait)

Paper type

Plain paper

Recycled paper

Color paper

Printer Body
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Printer Body

Inkjet plain paper

Semi-gloss photo paper

Inkjet transparency

Paper weight

Tray 1/optional tray: 60-105 g/m2 (114.7-198.5 lb.)

Bypass tray: 60-163 g/m2 (114.7-297.7 lb.)

Paper capacity

Tray 1: 200 sheets

Bypass tray: 1 sheet

Maximum paper capacity

700 sheets (with the optional tray installed)

Output tray capacity

150 sheets

The capacity may be less depending on the images printed.

Power supply

220-240 V, 0.4 A, 50/60 Hz (when fully equipped)

Power consumption

Average power consumption while printing: 30 W or less (not including options)

less than 39 W (when fully equipped)

Energy Saver mode: less than 6 W

When power is off: 0.3 W or less

To avoid any power consumption, disconnect the power plug from the wall outlet.

(Disconnect the power plug after turning the power off with the [Power] key.)

Operating environment

Temperature: 10 to 32°C (50 to 89.6°F))

Humidity: 15-80% RH (maximum wet-bulb temperature: 25°C (77°F) )

Printing may stop to protect the printer for conditions outside those described above.

Storage environment

Temperature: -20 to 43°C (-4 to 109.4°F)

Humidity: 15-80% RH

External dimensions

(W × D × H) 490 × 469 × 218 mm (19.3 × 18.5 × 8.6 inches)

Weight

Approximately 11 kg (24.3 lb.) (printer body with consumables)

Noise emission

Approximately 49 dB (high quality mode)

Interface

USB 2.0 high speed

Printer language

RPCS Raster

Print cartridges

Types and yields measured using A4 (Letter) 5% chart printed in standard (speed priority) mode.

Two kinds of Print cartridges with different yields can be used.

Print cartridge black: approximately 1450 sheets
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Printer Body

Print cartridge cyan: approximately 1000 sheets

Print cartridge magenta: approximately 1150 sheets

Print cartridge yellow: approximately 1150 sheets

Print cartridge black, large capacity type: approximately 2900 sheets

Print cartridge cyan, large capacity type: approximately 2000 sheets

Print cartridge magenta, large capacity type: approximately 2300 sheets

Print cartridge yellow, large capacity type: approximately 2300 sheets

The printing yields of Print cartridges vary depending on the number of times head cleaning is performed.Also, 
the printing yields of the Print cartridges packaged with the printer are lower than the yields of the Print 
cartridges available for purchase separately.
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Additional Information > Specifications > Option (Paper Feed Unit)

Option (Paper Feed Unit)

PAPER FEED UNIT TYPE700

Paper sizes

A4 (portrait), B5 (portrait), Legal (portrait), Letter (portrait), Exective (portrait) (184.2 mm × 266.7 mm 
(7.3 × 10.5 inches)), F (portrait) (203.2 mm × 330.2 mm (8.0 × 13.0 inches)), Foolscap (F4) (portrait) 
(215.9 mm × 330.2 mm (8.5 × 13.0 inches)), Folio (portrait) (209.5 mm × 330.2 mm (8.3 × 13.0 inches))

Paper type

Plain paper

Recycled paper

Color paper

Paper weight

60-105 g/m2 (114.7-198.5 lb.)

Paper capacity

500 sheets

External dimensions

(W × D × H) 485 × 468 × 115 mm (19.1 × 18.5 × 4.6 inches)

Weight

Approximately 4 kg (8.9 lb.)
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Additional Information > Electromagnetic Interference

Electromagnetic Interference

If another electronic device is placed next to the printer, each will influence the other negatively. In the case of a 
television or radio, noise may be generated. If this happens, do the following:

●     Move the television or radio as far as possible from the printer.

●     Change the position of the antenna of the television or radio.

●     Use a different wall outlet on a different circuit.
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Additional Information > About NetBSD

About NetBSD

For software installed on this printer such as a controller, the NetBSD operating system is used.

1.  Copyright Notice of NetBSD

For all users to use this product:

This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its 
authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright 
notice applicable for each of the files/binaries, the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/ .

Copyright (c) 1999, 2000 The NetBSD Foundation, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:

1.Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS ``AS 
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

2.  Authors Name List

All product names mentioned herein are trademarks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned in this 
document:

This product includes software developed by Jonathan R. Stone for the NetBSD Project.

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

This product includes software developed by Manuel Bouyer.

This product includes software developed by Charles Hannum.

This product includes software developed by Charles M. Hannum.

About NetBSD
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About NetBSD

This product includes software developed by Christopher G. Demetriou.

This product includes software developed by TooLs GmbH.

This product includes software developed by Terrence R. Lambert.

This product includes software developed by Adam Glass and Charles Hannum.

This product includes software developed by Theo de Raadt.

This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD Project.

This product includes software developed by the University of California, Lawrence Berkeley Laboratory and 
its contributors.

This product includes software developed by Christos Zoulas.

This product includes software developed by Christopher G. Demetriou for the NetBSD Project.

This product includes software developed by Paul Kranenburg.

This product includes software developed by Adam Glass.

This product includes software developed by Jonathan Stone.

This product includes software developed by Jonathan Stone for the NetBSD Project.

This product includes software developed by Winning Strategies, Inc.

This product includes software developed by Frank van der Linden for the NetBSD Project.

This product includes software developed for the NetBSD Project by Frank van der Linden

This product includes software developed for the NetBSD Project by Jason R. Thorpe.

The software was developed by the University of California, Berkeley.

This product includes software developed by Chris Provenzano, the University of California, Berkeley, and 
contributors.

Copyright (c) 1993 by Sun Microsystems, Inc. All rights reserved.

Developed at SunPro, a Sun Microsystems, Inc. business.

Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is 
preserved.

Copyright (c) 1995 Carnegie-Mellon University.

All rights reserved.

Author: Chris G. Demetriou

Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided 
that both the copyright notice and this permission notice appear in all copies of the software, derivative works 
or modified versions, and any portions thereof, and that both notices appear in supporting documentation.

CARNEGIE MELLON ALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" ONDITION. 
CARNEGIE MELLON DISCLAIMS ANY LIABILITY OF ANY KIND FOR ANY DAMAGES 
WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE.

Carnegie Mellon requests users of this software to return to

Software Distribution Coordinator or Software.Distribution@CS.CMU.EDU

School of Computer Science

Carnegie Mellon University

Pittsburgh PA 15213-3890

any improvements or extensions that they make and grant Carnegie the rights to redistribute these changes.
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Additional Information > Trademarks

Trademarks

Adobe and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries.

Pentium is a registered trademark of Intel Corporation.

Netscape is a registered trademark of Netscape Communication Corporation in the U.S. and/or other countries.

Macromedia and Flash are either registered trademarks or trademarks of Macromedia, Inc. in the U.S. and/or other 
countries.

Microsoft, Windows, Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the U.
S. and/or other countries.

Other product names used herein are for identification purposes only and might be trademarks of their respective 
companies. We disclaim any and all rights to those marks.

●     The product name of Windows® 95 is Microsoft® Windows® 95.

●     The product name of Windows® 98 is Microsoft® Windows® 98.

●     The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).

●     The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

●     The product names of Windows® XP are as follows:

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Professional

●     The product names of Windows ServerTM 2003 are as follows:

Microsoft® Windows ServerTM 2003 Standard Edition

Microsoft® Windows ServerTM 2003 Enterprise Edition

Microsoft® Windows ServerTM 2003 Web Edition

●     The product names of Windows NT® 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0
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Additional Information

Color Guide

Color Printing Mechanism

Color Production Method of Printers
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Printer Body

Printer Rear

Control Panel

Option

Cleaning

Moving

Moving a Short Distance

Moving a Long Distance

When Not Using for a Long Period of Time

Specifications

Printer Body

Option (Paper Feed Unit)

Electromagnetic Interference
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Using and Removing the User Guide

Using the User Guide

Removing the User Guide

Printing

Printing on Various Paper Types

Printing on Plain Paper

Printing on Thick Paper

Printing on Inkjet Plain Paper

Printing on Inkjet Transparency

Printing on Semi-gloss Photo Paper

Printing on Envelopes

Canceling Printing

Canceling Printing from the Printer Status Monitor

Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing from the Taskbar

Adjusting Print Quality

Printing Using Preset Print Quality Settings

Printing in Black and White

Saving Color Ink When Printing

Printing with Print Quality Settings You Want

Changing Image Printing Method

Correcting the Hue of Digital Photos

Printing Low Resolution Images Smoothly

Changing the Dither Pattern

Changing the Color Profiling Pattern

Printing Grayscale Images Using Black or CMYK

Printing Text in Black

Using ICM

All titles - - User Guide
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All titles - - User Guide

Adjusting Brightness, Contrast, and Saturation

Adjusting Color Balance

Printing a Whole Page as an Image

Changing the Image Data Process

Printing with Particular CMYK Colors

Printing Images Vividly

Various Print Functions

Printing Multiple Document Sets

Collating

Printing Web Pages

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Reducing to A4/Letter Automatically

Rotating the Image by 180 Degrees

Printing on Registered Custom Size Paper

Printing on Unregistered Custom Size Paper

Printing on Both Sides of Paper

Printing Multiple Document Pages per Sheet (Layout)

Splitting the Document Image across Multiple Sheets (Poster)

Printing from the Last Page

Creating a Binding Margin

Printing Documents with a Header and Footer

Printing with a Layout Suitable for Making Booklets

Printing Images or Text Superimposed on Prints

Creating a New Watermark

Printing Documents with an Overlay Image Superimposed (Overlay)

Creating a New Overlay Image File

Deleting an Overlay Image File

Creating a New Overlay Set

Custom Settings

Printing

Registering

Changing the Name
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Deleting

Updating Custom Settings According to the Current Printer Configuration

Changing the Custom Settings Display Order

Saving a Registered Custom Setting in a File

Registering a Custom Setting Using a Custom Setting File

Printer Driver

Opening the Printer Properties Dialog Box

Opening from the Start Menu

For Windows 95/98/Me

For Windows 2000, Windows NT 4.0

For Windows XP, Windows Server 2003

 Opening from an Application

Displaying the Printer Status

Opening the Printer Status Monitor

Printer Properties Settings

Using Help

Displaying an Explanation for Each Setting Item (Context Help)

Displaying Help in a Help Window (Content Help)

 Checking Whether Bidirectional Communication is Working or Not

Maintaining the Printer Using Utilities

Nozzle Check

Clean Print-heads (Normal)

Clean Print-heads (Full)

Adjust Print-head Positions

Registration

Adjust Paper Feed

Restore Defaults/Other Settings

Restoring the Settings to Their Defaults

Specifying an I/O Timeout

Checking the Current Printer Driver Version

Uninstalling the Printer Driver

Paper
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Loading Paper

Loading Paper into Tray 1

Loading Paper into Tray 2 (optional)

Loading Paper Larger than A4 (Letter)

Compatible Paper

Compatible Paper Types

Compatible Paper Sizes

Paper Handling Precautions

Printable Area

Non-compatible Paper

Troubleshooting

Printing Will Not Start

Power Cannot Be Turned On

Paper Will Not Feed Even When the Power Is On

Paper Is Not Fed or Delivered Normally

Paper Jam

Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed under the Top Cover

Removing Paper Jammed around the Guide Board

Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Output Tray

Print Results Are Not Satisfactory

Printing Is Uneven, Too Heavy, or Too Light

Dirty or Blotted Prints

Print Results Do Not Match the Displayed Image

Characters and Colors Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

Printer Status Monitor Does Not Open

Printer Status Monitor Errors

No Response from Printer

No Paper/Tray Not Detected (Bypass Tray)
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No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 2)

Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 2)

Cover Open
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Cartridge End

Ink End
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Printer Error

Adjusting the Printer

Error Indicator Summary
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Setting Up a Server

Setting Up a Client Computer
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Using and Removing the User Guide > Using the User Guide

Using the User Guide

Read this manual carefully before you use this product and keep it handy for future reference. For safe and correct use, 
please be sure to read the Safety Information in the Setup Guide before using the machine.

This section describes the items that appear in the User Guide.

Click to display the standard version of the User Guide.

Click to display the screen-reader version of the User Guide.

Click to display the [Settings] page. On this page, you can select the display color and whether or not to 

hide illustrations for procedures.

Enter a word you want to search for.

If you point to a character string, it turns blue and is underlined. Click the string to jump to the linked 

page.

Click to display the contents.

Click to display the previous topic.

Click to display the next topic.

Click to return to the top of the displayed page.

If a description contains a hyperlink, the hyperlink appears at the bottom of each page.

●     Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

●     Some illustrations in this manual might be slightly different from the machine.

●     Certain options might not be available in some countries. For details, please contact your local dealer.

Using the User Guide
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Using the User Guide

Top Previous Next

Copyright © 2004 All rights reserved.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0001.htm (2 of 2)2005/10/05 11:24:55



Using and Removing the User Guide > Removing the User Guide

Removing the User Guide

Follow the procedure below to remove the User Guide installed on your computer.

Removing the User Guide using its [Uninstall] function

1.  Click [Start], and then point to [Programs].

2.  Point to the installed [Product name], and then click [Uninstall].

3.  Follow the instructions that appear to remove the User Guide.

Removing the User Guide using [Add/Remove Programs]

1.  Open [My Computer], and then open [Control Panel].

2.  Double-click [Add/Remove Programs].

3.  Select the installed [Product name User Guide], and then click [Add/Remove...].

4.  Follow the instructions that appear to remove the User Guide.

●     As well as removing the entire the User Guide, you can also remove selected manuals from the guide.

Top Previous Next
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Printing > Printing on Various Paper Types

Printing on Various Paper Types

The print method differs depending on the type of paper used for printing. Use a print method appropriate for each 
paper type.

Related topics

Printing on Plain Paper 

Printing on Thick Paper 

Printing on Inkjet Plain Paper 

Printing on Inkjet Transparency 

Printing on Semi-gloss Photo Paper 

Printing on Envelopes 

Top Previous Next
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Printing > Printing on Various Paper Types > Printing on Plain Paper

Printing on Plain Paper

Follow the procedure below to print on plain paper. Plain paper are fed from tray 1 or tray 2 (optional).

1.  Load plain paper into tray 1 or tray 2 (optional).

2.  Open the printer properties dialog box from the application.

3.  On the [Setup] tab, click [Plain] in the [Paper type:] list.

4.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

5.  Make print settings, and then click [OK].

●     Opening from an Application

●     Paper Handling Precautions

●     Loading Paper

Top Previous Next
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Printing on Plain Paper
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Printing > Printing on Various Paper Types > Printing on Thick Paper

Printing on Thick Paper

Follow the procedure below to print on thick paper and label paper. Thick paper and label paper are fed from the 
bypass tray.

●     Paper heavier than 105 g/m2 (198.5 lb.) is inserted into the bypass tray one sheet at a time. Paper lighter than that can be loaded into tray 1 or 

tray 2 (optional).

1.  Open the printer properties dialog box from the application.

2.  On the [Setup] tab, click [Thick] in the [Paper type:] list.

3.  Make the necessary settings, and then click [OK].

A confirmation message appears.

4.  Check the message, and then click [OK].

5.  Make print settings, and then click [OK].

❍     The [Test Paper Feed/Resume] key lights.

6.  Slide the envelope selector to the forward position .

7.  Slide the bypass tray guides into position according to the paper size, and then pull the bypass tray 

extension out.

Printing on Thick Paper
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Printing on Thick Paper

8.  Insert a sheet of paper into the bypass tray with the print side face up.

❍     Paper can only be inserted one sheet at a time.

❍     Support the sheet with your hands to keep it from sliding out and dropping.

❍     Insert the sheet straight into the bypass tray.

❍     The thick paper should be between the top and bottom of the bypass tray guides.

9.  Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.
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Printing on Thick Paper

Printing starts.

●     Opening from an Application

●     Paper Handling Precautions
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Printing > Printing on Various Paper Types > Printing on Inkjet Plain Paper

Printing on Inkjet Plain Paper

Follow the procedure below to print on inkjet plain paper.

1.  Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

2.  Hold both sides of tray 1, and pull it toward you.

❍     Tray 1 cannot be detached. Do not pull it forcefully.

3.  Squeeze the paper guide release, and then slide the side paper guides into position according to the paper 

size.

Printing on Inkjet Plain Paper
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Printing on Inkjet Plain Paper

❍     Before loading paper, make sure to squeeze the front end paper guide and slide it to an open position.

4.  Load inkjet plain paper with the print side face down but not over the limit mark.

❍     Curled paper may jam. Straighten any curls before loading.

5.  Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

6.  Hold both sides of tray 1, and push it gently in until it stops.
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Printing on Inkjet Plain Paper

7.  Lower the output tray.

8.  Slide the envelope selector to the forward position . 

9.  Open the printer properties dialog box from the application.

10.  On the [Setup] tab, click [Inkjet Plain Paper] in the [Paper type:] list.

❍     Only one-sided printing is possible when [Inkjet Plain Paper] is selected. For duplex printing, click [Plain].

11.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

12.  Make print settings, and then click [OK].
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Printing on Inkjet Plain Paper

●     Opening from an Application

●     Paper Handling Precautions
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Printing > Printing on Various Paper Types > Printing on Inkjet Transparency

Printing on Inkjet Transparency

Follow the procedure below to print on inkjet transparency.

●     Ink on an inkjet transparency takes some time to dry. We recommend that you remove a printed inkjet transparency from the output tray 

before the next inkjet transparency is delivered.

●     The print delivery time interval can be set longer to avoid printed inkjet transparency from sticking together due to wet ink.

1.  Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

2.  Hold both sides of tray 1, and pull it toward you.

❍     Tray 1 cannot be detached. Do not pull it forcefully.

3.  Squeeze the paper guide release, and then slide the side paper guides into position according to the inkjet 

Printing on Inkjet Transparency
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Printing on Inkjet Transparency

transparency size.

❍     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4.  Load inkjet transparency into tray 1 with the notched corner in the right front corner of the tray. Do not 

load transparencies over the limit mark.

❍     Curled inkjet transparency may jam. Straighten any curls before loading.

❍     If other paper is loaded, remove it, and then load inkjet transparency.

❍     To prevent the leading edge of transparencies from being scratched, place transparencies one at a time.

5.  Squeeze the front end paper guide, and then slide it to meet the edge of the inkjet transparency.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0007.htm (2 of 4)2005/10/05 11:25:02



Printing on Inkjet Transparency

6.  Hold both sides of tray 1, and push it gently in until it stops.

7.  Lower the output tray.

8.  Slide the envelope selector to the forward position .
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Printing on Inkjet Transparency

9.  Open the printer properties dialog box from the application.

10.  On the [Setup] tab, click [Inkjet Transparency] in the [Paper type:] list.

11.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

12.  Make print settings, and then click [OK].

●     Opening from an Application

●     Paper Handling Precautions
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Printing > Printing on Various Paper Types > Printing on Semi-gloss Photo Paper

Printing on Semi-gloss Photo Paper

Follow the procedure below to print on semi-gloss photo paper.

1.  Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

2.  Hold both sides of tray 1, and pull it toward you.

❍     Tray 1 cannot be detached. Do not pull it forcefully.

3.  Squeeze the paper guide release, and then slide the side paper guides into position according to the paper 

size.

Printing on Semi-gloss Photo Paper

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0008.htm (1 of 4)2005/10/05 11:25:03

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();


Printing on Semi-gloss Photo Paper

❍     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4.  Load semi-gloss photo paper with the print side face down but not over the limit mark.

❍     The print side is rough and white-coated.

❍     Curled paper may jam. Straighten any curls before loading.

5.  Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

6.  Hold both sides of tray 1, and push it gently in until it stops.
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Printing on Semi-gloss Photo Paper

7.  Lower the output tray.

8.  Slide the envelope selector to the forward position .

9.  Open the printer properties dialog box from the application.

10.  On the [Setup] tab, click [Semi-gloss Photo Paper] in the [Paper type:] list.

11.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

12.  Make print settings, and then click [OK].

❍     The output tray can hold up to 20 sheets of semi-gloss photo paper at a time.
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Printing on Semi-gloss Photo Paper

●     Opening from an Application

●     Paper Handling Precautions

Top Previous Next
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Printing > Printing on Various Paper Types > Printing on Envelopes

Printing on Envelopes

Follow the procedure below to print on envelopes. The envelopes are fed from the bypass tray.

●     Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or similar object.

●     Load them properly because the printable area depends on the orientation.

1.  Open the printer properties dialog box from the application.

2.  On the [Setup] tab, click [Envelope] in the [Paper type:] list. 

3.  Make the necessary settings, and then click [OK].

A confirmation message appears.

4.  Check the message, and then click [OK].

5.  Make print settings, and then click [OK].

❍     The [Test Paper Feed/Resume] key lights.

6.  Slide the envelope selector to the rear position .

7.  Open up the bypass tray guides as far as they will go, and then pull the bypass tray extension out.

Printing on Envelopes
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Printing on Envelopes

8.  Insert an envelope as illustrated with the front-side up and the folded flap on the left side when the 

machine is viewed from the back, and then slide the bypass tray guides up against the edges of the 

envelope.

❍     If the envelope has a short-edge flap, the envelope should be inserted bottom first with the flap unfolded as illustrated.

❍     Envelopes can only be inserted one at a time.

❍     Support the envelope with your hands to keep it from sliding out and dropping.

❍     Insert the envelope straight into the bypass tray.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0009.htm (2 of 3)2005/10/05 11:25:04



Printing on Envelopes

❍     The envelope should be between the top and bottom of the bypass tray guides.

9.  Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

Printing starts.

●     Opening from an Application

●     Paper Handling Precautions

●     Printable Area

Top Previous Next
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Printing > Canceling Printing

Canceling Printing

Print jobs can be canceled from either a printer or computer. How to cancel print jobs differs according to their job 
status. Check the job status first.

Canceling a print job being printed

Cancel the print job from the Printer Status monitor or by pressing the [Cancel] key of the printer.

Canceling a print job in queue

Cancel the print job from the taskbar of the computer.

Related topics

Canceling Printing from the Printer Status Monitor 

Canceling Printing Using the [Cancel] Key of the Printer 

Canceling Printing from the Taskbar 

Top Previous Next
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Canceling Printing
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Printing > Canceling Printing > Canceling Printing from the Printer Status Monitor

Canceling Printing from the Printer Status Monitor

Follow the procedure below to cancel a print job being printed.

1.  Check that printing and the Printer Status monitor have started.

2.  Click [Stop Printing].

❍     It will take a few moments for printing to stop.

●     Displaying the Printer Status

Top Previous Next
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Canceling Printing from the Printer Status Monitor
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Printing > Canceling Printing > Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing Using the [Cancel] Key of the Printer

Follow the procedure below to cancel a print job being printed.

1.  Check that printing has started.

❍     Not only the print job being printed but also the print jobs in queue will be canceled.

❍     If you press the [Cancel] key while the printer is receiving print data for a print job (the [Power] key is blinking), that print job is 

also canceled.

2.  Press the [Cancel] key.

❍     It will take a few moments for printing to stop.

Top Previous Next
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Canceling Printing Using the [Cancel] Key of the Printer
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Printing > Canceling Printing > Canceling Printing from the Taskbar

Canceling Printing from the Taskbar

Follow the procedure below to cancel a print job in queue.

1.  Double-click the icon of the printer on the taskbar.

2.  Select the print job you want to cancel, and then click [Cancel Printing] (Windows 2000/XP, Windows 

Server 2003: [Cancel]) on the [Document] menu.

Top Previous Next

Copyright © 2004 All rights reserved.

Canceling Printing from the Taskbar
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Printing > Adjusting Print Quality

Adjusting Print Quality

Print quality and color tone can be adjusted to suit the print data.

Related topics

Printing Using Preset Print Quality Settings 

Printing in Black and White 

Saving Color Ink When Printing 

Printing with Print Quality Settings You Want 

Printing Images Vividly 

Top Previous Next
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Adjusting Print Quality
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Printing > Adjusting Print Quality > Printing Using Preset Print Quality Settings

Printing Using Preset Print Quality Settings

With preset print quality settings, you do not have to make print quality settings every time you print. Follow the 
procedure below to print using a preset print quality setting.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, select a print quality setting in the [Print Quality] area.

3.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

4.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing Using Preset Print Quality Settings

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0015.htm2005/10/05 11:25:11

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();


Printing > Adjusting Print Quality > Printing in Black and White

Printing in Black and White

Follow the procedure below to print using only black ink.

Since black and white printing is faster than color printing, it is efficient for printing color documents that do not need 
to be printed in color. Also, the black produced by black and white printing is a more distinct black than that produced 
by color printing.

●     Be sure to select black and white printing if you specified black and white printing in an application.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [Black and White] in the [Color/Black and White] area.

3.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

4.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing in Black and White
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Printing > Adjusting Print Quality > Saving Color Ink When Printing

Saving Color Ink When Printing

Follow the procedure below to save color ink by printing graphics and images with less than the usual amount of ink. 
Text is printed as usual so that it can remain clear and easy to read.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [Color] in the [Color/Black and White] area.

3.  Select the [Level color] check box.

4.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

5.  Make print settings, and then click [OK].

●     Overall color, except for text, will be lighter.

●     The color of text may be printed lighter depending on the application used.

●     Opening from an Application

Top Previous Next
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Saving Color Ink When Printing
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want

Printing with Print Quality Settings You Want

You can make print quality settings more in details.

Related topics

Changing Image Printing Method 

Correcting the Hue of Digital Photos 

Printing Low Resolution Images Smoothly 

Changing the Dither Pattern 

Changing the Color Profiling Pattern 

Printing Grayscale Images Using Black or CMYK 

Printing Text in Black 

Using ICM 

Adjusting Brightness, Contrast, and Saturation 

Adjusting Color Balance 

Printing a Whole Page as an Image 

Changing the Image Data Process 

Printing with Particular CMYK Colors 

Top Previous Next
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing Image Printing Method

Changing Image Printing Method

When printing images, the higher the resolution of images, the longer the time required for printing. Follow the 
procedure below to print with priority on print quality or print speed.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select an image printing method in the [Image processing priority] list.

5.  Click [OK].

The [Change User Settings] dialog box closes.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Changing Image Printing Method
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Correcting the Hue of Digital Photos

Correcting the Hue of Digital Photos

Correct the hue of digital photos. This is effective especially for overexposed or underexposed images.

●     Exposure is affected by the levels of light in which the photo was taken. If there are extreme light and shade differences between object and 

background, the object may be underexposed (too dark) or overexposed (too light).

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select the [Adjust photos and images] check box.

❍     If the [Adjust photos and images] check box is selected, the [Use ICM] check box is unavailable.

5.  Click [OK].

The [Change User Settings] dialog box closes.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Correcting the Hue of Digital Photos
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing Low Resolution Images Smoothly

Printing Low Resolution Images Smoothly

Follow the procedure below to print outlines of low resolution images, which often appear on Web pages, smoothly.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select the [Smooth low resolution images] check box.

5.  Click [OK].

The [Change User Settings] dialog box closes.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing Low Resolution Images Smoothly
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Dither Pattern

Changing the Dither Pattern

A dither pattern is a pattern of dots used to simulate a color or shade of an image. If the pattern is changed, the 
characteristics of the image will also change. Follow the procedure below to select a pattern suitable for the image to 
be printed.

●     Dithering is a technique where tiny dots are printed in patterns in order to create the illusion of tones and colors that cannot be physically 

reproduced.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select a dither pattern in the [Dithering] list.

❍     Thin lines may break depending on the pattern used. If this happens, select another pattern.

5.  Click [OK].

The [Change User Settings] dialog box closes.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Changing the Dither Pattern
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Color Profiling Pattern

Changing the Color Profiling Pattern

Follow the procedure below to select a color profiling pattern to adjust the tone of colors for prints according to the 
colors displayed on the computer screen.

Colors on the computer screen are expressed using the three RGB colors, but colors used for printing are composed of 
the four CMYK colors. When printing, RGB colors are converted to CMYK colors.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select a color profiling pattern in the [Color profile:] list.

5.  Click [OK].

The [Change User Settings] dialog box closes.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

●     Color Guide

Top Previous Next
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing Grayscale Images Using Black or CMYK

Printing Grayscale Images Using Black or CMYK

Follow the procedure below to print black or gray parts of an image using black or CMYK.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select a gray reproduction method in the [Gray reproduction (Text/

Line Art):] list.

5.  Click [OK].

The [Change User Settings] dialog box closes.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing Text in Black

Printing Text in Black

Follow the procedure below to print text other than black in black. This is useful when text other than black looks 
lighter when printed.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select the [Print all texts in black] check box.

5.  Click [OK].

The [Change User Settings] dialog box closes.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application
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Printing Text in Black
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Using ICM

Using ICM

Follow the procedure below to correct colors using the Windows ICM (Image Color Matching) function.

●     ICM is a color management system that adjusts colors between I/O devices. Use this function to produce print results with colors as close as 

possible to those displayed on the computer screen. To use this function, the color profile must be added to the printer.

●     You can find the color profile in the ICM folder stored on the CD-ROM provided. For information about adding a color profile, search for 

the words "color profile" in Windows Help, and then see the appropriate topic.

●     This function is unavailable under Windows 95 or Windows NT 4.0.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  On the [Image Adjustments] tab, select the [Use ICM] check box.

❍     If the [Use ICM] check box is selected, the [Color profile:] list on the [Image Adjustments] tab is unavailable. Windows performs 

color correction using the profile specified on the [Color Management] tab.

❍     If the [Use ICM] check box is selected, the [Adjust photos and images] check box is unavailable.

5.  In the [ICM method:] and [ICM intent:] lists, select a color correction process.

6.  Click [OK].

The [Change User Settings] dialog box closes.

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Using ICM
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Adjusting Brightness, Contrast, and Saturation

Adjusting Brightness, Contrast, and Saturation

Follow the procedure below to adjust brightness, contrast, and saturation for printing.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  Click the [Balance Adjustments] tab.

5.  Adjust the brightness, contrast, and saturation.

❍     Make adjustments by moving the slider or clicking [-] or [+].

6.  Click [OK].

The [Change User Settings] dialog box closes.

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

●     Opening from an Application
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Adjusting Color Balance

Adjusting Color Balance

Follow the procedure below to adjust color balance by changing the mixture of red (R), green (G), and blue (B).

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  Click the [Balance Adjustments] tab.

5.  Adjust color balances.

❍     Make adjustments by moving the slider or clicking [-] or [+]. Click [ ] and [ ] to move all sliders at the same time.

❍     Cyan (C) and red (R), magenta (M) and green (G), and yellow (Y) and blue (B) are pairs of complementary colors.

6.  Click [OK].

The [Change User Settings] dialog box closes.

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

Complementary Colors

It is helpful to understand the concept of complementary colors when adjusting color balance. When two 
primary colors of the primary colors of light (RGB) or primary colors of pigment (CMY) are mixed, the 
resulting color is the complimentary color of the remaining primary color. Red and cyan, green and 
magenta, and blue and yellow are pairs of complementary colors.

Hints for Adjusting Color Balance

The following methods are available to make a specific color stronger: decreasing the color's 
complementary color or decreasing the other colors (that is, decreasing complementary colors relatively). 
A combination of both methods can be used.

For example, to make red more vivid, make red stronger (by decreasing cyan) or decrease green and blue 
(making magenta and yellow stronger). The more red is used, the brighter the image looks. This is useful to 
adjust the color of a dark image. On the contrary, the less green and blue are used, the duller the image 
looks. Use this method to make a bright image dull.

●     Opening from an Application

Adjusting Color Balance
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Adjusting Color Balance
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing a Whole Page as an Image

Printing a Whole Page as an Image

This section explains how to convert a print job to image data using a Windows application, and then print the image 
using the printer driver. Follow the procedure below to print a whole page as an image. This will allow you to get print 
results that resemble the display image more closely. Since more data has to be processed, printing will take much 
longer. Use this function if the printed image differs from the display image.

●     Black or gray parts will be printed with the four CMYK colors regardless of the settings made in the [Gray reproduction (Text/Line Art):] list 

on the [Image Adjustments] tab in the [Change User Settings] dialog box.

●     This setting overrides the watermark setting.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  Click the [Misc.] tab.

5.  Select the [Print as bitmap] check box.

6.  Click [OK].

The [Change User Settings] dialog box closes.

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

●     Opening from an Application

●     Printing Images or Text Superimposed on Prints

Top Previous Next
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Printing a Whole Page as an Image
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Image Data Process

Changing the Image Data Process

Depending on the application, there may be cases where printing takes a long time or colors are not printed correctly. 
Follow the procedure below to change the image data process to solve the problem.

●     Since changing the image data processing method may cause printing not to be performed correctly with some applications, you should 

normally leave this option unselected.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  Click the [Misc.] tab.

5.  Select the [Change data processing] check box.

6.  Click [OK].

The [Change User Settings] dialog box closes.

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Changing the Image Data Process
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing with Particular CMYK Colors

Printing with Particular CMYK Colors

Normally full color (CMYK) is used for color printing. Follow the procedure below to print using particular CMYK 
colors.

●     These settings are unavailable when black and white printing is specified.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, click [User settings] in the [Print Quality] area.

3.  Click [Change...].

The [Change User Settings] dialog box appears.

4.  Click the [Misc.] tab.

5.  In the [Separate into CMYK, then print in designated color only] area, select colors.

❍     Select colors you want to use.

6.  Click [OK].

The [Change User Settings] dialog box closes.

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing with Particular CMYK Colors
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Printing > Adjusting Print Quality > Printing Images Vividly

Printing Images Vividly

By changing the printer properties settings or using special paper, vivid images can be printed.

Changing the printer properties settings

Prints can be made with priority on print quality. Change print quality settings in the printer properties dialog 
box.

Using special paper

Printing on special paper will look more vivid compared to printing on plain paper. Use inkjet plain paper or 
semi-gloss photo paper.

●     Printing Using Preset Print Quality Settings

●     Recommended Consumables

Top Previous Next
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Printing Images Vividly
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Printing > Various Print Functions

Various Print Functions

By using various print functions, you can make prints appropriate for your purposes.

●     Printing on Various Paper Types

Related topics

Printing Multiple Document Sets 

Collating 

Printing Web Pages 

Reducing and Enlarging to Fit the Paper Size (Fit to paper size) 

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification) 

Reducing to A4/Letter Automatically 

Rotating the Image by 180 Degrees 

Printing on Registered Custom Size Paper 

Printing on Unregistered Custom Size Paper 

Printing on Both Sides of Paper 

Printing Multiple Document Pages per Sheet (Layout) 

Splitting the Document Image across Multiple Sheets (Poster) 

Printing from the Last Page 

Creating a Binding Margin 

Printing Documents with a Header and Footer 

Printing with a Layout Suitable for Making Booklets 

Printing Images or Text Superimposed on Prints 

Printing Documents with an Overlay Image Superimposed (Overlay) 

Top Previous Next
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Printing > Various Print Functions > Printing Multiple Document Sets

Printing Multiple Document Sets

Follow the procedure below to print multiple sets of the same document.

●     If you do not use the Collate function, prints will be delivered in page batches (P1, P1, P2, P2 ...). If you use the Collate function, prints will 

be delivered in document batches (P1, P2, P1, P2 ...).

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Page Settings] tab.

3.  In the [Copies] box, enter the number of sets you want to print between 1 and 999.

4.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

5.  Make print settings, and then click [OK].

●     Collating

●     Opening from an Application

Top Previous Next
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Printing Multiple Document Sets
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Printing > Various Print Functions > Collating

Collating

Follow the procedure below to print complete sets of prints one set at a time when printing multiple sets such as for 
presentation materials.

●     Even when using the Collate function with Layout, Poster, or Duplex, document boundaries are correctly recognized so problems like the 

first page and last page being printed on the same sheet do not occur.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Page Settings] tab.

3.  In the [Copies] box, enter the number of sets you want to print between 1 and 999.

4.  Select the [Collate] check box.

5.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

6.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing Web Pages

Printing Web Pages

Use the procedures described below to make settings for printing Web pages.

When a Web page is printed, it may not fit on the paper used or it may not be printed as it looks on the screen. Use the 
information below to print Web pages correctly.

Printing low resolution images smoothly

Images displayed on Web sites tend to be low resolution images to reduce data size. Before printing, be sure to 
make the setting to print low resolution images smoothly.

Printing a whole Web page fit to the paper size

When a whole Web page cannot be printed on the paper size used, reduce it using [Fit to paper size] or [Scale] 
under the Reduce/Enlarge function. If [A3 (297 x 420 mm)] or [B4 JIS (257 x 364 mm)] is selected for 
[Original size:] and the [Reduce automatically to fit A4]/[Reduce automatically to fit Letter] check box is 
selected, the print image will be reduced automatically to fit A4/Letter size paper.

●     When a Web page is printed over multiple sheets, images or text where any two sheets are connected may not be printed.

Printing the background color of a Web page

The background color of a Web page may not be printed. Make the settings to print the background color using 
a Web browser.

Internet Explorer

1.  On the [View] or [Tools] menu of the browser, click [Internet Options...].

2.  Click the [Advanced] tab.

3.  In the [Settings] list, select the [Print background colors and images] check box under [Printing].

4.  Click [OK].

Netscape Navigator

1.  On the [File] menu of the browser, click [Page Setup].

2.  On the [Format & Options] tab, select the [Print Background (colors & images)] check box in the 

[Options] area.

3.  Click [OK].

●     Printing Low Resolution Images Smoothly

●     Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

●     Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

●     Reducing to A4/Letter Automatically

Printing Web Pages
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Printing Web Pages
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Printing > Various Print Functions > Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Follow the procedure below to print document pages reduced or enlarged to fit the paper size. By specifying a 
document and paper size, an appropriate reduction or enlargement ratio is selected automatically. This is useful when 
reducing or enlarging from or to standard paper sizes such as when reducing an A3 document to A5 paper.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Page Settings] tab.

3.  Check that the document orientation and size are the same as those selected in the application.

❍     Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected, 

make the correct settings.

4.  Select the [Reduce/Enlarge] check box, and then click [Fit to paper size] in the list.

5.  In the [Printout paper size:] list, select a paper size.

Select the size of paper loaded in the paper tray.

❍     An automatically selected ratio appears in the [Scaling(%):] box.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Reducing and Enlarging to Fit the Paper Size (Fit to paper size)
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Printing > Various Print Functions > Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Follow the procedure below to print with a reduction or enlargement ratio in the range of 20-300% adjustable in 1% 
increments. Use this to reduce the size of the print image slightly to insert a margin, for example.

Two methods are available: scale and directional magnification. Scale is used to specify the same ratio in both 
horizontal and vertical directions while directional magnification is used to specify a different ratio for each direction.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Page Settings] tab.

3.  Select the [Reduce/Enlarge] check box, and then click [Scale] or [Directional magnification...] in the list.

4.  If [Scale] is selected, enter a ratio in the [Scaling(%):] box.

❍     Enter a number between 20 and 300.

❍     In the [Printout paper size:] list, you can change the paper size.

5.  If [Directional magnification...] is selected, enter ratios in the [Vertical:] and [Horizontal:] boxes, and 

then click [OK].

6.  Select the [Centering] check box to center an image.

❍     If [Scale] or [Directional magnification...] is selected, a wide margin may be created on the right or bottom of the paper. If this 

happens, select the [Centering] check box to center an image and create margins of the same width.

❍     If the [Centering] check box is not selected, the reduced or enlarged image is positioned in the upper left of the paper.

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

●     Opening from an Application
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Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)
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Printing > Various Print Functions > Reducing to A4/Letter Automatically

Reducing to A4/Letter Automatically

Follow the procedure below to print a document larger than A4/Letter onto A4/Letter size paper by reducing it. For 
example, if a document is A3/Legal size, the document is reduced to A4/Letter automatically and printed.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Page Settings] tab.

3.  Check that the document orientation and size are the same as those selected in the application.

❍     Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected, 

make the correct settings.

In the [Printout paper size:] list, [Reduce to fit A4]/[Reduce to fit Letter] appears.

❍     If [Reduce to fit A4]/[Reduce to fit Letter] does not appear, select the [Reduce automatically to fit A4]/[Reduce automatically to fit 

Letter] check box in the [Printer Configuration] dialog box.

4.  Click [OK].

5.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

6.  Make print settings, and then click [OK].

●     When you do not want to reduce images from documents larger than A4/Letter, clear the [Reduce automatically to fit A4]/[Reduce 

automatically to fit Letter] check box in the [Printer Configuration] dialog box. For example, this is done when you want to print document 

images at full size even if they run off the paper.

●     Opening from an Application
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Printing > Various Print Functions > Rotating the Image by 180 Degrees

Rotating the Image by 180 Degrees

Follow the procedure below to print images rotated by 180 degrees. Use this function if paper loaded in the paper tray 
has a distinct top and bottom and printing with the paper in that orientation would otherwise make the image upside-
down.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Page Settings] tab.

3.  Select the [Rotate by 180 degrees] check box.

4.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

5.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Rotating the Image by 180 Degrees
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Printing > Various Print Functions > Printing on Registered Custom Size Paper

Printing on Registered Custom Size Paper

Follow the procedure below to print on registered custom size paper.

Register the size of the custom size paper loaded in the paper tray in the [Printer Configuration] dialog box.

1.  Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to 
open it may differ in some applications. Open the dialog box according to the application being used.

2.  Open the printer properties dialog box from the [Page Setup] dialog box.

3.  Click the [Page Settings] tab.

4.  In the [Original size:] list, select a custom paper size.

Select from the sizes already registered.

5.  Click [Portrait] or [Landscape].

Select the orientation that matches the document orientation and feeding direction.

6.  Click the [Setup] tab.

7.  Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.

8.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

9.  Check that the orientation selected in the [Setup] dialog box of the application is the same as that 

selected in step 5..

If it is not, make the correct setting.

10.  Close the [Page Setup] dialog box of the application.

11.  Create a file in the application.

12.  In the printer properties dialog box, make the print settings for the printer selected in step 2., and then 

click [OK].

●     Opening from an Application
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Printing > Various Print Functions > Printing on Unregistered Custom Size Paper

Printing on Unregistered Custom Size Paper

Follow the procedure below to print on unregistered custom size paper.

1.  Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to 
open it may differ in some applications. Open the dialog box according to the application being used.

2.  Open the printer properties dialog box from the [Page Setup] dialog box.

3.  Click the [Page Settings] tab.

4.  In the [Original size:] list, click [Custom paper size...].

The [Custom Paper Size] dialog box appears.

5.  In the [Long edge:] and [Short edge:] boxes, enter values.

❍     To change the measurement unit, click [Measurement Unit...].

6.  In the [Paper source tray:] list, select a paper tray.

7.  In the [Paper Position in Tray] area, select a paper orientation.

8.  Click [OK].

❍     To register the paper size as a custom paper size, click [Open [Custom Paper Sizes]...].

9.  Click the [Setup] tab.

10.  Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.

11.  Click the [Page Settings] tab.

12.  Click [Portrait] or [Landscape].

Select the orientation that matches the document orientation and feeding direction.

13.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

14.  Check that the orientation selected in the [Page Setup] dialog box of the application is the same as that 

selected in step 5..

If it is not, make the correct setting.

15.  Close the [Page Setup] dialog box of the application.

16.  Create a file in the application.

17.  In the printer properties dialog box, make the print settings for the printer selected in step 2., and then 

click [OK].

●     Opening from an Application
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Printing > Various Print Functions > Printing on Both Sides of Paper

Printing on Both Sides of Paper

Follow the procedure below to print on both sides of paper.

●     If the page size varies within a document, a page break will occur before the page where the size changes.

●     When printing solid color using a lot of ink, we recommend that you use one-sided printing.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Duplex/Booklet] check box.

❍     If you select the [Create margin] check box when printing on plain paper, the machine automatically reduces the size of the page 

images and centers them on the paper.

4.  Click the icon representing the binding method you want to use.

❍     The icons are displayed in either landscape or portrait depending on the document orientation.

5.  Select the [Header/Footer/Adjust image position/Binding margins] check box to create a binding margin.

Click [Details...] to specify a margin in the [Binding Margins for Duplex Printing] area.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

●     Printing with a Layout Suitable for Making Booklets

●     Creating a Binding Margin
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Printing > Various Print Functions > Printing Multiple Document Pages per Sheet (Layout)

Printing Multiple Document Pages per Sheet (Layout)

Follow the procedure below to print multiple document pages per sheet.

●     When using Layout, a suitable reduction or enlargement ratio is selected automatically based on the paper size and the number of pages you 

want to fit on each sheet.

●     If the page orientation varies within a document, a page break will occur before a page where the orientation changes.

●     If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Layout/Poster] check box, and then select the number of document pages you want to fit on 

each sheet in the list.

❍     Do not click [Poster] since it is a different function.

4.  Click the icon that matches the page flow you want to use.

❍     The icons show the available page flows for the number of pages selected.

❍     The icons are displayed in either landscape or portrait depending on the document orientation.

5.  Select the [Draw border] check box to print borders.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application
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Printing > Various Print Functions > Splitting the Document Image across Multiple Sheets (Poster)

Splitting the Document Image across Multiple Sheets (Poster)

Follow the procedure below to print a single document page over multiple sheets to make a poster size print.

●     The enlargement ratio used is based on the specified paper size and the number of sheets you want to split the image over.

●     Prints are made with a 15 mm (0.6 inches) overlap margin. When pasting sheets together, overlap them to hide this margin.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Layout/Poster] check box, and then click [Poster] in the list.

4.  Click the icon representing the number of sheets you want to split the image over.

❍     The icons are displayed in either landscape or portrait depending on the document orientation.

5.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

6.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing from the Last Page

Printing from the Last Page

Follow the procedure below to start printing from the last page of a document. Use this function when prints come out 
face up in the output tray. This allows a printed document to be assembled in page order.

●     If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Page Settings] tab.

3.  Select the [Reverse order printing] check box.

4.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

5.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Creating a Binding Margin

Creating a Binding Margin

Follow the procedure below to print with a binding margin. If you create a binding margin, it is offset from the 
document margin set from the application.

●     Since the margin opposite the binding margin will be shifted toward the paper edge, be sure to make this margin wide enough when making 

the document.

●     If a binding margin is set in an application, do not make this setting in the printer properties. This would result in a binding margin twice as 

wide as expected.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Header/Footer/Adjust image position/Binding margins] check box.

4.  Click [Details...].

The [Header/Footer/Adjust Image Position/Binding Margins] dialog box appears.

5.  In the [Adjust Image Position] area, select the direction in which you want to shift the print area in the 

[Direction:] list.

❍     Margins (top, bottom, left, right) change according to the selected direction.

6.  Enter a binding margin width, and then click [OK].

❍     To change the measurement unit, click [Measurement Unit...].

7.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

8.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing Documents with a Header and Footer

Printing Documents with a Header and Footer

Follow the procedure below to print documents with character strings in the top and bottom margins.

●     Besides date, page number, and file name, text of up to 32 characters can be inserted into these areas.

●     If you print a document using the Reduce/Enlarge function, the header and footer will also be reduced or enlarged.

●     A header and footer will be printed on every page. For example, if you print several document pages on a sheet of paper (Layout), a header 

and footer will appear for every page.

●     If a header and footer are set in an application, do not make this setting in the printer properties.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Header/Footer/Adjust image position/Binding margins] check box.

4.  Click [Details...].

The [Header/Footer/Adjust Image Position/Binding Margins] dialog box appears.

5.  In the [Header/Footer] area, make the necessary settings, and then click [OK].

❍     If the same position is selected for the date and time, page number, or text, the printing order is as follows: date and time, text, page 

number.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing with a Layout Suitable for Making Booklets

Printing with a Layout Suitable for Making Booklets

Follow the procedure below to print on both sides of paper using a layout suitable for making booklets.

●     There are two kinds of booklet layout: [Booklet 1] and [Booklet 2]. With [Booklet 1], each sheet is folded in half separately, then the folded 

sheets are stacked and bound. With [Booklet 2], the whole stack is folded in half in a similar way to a magazine.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Duplex/Booklet] check box.

4.  Click the icon representing the booklet format you want to use.

❍     The icons are displayed in either landscape or portrait depending on the document orientation.

5.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

6.  Make print settings, and then click [OK].

●     Opening from an Application

●     Printing on Both Sides of Paper

Top Previous Next
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Printing > Various Print Functions > Printing Images or Text Superimposed on Prints

Printing Images or Text Superimposed on Prints

Follow the procedure below to print an image or text superimposed on prints. The image or text is referred to as a 
watermark.

●     A watermark made up of a bitmap file (extension .bmp) is referred to as an image watermark. A watermark made up of text data is referred to 

as a text watermark. You cannot use both together.

●     Various predefined watermarks are provided. You can also create your own watermarks.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Watermarks/Overlay] check box, and then select a watermark in the list.

❍     To edit the watermark, click [Edit...].

❍     To create a new watermark, click [Add Bitmap...] or [Add Text...].

4.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

5.  Make print settings, and then click [OK].

●     Opening from an Application

Related topics

Creating a New Watermark 

Top Previous Next
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Printing > Various Print Functions > Printing Images or Text Superimposed on Prints > Creating a New Watermark

Creating a New Watermark

Follow the procedure below to create a new watermark.

●     There are two kinds of watermarks: image watermarks made up of a bitmap file (extension .bmp) and text watermarks made up of text data.

1.  Open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Watermarks/Overlay] check box.

4.  Click [Add Bitmap...] to create an image watermark, or click [Add Text...] to create a text watermark.

5.  Make the necessary settings in the [Add Bitmap Watermark] or [Add Text Watermark] dialog box, and 

then click [OK].

The watermark is registered and added to the list.

●     Opening from the Start Menu

●     Opening from an Application

●     Printing Images or Text Superimposed on Prints

Top Previous Next
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay)

Printing Documents with an Overlay Image Superimposed (Overlay)

Follow the procedure below to print a document with an overlay image superimposed.

●     Before printing using the Overlay function, an overlay image file and overlay set must be created.

●     A superimposing image will be aligned with the document page at the upper left corner. If the document to be printed and superimposing 

image differ in size and orientation, the superimposing image may be cut or run off.

●     Depending on the application, you may not get the expected result.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Watermarks/Overlay] check box, and then select an overlay set in the list.

❍     To edit the overlay set, click [Edit...].

❍     To create a new overlay set, click [Add Overlay....].

4.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

5.  Make print settings, and then click [OK].

Overlay image file:

Data saved in a format allowing it to be used as a superimposing image.

Overlay set:

An overlay image file and setting details (such as how and which page an overlay image is superimposed on) are 
combined, named, and registered as a set. Each set registered is called an overlay set.

When printing, select an overlay set.

●     Opening from an Application

Related topics

Creating a New Overlay Image File 

Deleting an Overlay Image File 

Creating a New Overlay Set 

Printing Documents with an Overlay Image Superimposed (Overlay)

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0052.htm (1 of 2)2005/10/05 11:25:51

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();


Printing Documents with an Overlay Image Superimposed (Overlay)

Top Previous Next

Copyright © 2004 All rights reserved.

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0052.htm (2 of 2)2005/10/05 11:25:51



Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Creating a New Overlay Image File

Creating a New Overlay Image File

Follow the procedure below to create an overlay image file.

●     You can create an overlay image file with any application.

●     When an overlay image file is created using a multiple-page document, only the first page will be saved as an overlay image.

1.  Open the file with which you want to create an overlay image file, and then open the printer properties 

dialog box.

2.  On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.

The [Job Type Details] dialog box appears.

3.  In the [File name:] box, enter a file name.

❍     Enter a name using up to 32 characters.

❍     Under Windows 95/98/Me, enter a name using up to eight characters.

4.  Click [OK].

5.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

❍     When creating an overlay image file (when [Save as Overlay Data...] is selected in the [Job type:] list), only print quality settings are 

available.

6.  Click [OK] in the [Print] dialog box.

The overlay image file is created.

●     Opening from an Application

Top Previous Next

Copyright © 2004 All rights reserved.
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Deleting an Overlay Image File

Deleting an Overlay Image File

Follow the procedure below to delete an overlay image file.

1.  Open the printer properties dialog box.

2.  On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.

3.  Select the overlay image file you want to delete.

4.  Click [Delete...].

A confirmation message appears.

5.  Click [OK].

The overlay image file is deleted.

●     You can also delete overlay image files (extension .rpo) using Windows Explorer.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Creating a New Overlay Set

Creating a New Overlay Set

Follow the procedure below to combine an overlay image file and setting details (such as how and which page an 
overlay image is superimposed on), name it, and register it as a set. Each set registered is called an overlay set.

●     For printing the same overlay image with different setting details, set different combinations of setting details for the same overlay image 

file, and then register each set as a different overlay set.

1.  Open the printer properties dialog box.

2.  Click the [Edit] tab.

3.  Select the [Watermarks/Overlay] check box.

4.  Click [Add Overlay....].

5.  In the [Add Overlay] dialog box, make the necessary settings, and then click [OK].

The overlay set is registered and added to the list.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings

Custom Settings

In [Custom Settings:], frequently used printer properties settings can be registered as a custom setting.

Since custom settings can be saved in a file and recalled from that file, multiple users can share that file to print with 
the same printer properties settings.

Related topics

Printing 

Registering 

Changing the Name 

Deleting 

Updating Custom Settings According to the Current Printer Configuration 

Changing the Custom Settings Display Order 

Saving a Registered Custom Setting in a File 

Registering a Custom Setting Using a Custom Setting File 

Top Previous Next
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Printing > Custom Settings > Printing

Printing

Follow the procedure below to print with the registered custom settings.

The printer configuration settings must be made beforehand.

1.  Open the file you want to print from the application, and then open the printer properties dialog box.

2.  On the [Setup] tab, select a setting in the [Custom Settings:] list.

Click [No setting] to print with the standard settings.

3.  On the [Page Settings] tab, check that the document orientation and size are the same as those selected in 

the application.

❍     Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected, 

make the correct settings.

4.  To print multiple sets, enter the number of sets in the [Copies] box.

5.  On the [Setup] tab, click [Normal Print] in the [Job type:] list.

❍     A paper tray and paper type are included in a registered custom setting. If you want to print on paper that is different from the one in 

the selected custom setting, you can select the paper tray and paper type you want to use on the [Setup] tab.

6.  Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

7.  Make print settings, and then click [OK].

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings > Registering

Registering

Follow the procedure below to register a new custom setting.

●     Up to 16 custom settings can be registered.

1.  Open the printer properties dialog box.

2.  Click the [Setup], [Page Settings], or [Edit] tab.

3.  In the [Custom Settings:] list, select the custom setting on which you want to base the new custom setting.

❍     To base the new setting on the default settings, click [No setting].

❍     When creating a new custom setting based on an existing custom setting, select the custom setting from which you can make the 

new setting with the least changes.

4.  Make the settings on the [Setup], [Page Settings], and [Edit] tabs.

❍     Settings not included in a custom setting are as follows: [Job type:] on the [Setup] tab, [Original orientation:], [Original size:], 

[Printout paper size:], and [Copies] on the [Page Settings] tab, and all settings in the [Printer Configuration] dialog box.

5.  Click [Save...].

The [Save New Custom Setting] dialog box appears.

6.  In the [Custom Setting name:] box, enter a custom setting name.

❍     Up to 36 characters can be entered.

7.  Click [OK].

The custom setting is registered and added to the list.

8.  Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings > Changing the Name

Changing the Name

Follow the procedure below to change a name of a registered custom setting.

1.  Open the printer properties dialog box.

2.  Click the [Setup], [Page Settings], or [Edit] tab.

3.  Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4.  Select the custom setting whose name you want to change.

❍     [No setting] cannot be changed.

5.  In the [Custom Setting name:] box, enter a new name.

❍     Up to 36 characters can be entered.

6.  Click [Close].

The custom setting name is changed.

7.  Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings > Deleting

Deleting

Follow the procedure below to delete a registered custom setting.

●     If you delete the custom settings that were registered automatically during installation of the printer driver, they will reappear when the 

custom settings display is updated.

1.  Open the printer properties dialog box.

2.  Click the [Setup], [Page Settings], or [Edit] tab.

3.  Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4.  Select the custom setting you want to delete.

❍     [No setting] cannot be deleted.

5.  Click [Delete Custom Setting].

A confirmation message appears.

6.  Click [OK].

7.  Click [Close].

8.  Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings > Updating Custom Settings According to the Current Printer Configuration

Updating Custom Settings According to the Current Printer Configuration

There are two kinds of custom settings displayed in the printer properties dialog box: those registered automatically 
during installation of the printer driver and custom settings added later by the user. Since these custom settings are not 
deleted automatically, depending on the installed options, some custom settings that cannot be used to print may 
remain.

To keep only custom settings that can be used with the options installed, follow the procedure below to update custom 
settings after you install or uninstall options. The following is how each kind of custom settings will be updated:

●     Custom settings registered automatically during printer driver installation

Custom settings that can still be used remain registered. Custom settings that cannot be used are deleted.

●     Custom settings registered by user

Custom settings that cannot be used are deleted. Deleted custom settings cannot be recovered.

●     If bidirectional communication is not working, you must configure installed options in the [Printer Configuration] dialog box before 

performing this procedure.

1.  Open the printer properties dialog box.

2.  Click the [Setup], [Page Settings], or [Edit] tab.

3.  Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4.  Click [Refresh Printer Information].

❍     If bidirectional communication is working, printer configuration settings in the [Accessories] area and custom settings in the 

[Custom Settings:] list are updated.

❍     If bidirectional communication is not working, custom settings in the [Custom Settings:] list are updated according to the current 

printer configuration settings in the [Accessories] area.

5.  Click [Close].

6.  Click [OK].

The printer properties dialog box closes.

●     Checking Whether Bidirectional Communication is Working or Not

●     Opening from the Start Menu

●     Opening from an Application

Updating Custom Settings According to the Current Printer Configuration
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Printing > Custom Settings > Changing the Custom Settings Display Order

Changing the Custom Settings Display Order

Follow the procedure below to change the display order in the [Custom Settings:] list. For optimal ease-of-use, change 
the order according to the setting type and how often you use them.

1.  Open the printer properties dialog box.

2.  Click the [Setup], [Page Settings], or [Edit] tab.

3.  Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4.  Select the custom setting you want to move.

❍     [No setting] cannot be moved.

5.  Click [Move Up] or [Move Down].

6.  Click [Close].

7.  Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings > Saving a Registered Custom Setting in a File

Saving a Registered Custom Setting in a File

Follow the procedure below to save a registered custom setting in a custom setting file.

●     Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, this function is unavailable.

1.  Open the printer properties dialog box.

2.  Click the [Setup], [Page Settings], or [Edit] tab.

3.  Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4.  Select the custom setting you want to save.

5.  Click [Save Custom Setting...].

The [Save Custom Setting] dialog box appears.

6.  In the [File name:] box, enter a file name.

❍     Up to eight characters can be entered.

❍     The extension is .rst.

7.  Click [OK].

The [Save Custom Setting] dialog box closes. The custom setting is saved in a custom setting file.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printing > Custom Settings > Registering a Custom Setting Using a Custom Setting File

Registering a Custom Setting Using a Custom Setting File

Follow the procedure below to register a custom setting from a custom setting file. This file would be provided by an 
administrator, for example.

●     The custom settings file name can be up to eight characters.

1.  Open the printer properties dialog box.

2.  Click the [Setup], [Page Settings], or [Edit] tab.

3.  Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4.  Click [Load Custom Setting].

The [Load Custom Setting...] dialog box appears.

5.  Select the file containing the custom setting you want to register.

6.  Click [OK].

The custom setting is imported and registered.

7.  Click [Close].

8.  Click [OK].

The printer properties dialog box closes.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box

Opening the Printer Properties Dialog Box

The printer properties dialog box can be opened from an application or from the [Start] menu of Windows. Depending 
on how you open it, the available tabs vary.

Related topics

Opening from the Start Menu 

Opening from an Application 

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu

Opening from the Start Menu

All printer properties settings can be changed if the printer properties dialog box is opened from the [Printers] folder 
(Windows XP, Windows Server 2003: the [Printers and Faxes] folder).

●     The printer properties settings made here are displayed as the default when the printer properties dialog box is opened from an application.

Related topics

For Windows 95/98/Me 

For Windows 2000, Windows NT 4.0 

For Windows XP, Windows Server 2003 

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows 95/98/Me

For Windows 95/98/Me

Follow the procedure below to open the printer properties dialog box from the [Start] menu.

1.  On the [Start] menu, point to [Settings], and then click [Printers].

2.  Click the icon of the printer, and then click [Properties] on the [File] menu.

The printer properties dialog box appears.

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows 2000, Windows NT 4.0

For Windows 2000, Windows NT 4.0

Follow the procedure below to open the printer properties dialog box (Windows NT 4.0: the [Default] dialog box) 
from the [Start] menu.

1.  On the [Start] menu, point to [Settings], and then click [Printers].

❍     Under Windows Server 2003, click [Printers and Faxes].

2.  Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

❍     Under Windows NT 4.0, click [Document Defaults...] on the [File] menu.

❍     To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box (Windows NT 4.0: the [Default] dialog box) appears.

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows XP, Windows Server 2003

For Windows XP, Windows Server 2003

Follow the procedure below to open the printer properties dialog box from the [Start] menu.

Windows XP Home Edition

1.  On the [Start] menu, click [Control Panel].

2.  Click [Printers and Other Hardware].

3.  Click [Printers and Faxes].

4.  Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

❍     To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box appears.

Windows XP Professional

1.  On the [Start] menu, click [Printers and Faxes].

2.  Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

❍     To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box appears.

Top Previous Next
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Printer Driver > Opening the Printer Properties Dialog Box >  Opening from an Application

Opening from an Application

Follow the procedure below to open the printer properties dialog box from an application. The default properties 
settings are displayed when opened from an application. Change the settings as necessary.

●     Changes made here are only applicable with that application and only as long as that application stays open.

●     Some applications may automatically change the printer properties settings.

●     The procedure below is an example for Paint (included in the standard Windows package).

●     How to open the printer properties dialog box differs depending on the application. From most applications, the printer properties dialog box 

can be opened by clicking [Print...] or [Page Setup...] on the [File] menu, and then clicking [Properties] (Windows 2000/XP, Windows Server 

2003: [Preferences]). For details, see Help of the application.

1.  On the [File] menu, click [Print...].

2.  In the [Name] list, select the name of this printer, and then click [Properties] (Windows 2000/XP, 

Windows Server 2003: [Preferences]).

The printer properties dialog box (Windows 2000/XP, Windows Server 2003: the [Printing Preferences] dialog 
box) appears.

Top Previous Next
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Printer Driver > Displaying the Printer Status

Displaying the Printer Status

Using the Printer Status monitor, printer conditions such as the print jobs or remaining ink can be checked from the 
computer. Also, when errors occur, the status of the printer and the solution to the problem can be checked quickly.

Related topics

Opening the Printer Status Monitor 

Top Previous Next
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Printer Driver > Displaying the Printer Status > Opening the Printer Status Monitor

Opening the Printer Status Monitor

The Printer Status monitor automatically opens when printing starts. It can also be opened when not printing. Follow 
the procedure below to open the Printer Status monitor.

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Printer Status].

The Printer Status monitor dialog box appears.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Printer Properties Settings

Printer Properties Settings

Make various print settings in the printer properties dialog box.

Related topics

Using Help 

Checking Whether Bidirectional Communication is Working or Not 

Top Previous Next
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Printer Driver > Printer Properties Settings > Using Help

Using Help

For information about setting items and how to make settings, see Help.

Two types of the printer driver Help are available: context Help and content Help.

Related topics

Displaying an Explanation for Each Setting Item (Context Help) 

Displaying Help in a Help Window (Content Help) 

Top Previous Next
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Printer Driver > Printer Properties Settings > Using Help > Displaying an Explanation for Each Setting Item (Context Help)

Displaying an Explanation for Each Setting Item (Context Help)

Follow the procedure below to display Help for each setting item.

1.  Click the [?] button found at the upper right of each dialog box.

A question mark appears beside the pointer.

2.  Move the pointer over the setting item for which you want to read Help.

❍     You can also display Help for the setting item by right-clicking the setting item, and then clicking [Help] on the shortcut menu that 

appears.

Top Previous Next
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Printer Driver > Printer Properties Settings > Using Help > Displaying Help in a Help Window (Content Help)

Displaying Help in a Help Window (Content Help)

Follow the procedure below to display Help.

1.  Click [Help] found at the lower right in each dialog box.

Help for the open dialog box appears.

2.  To display the contents, click [Help Topics].

3.  In the [Help Topic] dialog box, select a topic.

4.  Click [Display].

●     To print the currently displayed Help topic, click [Print] at the top.

●     To print from the [Help Topics] dialog box, select a topic, and then click [Print].

●     In the [Help Topics] dialog box, selecting a book and printing it will print all topics in that book.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Printer Properties Settings >  Checking Whether Bidirectional Communication is Working or Not

Checking Whether Bidirectional Communication is Working or Not

Follow the procedure below to check if bidirectional communication is working by obtaining the printer version 
information.

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [About].

The [About] dialog box appears.

4.  Check that the printer version is displayed.

When bidirectional communication is working, the printer version is displayed.

5.  Click [OK].

❍     The printer version appears under [System Version:].

Requirements for Bidirectional Communication

If bidirectional communication is working between the printer and computer, information about the paper loaded 
in the printer is sent to the computer and is applied automatically to the printer properties settings. In addition to 
that, the printer status can be checked from the computer.

●     The computer must support bidirectional communication.

●     The bidirectional communication settings must be enabled in the printer properties.

●     The printer and computer must be connected using a USB cable.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities

Maintaining the Printer Using Utilities

If you repeatedly print, the inside of the printer will get dirty and print quality may degrade. Perform printer 
maintenance from the [Maintenance] tab in the printer properties dialog box.

Related topics

Nozzle Check 

Clean Print-heads (Normal) 

Clean Print-heads (Full) 

Adjust Print-head Positions 

Registration 

Adjust Paper Feed 

Restore Defaults/Other Settings 

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Nozzle Check

Nozzle Check

Follow the procedure below to check whether the print-head nozzles are clogged up or not by printing a nozzle check 
test pattern.

●     To check the printed test pattern, proceed to step 7..

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Nozzle Check].

4.  Click [Next >].

5.  Check that A4/Letter size paper is loaded in the paper tray.

6.  Click [Next >].

7.  Check the printed test pattern.

Normal

When print-heads are clogged

8.  Click [Finish].

❍     If the printed test pattern is not clear, select the [Clean print-heads (normal)] check box, and then click [Next >].

●     Opening from the Start Menu

●     Opening from an Application

●     Clean Print-heads (Normal)

Nozzle Check
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Nozzle Check
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Normal)

Clean Print-heads (Normal)

Follow the procedure below to perform a normal print-head cleaning. Perform a head cleaning when a particular color 
cannot be printed or print images are blurred. Head cleaning consumes ink.

●     When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head 

cleaning will be automatically performed.

1.  Slide the envelope selector  to the forward position.

2.  Open the printer properties dialog box.

3.  Click the [Maintenance] tab.

4.  Click [Clean Print-heads (Normal)].

5.  In the [Select print-head(s)] area, select a color.

6.  Click [Next >].

7.  Click [Next >].

❍     Do not perform another operation before cleaning is complete.

8.  Click [Finish].

❍     To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >]. 

Nozzle check starts.

❍     If the condition of the print-heads is not satisfactory, perform head cleaning again. However, the heads may remain clogged and the 

printer may not print properly even if you clean the heads multiple times. If this happens, perform a full print head cleaning. If there 

is still no improvement, turn the printer off, and then leave it overnight or longer. This may solve the problem.

Clean Print-heads (Normal)
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Clean Print-heads (Normal)

●     Opening from the Start Menu

●     Opening from an Application

●     Nozzle Check

●     Clean Print-heads (Full)
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Full)

Clean Print-heads (Full)

Follow the procedure below to perform a thorough print-head cleaning. Since this consumes more ink than a normal 
head cleaning does, perform this when the problem persists after performing a normal head cleaning.

●     When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head 

cleaning will be automatically performed.

1.  Slide the envelope selector  to the forward position.

2.  Open the printer properties dialog box.

3.  Click the [Maintenance] tab.

4.  Click [Clean Print-heads (Full)].

5.  In the [Select print-head(s)] area, select a color.

6.  Click [Next >].

7.  Select the [Clean print-heads (full)] check box.

8.  Click [Next >].

Head cleaning starts.

❍     Do not perform another operation before cleaning is complete.

9.  Click [Finish].

❍     To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >]. 

The nozzle check starts.

●     A full print-head cleaning consumes a lot of ink. Perform it only when necessary. 

Clean Print-heads (Full)
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Clean Print-heads (Full)

●     A full print-head cleaning may deplete the ink before the Print cartridge is expected to need to be changed.

●     Opening from the Start Menu

●     Opening from an Application

●     Nozzle Check
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Printer Driver > Maintaining the Printer Using Utilities > Adjust Print-head Positions

Adjust Print-head Positions

Follow the procedure below to print a test pattern and adjust the print-head positions if vertical lines are printed 
unaligned or printed colors look blurred.

●     To check the printed test pattern, proceed to step 8..

●     When the envelope selector is not at the correct position, the colors may be printed unaligned.

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Adjust Print-head Positions].

4.  In the [Select a test pattern:] list, select a test pattern.

❍     Select a resolution. To adjust print-head positions for all resolutions, repeat this procedure selecting the other resolution.

[High speed/ Standard (speed priority)] is selected here as an example.

5.  Click [Next >].

6.  Check that A4/Letter size paper is loaded in the paper tray.

7.  Click [Next >].

A test pattern to adjust print-head positions is printed.

❍     Do not perform other operations during printing.

❍     The "High quality" test pattern differs from the "Standard" test pattern.

8.  Check the optimal adjustment values on the printed test pattern.

❍     The optimal adjustment value is the column number that appears above the lightest gray square with straight vertical lines on both 

sides. When the column number is "+2" for the "A" line, the optimal adjustment value is "+2" for "A".

Adjust Print-head Positions
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Adjust Print-head Positions

9.  Enter the optimal adjustment values.

10.  Click [Finish].

❍     Repeat steps 4. to10. to print the "High quality" or "Standard" test pattern and enter the optimal adjustment values.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Registration

Registration

Follow the procedure below to adjust where to start printing on paper loaded in each paper tray after checking the test 
pattern printed.

●     To check the printed test pattern, proceed to step 8..

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Registration].

4.  In the [Unit type:] list, select a paper tray. In the [Paper type:] list, select a paper type.

5.  Click [Next >].

6.  Check that A4/Letter size paper is loaded in the paper tray.

7.  Click [Next >].

A test pattern to adjust the print start position is printed.

❍     Do not perform other operations during printing.

8.  Check the optimal adjustment values on the printed test pattern.

❍     Fold the test pattern sheet in half lengthwise.

❍     The optimal adjustment value is the difference between the single vertical line and the cross's vertical line that you can see when the 

folded paper is held up to light. When the difference is one calibration mark in the "+" direction, the optimal adjustment value for 

the [Printing direction:] is "+1.0".

Registration
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Registration

❍     Fold the test pattern sheet in half widthwise, and then check the adjustment value for the [Paper feed direction:].

❍     Adjustment values are in 0.1 increments.

9.  In the [Printing direction:] and [Paper feed direction:] boxes, enter the adjustment values (-4.0 to +4.0) 

from step 8..

10.  Click [Finish].

❍     If a test pattern does not print or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then 

click [Next >]. A registration test pattern is printed and the dialog box displayed in step 9..

●     Opening from the Start Menu

●     Opening from an Application
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Printer Driver > Maintaining the Printer Using Utilities > Adjust Paper Feed

Adjust Paper Feed

If horizontal lines are printed unaligned or print images are patchy, print a test pattern, and then adjust the paper feed 
setting.

●     To check the printed test pattern, proceed to step 7..

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Adjust Paper Feed].

4.  Click [Next >].

5.  Check that A4/Letter size paper is loaded in the paper tray.

6.  Click [Next >].

A test pattern to adjust paper feed is printed.

❍     Do not perform other operations during printing.

7.  Check the optimal adjustment values on the printed test pattern.

❍     The optimal adjustment value is the number that appears on the left of the lightest gray square with straight horizontal lines on both 

sides. When this number is "+2", the optimal adjustment value is "+2".

❍     When horizontal lines beside the lightest gray square are broken, select the optimal adjustment value by referring to the lines broken 

in the opposite direction. When the "+2" square is the lightest gray square and the "+6" horizontal lines are broken in the opposite 

direction, the optimal adjustment value is between "+3" and "+5". After adjustment, check the adjustment result.

Adjust Paper Feed
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Adjust Paper Feed

8.  In the [Paper feed value:] box, enter the adjustment value (-14 to +14) from step 7..

9.  Click [Finish].

❍     If a test pattern is not printed or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then 

click [Next >].

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings

Restore Defaults/Other Settings

Follow the procedure below to restore the settings to their defaults or specify the amount of time the printer will wait 
for more information from the computer sending the print data before it times out (I/O timeout).

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Restore Defaults/Other Settings].

The [Restore Defaults/Other Settings] dialog box appears.

●     Opening from the Start Menu

●     Opening from an Application

Related topics

Restoring the Settings to Their Defaults 

Specifying an I/O Timeout 

Top Previous Next
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Restore Defaults/Other Settings
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings > Restoring the Settings to Their Defaults

Restoring the Settings to Their Defaults

Follow the procedure below to restore the settings for [Adjust Print-head Positions], [Registration], [Adjust Paper 
Feed], and [I/O Timeout:] to their defaults.

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Restore Defaults/Other Settings].

4.  Click [Restore Defaults]

A confirmation message appears.

5.  Click [OK].

●     The settings currently made for [Adjust Print-head Positions], [Registration], [Adjust Paper Feed], and [I/O Timeout:] will be lost. These 

settings cannot be restored. 

●     Opening from the Start Menu

●     Opening from an Application

●     Adjust Print-head Positions

●     Registration

●     Adjust Paper Feed

●     Specifying an I/O Timeout

Top Previous Next
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings > Specifying an I/O Timeout

Specifying an I/O Timeout

Follow the procedure below to specify the amount of time the printer will wait for more information from the 
computer sending the print data before it times out.

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Restore Defaults/Other Settings].

The [Restore Defaults/Other Settings] dialog box appears.

4.  In the [Select a time period] area, select the amount of time in the [I/O Timeout:] list.

5.  Click [OK].

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Specifying an I/O Timeout
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Printer Driver > Checking the Current Printer Driver Version

Checking the Current Printer Driver Version

Follow the procedure below to check the version of the printer driver currently installed.

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [About].

The [About] dialog box appears.

4.  Check the version.

●     Opening from the Start Menu

●     Opening from an Application

Top Previous Next
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Checking the Current Printer Driver Version
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Printer Driver > Uninstalling the Printer Driver

Uninstalling the Printer Driver

Follow the procedure below to uninstall the current printer driver before installing the new version of the printer driver.

●     The Printer Status monitor installed with the current printer driver will be uninstalled when the current printer driver is uninstalled.

●     Custom settings registered are also deleted. To continue using the registered custom settings, save them as custom setting files before 

uninstalling.

1.  On the [Start] menu, point to [Settings], and then click [Printers].

❍     Under Windows XP Professional, click [Printers and Faxes] on the [Start] menu.

❍     Under Windows XP Home Edition, click [Control Panel] on the [Start] menu. Click [Printers and Other Hardware], and then click 

[Printers and Faxes].

2.  Click the icon of the printer, and then click [Delete] on the [File] menu.

3.  A confirmation message appears. Click [Yes].

The printer driver is uninstalled.

●     Saving a Registered Custom Setting in a File

Top Previous Next
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Uninstalling the Printer Driver
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Paper > Loading Paper

Loading Paper

Load paper into the paper tray.

Normally, load paper into tray 1. Tray 2 (optional) can be used if installed.

●     Load paper with the paper grain parallel to the feed direction.

●     Printing on Thick Paper

Related topics

Loading Paper into Tray 1 

Loading Paper into Tray 2 (optional) 

Top Previous Next

Copyright © 2004 All rights reserved.

Loading Paper
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Paper > Loading Paper > Loading Paper into Tray 1

Loading Paper into Tray 1

Follow the procedure below to load paper into tray 1.

1.  Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

2.  Hold both sides of tray 1, and pull it toward you.

❍     Tray 1 cannot be detached. Do not pull it forcefully.

3.  Squeeze the paper guide release, and then slide the side paper guides into position according to the paper 

size.

Loading Paper into Tray 1
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Loading Paper into Tray 1

❍     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4.  Load paper with the print side face down but not over the limit mark.

5.  Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

6.  Hold both sides of tray 1, and push it gently in until it stops.
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Loading Paper into Tray 1

7.  Lower the output tray.

Top Previous Next
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Paper > Loading Paper > Loading Paper into Tray 2 (optional)

Loading Paper into Tray 2 (optional)

Follow the procedure below to load paper into tray 2.

●     Only plain paper can be loaded in tray 2.

1.  Hold both sides of tray 2, lift it slightly, and pull it toward you.

❍     Pull tray 2 completely out. Take care not to drop it.

2.  Lift off the cover.

3.  Squeeze the paper guide release, and then slide the paper guides into position according to the paper size.

Loading Paper into Tray 2 (optional)
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Loading Paper into Tray 2 (optional)

4.  Load paper with the print side face down but not over the limit mark.

5.  Re-attach the cover.

6.  Hold both sides of tray 2, and push it gently in until it stops.
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Loading Paper into Tray 2 (optional)

Related topics

Loading Paper Larger than A4 (Letter) 

Top Previous Next
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Paper > Loading Paper > Loading Paper into Tray 2 (optional) > Loading Paper Larger than A4 (Letter)

Loading Paper Larger than A4 (Letter)

Follow the procedure below to use the paper tray extension for paper larger than A4 (Letter) size, such as legal size 
paper.

1.  Pull tray 2 toward you, until it is completely out of the printer, and then lift off the cover.

2.  Slide the tabs on both sides of the tray's interior to the unlocked position.

3.  Pull out the paper tray extension.

Loading Paper Larger than A4 (Letter)
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Loading Paper Larger than A4 (Letter)

4.  Slide the tabs back into place to lock the paper tray extension into position.

5.  Squeeze the paper guide release, and then slide the paper guides into position according to the paper size.

❍     Do not use the paper tray extension for A4 (Letter) size paper or smaller paper. Use it only for long paper.

Top Previous Next
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Paper > Compatible Paper

Compatible Paper

Before printing, check the paper types compatible with this printer.

Related topics

Compatible Paper Types 

Compatible Paper Sizes 

Paper Handling Precautions 

Printable Area 

Top Previous Next
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Compatible Paper
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Paper > Compatible Paper > Compatible Paper Types

Compatible Paper Types

You can use various types of paper.

●     Plain paper

This paper is normally used for copying and printing. Unlike inkjet plain paper or semi-gloss photo paper, it is 
uncoated.

●     Inkjet plain paper

This extra-white plain paper makes the printed colors appear more vivid. Since it does not have an ink-
absorbent coating, you can write on it and use it for photocopying, just like regular plain paper.

●     Semi-gloss photo paper

Glossy photo paper with reduced reflection is a good match for the pigmented inks used by the machine. Paper 
for dye inks is not recommended because the machine's pigmented inks may not take properly to it or may 
smear or rub off. Glossy photo paper can be used in this machine provided it is compatible with pigmented inks.

●     Inkjet transparency

Transparency film for equipment such as overhead projectors is designed for the pigmented inks used by the 
machine. Film for plain paper copiers cannot be used because it does not absorb ink. Film for dye inks is not 
recommended because the machine's pigmented inks may not take properly to it or may smear or rub off. 
Transparency film can be used in this machine provided it is compatible with pigmented inks.

●     Envelopes

For details about the types of envelope that can be used, see Paper Handling Precautions. Paper Handling 

Precautions

●     Thick paper

For details about the types of thick paper that can be used, see Paper Handling Precautions. Paper Handling 

Precautions

●     All types of paper besides thick paper can be loaded in tray 1.

●     Only plain paper can be loaded in tray 2 (optional).

●     Printing on Various Paper Types

Top Previous Next
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Paper > Compatible Paper > Compatible Paper Sizes

Compatible Paper Sizes

You can use various sizes of paper.

Standard Sizes

●     A4*1

●     A5 (landscape)

●     A6

●     B5*1

●     Exective (184.2 × 266.7 mm (7.3 × 10.5 inches))*1

●     F (203.2 × 330.2 mm (8.0 × 13.0 inches))*1

●     Foolscap (F4) (215.9 × 330.2 mm (8.5 × 13.0 inches))*1

●     Folio (209.5 × 330.2 mm (8.3 × 13.0 inches))*1

●     Letter*1

●     Legal*1

●     5 1/2" × 8 1/2" (landscape)

Custom paper sizes

●     Custom paper sizes: 148-356mm (length) × 90-216mm (width), (5.9-14.1 inches (length) × 3.6-8.5 
inches (width))

●     Custom paper sizes with the bypass tray: 148-1295.4mm (length) × 90-216mm (width), (5.9-51.0 inches 
(lengths) × 3.6-8.5 inches (width))

Envelopes

●     Com10 (104.8 × 241.3 mm (4.2 × 9.5 inches))

●     Monarch (98.4 × 190.5 mm (3.9 × 7.5 inches))

●     C6 (114 × 162 mm (4.5 × 6.4 inches))

●     C5 (162 × 229 mm (6.4 × 9.1 inches))

●     DL Env (110 × 220 mm (4.4 × 8.7 inches))

*1 Can also be loaded in Tray 2 (optional).

Top Previous Next
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Compatible Paper Sizes
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Paper > Compatible Paper > Paper Handling Precautions

Paper Handling Precautions

To ensure optimum print results, take care when handling paper before and after printing.

Loading precautions

●     Use compatible paper.

●     Load paper with the print side face down in the paper trays.

●     Load paper with the paper grain parallel to the feed direction.

●     Do not load paper of different types at the same time.

●     Do not stack paper over the limit mark.

●     Curled paper may jam. Straighten any curls before loading.

●     Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or 
similar object.

●     When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of 

Paper Handling Precautions
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Paper Handling Precautions

the bypass tray guides.

Paper storage precautions

●     Do not store paper in humid places.

●     Do not store paper in direct sunlight.

●     Store paper flat.

●     Store unused paper in the original package.

Paper type precautions

Plain paper

●     Use the bypass tray to print on paper heavier than 105 g/m2 (198.5 lb.).

●     Depending on the type of paper, the ink may take time to dry. With duplex printing, the ink may 
smear or rub off. Using the printer driver, specify how long to wait for the ink to dry between 
printing each side of a duplex sheet. For details, see the printer driver Help. Opening the Printer 

Properties Dialog Box

Inkjet plain paper

●     When printing on inkjet plain paper, in the printer properties dialog box, click [Inkjet Plain Paper]. 
This allows printing at higher quality.

●     In the printer properties dialog box, when [Inkjet Plain Paper] is selected, only one-sided printing 
is possible. To print on both sides of a sheet, click [Plain].

●     The ink may smear depending on the type of image. If this happens, set the envelope selector to 
the rear position .

●     Use as soon as possible after opening the package.

Semi-gloss photo paper

●     The glossy side (or the pearl side) of the paper is the printing surface.

●     Handle paper by the edges so as not to dirty or leave fingerprints on the print side.

●     Make sure that sheets are not badly bent or scratched, and the print side is not damaged.

●     Only one-sided printing is possible.

●     After printing, do not touch the printed side until the ink has fully dried.

●     If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

●     Make sure that the output tray has no more than twenty sheets stacked on it.

●     Semi-gloss photo paper is designed for photograph printing. For graphics, we recommend plain or 
inkjet plain paper.
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Paper Handling Precautions

●     When using these sheets, see the instructions supplied with them.

Inkjet transparency

●     Identify the print side by orientating the sheet vertically, so that the notched corner is at the bottom 
left. The side facing you is the print side.

●     Load one sheet at a time. If multiple sheets are loaded, the leading edge of transparencies may get 
scratched.

●     Handle sheets by the edges so as not to dirty or leave fingerprints on the print side.

●     Make sure that sheets are not badly bent or scratched, and the print side is not damaged.

●     Only one-sided printing is possible.

●     Remove sheets from the output tray individually, as they come out.

●     After printing, do not touch the printed side until the ink has fully dried.

●     If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

●     Ink takes time to dry. To prevent sheets from sticking together, remove them from the output tray 
individually, as they come out.

●     If printing comes out streaked, adjust the paper feed level. See Adjust Paper Feed.

●     Use at 15-25°C (59-77°F) and 30-70% humidity.

●     Use as soon as possible after opening the package.

●     When using these sheets, see the instructions supplied with them.

Envelopes

●     Feed envelopes one by one into the bypass tray at the back of the machine.

●     Squeeze the excess air from the envelopes, making them as flat as possible.

●     Load them properly, because the printable area depends on the orientation. See Printable Area.

Thick paper

●     Use tray 1 to load paper lighter than 105 g/m2 (198.5 lb.).

●     You can insert paper with weights up to 163 g/m2 (308.7 lb.) into the bypass tray.

●     Insert paper with the print side face up into the bypass tray.

Cautions to Observe After Printing

Depending on the paper type, the ink may take a while to dry. After printing, be careful not to touch the printed 
side until the ink has dried properly; otherwise, the ink may smudge.

●     Printing on Various Paper Types

Top Previous Next
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Paper > Compatible Paper > Printable Area

Printable Area

Printable and unprintable areas

1.  Feed Direction

2.  Printable Area

3.  3 mm (0.12 inches)

●     Do not attempt to print beyond the guaranteed printable area. Paper feed precision is reduced around the printable area limits, resulting in 

lower print quality.

●     When printing on envelopes, the following print area limitations apply.

1.  Feed Direction

2.  Printable Area

3.  8 mm (0.4 inches)

4.  38 mm (1.5 inches)

5.  5 mm (0.2 inches)

Top Previous Next
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Printable Area
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Paper > Non-compatible Paper

Non-compatible Paper

Check if the paper is compatible.

Do not use paper that is:

●     wrinkled, folded, or damaged

●     wavy at the ends

●     curled

●     absorbent

●     dry and conducive to static buildup

●     already printed on

●     preprinted (unless specified)

●     heat sensitive/non-carbon

●     too thick or thin

●     pre-stitched or hole-punched

●     glued or tacked

●     stapled or clipped together

●     dark in places

●     irregular in length and proportion

●     Even if compatible paper types are used, print quality may be lower than usual or paper jams may occur if the paper was improperly stored.
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Troubleshooting > Printing Will Not Start

Printing Will Not Start

If printing will not start, check whether the power of the printer is on or whether the power can be turned on or not.

Related topics

Power Cannot Be Turned On 

Paper Will Not Feed Even When the Power Is On 

Top Previous Next
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Troubleshooting > Printing Will Not Start > Power Cannot Be Turned On

Power Cannot Be Turned On

If the [Power] key does not light or does not blink when it is pressed, check if there is something wrong with the 
power cord or wall outlet.

Check the following:

●     Make sure that the power plug is firmly inserted into the wall outlet.

●     Check if there is something wrong with the wall outlet. Do this by connecting another electronic product whose 
operation you are familiar with.

Top Previous Next
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Troubleshooting > Printing Will Not Start > Paper Will Not Feed Even When the Power Is On

Paper Will Not Feed Even When the Power Is On

If printing will not start even when the power is on, check if an error has occurred using the indicators or Printer Status 
monitor.

An indicator is lit or blinking

Only the [Power] key is blinking.

The printer may be receiving data or replenishing its ink. Wait momentarily for the blinking [Power] key to stop 

and stay lit.

The [Test Paper Feed/Resume] key or a low ink indicator is blinking or lit.

An error has occurred. See Error Indicator Summary.

An error message is displayed on the Printer Status monitor.

Click [User Guide...] to display the page corresponding to the error where you can check how to solve the problem in 

more detail. See Printer Status Monitor Errors.

 

A print sample can be printed using keys on the control panel to check that the printer is not out of order.

When the power is off, while holding down the [Cancel] key and the [Test Paper Feed/Resume] key, press and 
hold down the [Power] key for over three seconds. The low ink indicators will light once and a print sample will 
be delivered.
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Troubleshooting > Paper Is Not Fed or Delivered Normally

Paper Is Not Fed or Delivered Normally

If the printer is operating but paper will not feed or paper jams multiple times, check the condition of the printer and 
paper.

Paper does not feed smoothly.

Paper guides are not adjusted properly.

●     The paper guides of the paper tray do not match the paper loaded. Adjust the paper guides and load the paper 

again. See Loading Paper.

Paper is not loaded properly.

●     The paper is not loaded properly. Load the paper correctly. See Loading Paper.

Paper is curled.

●     Remove the loaded paper and check if it is curled. If it is, straighten the curl.

Paper that is not compatible is loaded.

●     Remove the loaded paper and replace it with compatible paper. See Non-compatible Paper.

Paper jams multiple times.

The guide board is not closed.

●     Make sure that the guide board is closed. Remove the duplex unit and press both sides of the guide board until 

it clicks closed.

Multiple sheets are inserted in the bypass tray.

●     When using the bypass tray, insert paper one sheet at a time. See Printing on Thick Paper.

The tray 2 rear cover is not closed.

●     Make sure that the tray 2 rear cover is closed. Press both sides of the cover until it clicks closed.

Paper Is Not Fed or Delivered Normally
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Paper Is Not Fed or Delivered Normally

Printing densely colored images on both sides.

●     When printing images containing areas of solid color that consume a lot of ink, we recommend single-sided 

printing.

Multiple sheets of paper are fed at one time.

Load the paper again. Remove the paper from the paper tray, fan it well, and tap it on a flat surface such as a desk to 

even the edges. Check the position of the paper guides of the paper tray, and then load the paper again.

Though a paper jam is cleared, paper does not feed.

When a paper jam occurs, clear the paper jam, and then press the [Test Paper Feed/Resume] key. See Paper Jam.

●     If an error is displayed on the Printer Status monitor, follow the instructions to solve the problem.Printer Status Monitor Errors.

Top Previous Next
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Troubleshooting > Paper Jam

Paper Jam

This explains how to remove a paper jam. When a paper jam error appears in the Printer Status monitor, remove the 
paper from the location indicated.

●     If you cannot locate paper jams or jammed paper cannot be removed easily, you can check the condition of paper from the top of the printer.

Related topics

Removing Paper Jammed in the Paper Tray (Tray 1) 

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover) 

Removing Paper Jammed in the Bypass Tray 

Removing Paper Jammed under the Top Cover 

Removing Paper Jammed around the Guide Board 

Removing Paper Jammed in the Duplex Unit 

Removing Paper Jammed in the Output Tray 
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Paper Tray (Tray 1)

Follow the procedure below to remove paper jammed in tray 1.

1.  Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

2.  Hold both sides of tray 1, and then pull it toward you.

❍     Tray 1 cannot be detached. Do not pull it forcefully.

3.  Remove jammed paper.

❍     If you cannot remove the jammed paper or it is difficult to remove, the paper may be jammed inside the printer. Examine the paper 

carefully and remove.

❍     If you cannot locate jammed paper, it may be jammed inside the printer.

4.  Hold both sides of tray 1, and push it gently in until it stops.

Removing Paper Jammed in the Paper Tray (Tray 1)
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Removing Paper Jammed in the Paper Tray (Tray 1)

5.  Lower the output tray.

6.  Press the [Test Paper Feed/Resume] key.

Printing starts.

❍     Blank paper may be delivered after printing resumes.

●     Removing Paper Jammed around the Guide Board

●     Paper Is Not Fed or Delivered Normally
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Removing Paper Jammed in the Paper Tray (Tray 1)
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Follow the procedure below to remove paper jammed in tray 2 (optional).

1.  Hold both sides of tray 2, lift it slightly, and pull it toward you.

❍     Pull tray 2 completely out. Take care not to drop it.

2.  Lift off the cover.

3.  Remove jammed paper.

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

4.  Re-attach the cover.

5.  Hold both sides of tray 2, and push it gently in until it stops.

6.  Press the [Test Paper Feed/Resume] key.
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Printing starts.

●     Blank paper may be delivered after printing resumes.

If you cannot locate paper jammed in tray 2, follow the procedure below to remove the paper jammed.

1.  While pushing the tabs on both sides of the tray 2 rear cover toward the inside, open the tray 2 rear 

cover.

2.  Remove jammed paper.

3.  Close the tray 2 rear cover.
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

❍     Press both sides of the cover until it clicks closed.

4.  Press the [Test Paper Feed/Resume] key.

Printing starts.

❍     Blank paper may be delivered after printing resumes.

●     Paper Is Not Fed or Delivered Normally

Top Previous Next
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed in the Bypass Tray

Follow the procedure below to remove paper jammed in the bypass tray.

1.  Remove jammed paper.

2.  Press the [Test Paper Feed/Resume] key.

❍     The [Test Paper Feed/Resume] key stops blinking and stays lit.

3.  Insert a sheet of paper into the bypass tray with the print side face up.

Removing Paper Jammed in the Bypass Tray
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Removing Paper Jammed in the Bypass Tray

4.  Press the [Test Paper Feed/Resume] key.

Printing starts.

If it is difficult to remove jammed paper, follow the procedure below to remove it.

1.  Move the duplex unit locks to the unlocked position, and then detach the duplex unit.

2.  Remove jammed paper.
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Removing Paper Jammed in the Bypass Tray

3.  Attach the duplex unit, and then move the duplex unit locks to the locked position.

4.  Press the [Test Paper Feed/Resume] key.

❍     The [Test Paper Feed/Resume] key stops blinking and stays lit.

5.  Insert a sheet of paper into the bypass tray with the print side face up.
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Removing Paper Jammed in the Bypass Tray

6.  Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Paper Is Not Fed or Delivered Normally
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Troubleshooting > Paper Jam > Removing Paper Jammed under the Top Cover

Removing Paper Jammed under the Top Cover

Follow the procedure below to remove paper jammed under the top cover.

1.  Open the top cover.

2.  If the carriage stops in the middle, move it to whichever side is easier to move it to.

3.  Remove jammed paper.

❍     Take care not to snag the sleeves of your clothing on the cord.

❍     Do not touch the feed belt.

4.  Close the top cover.

Removing Paper Jammed under the Top Cover
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Removing Paper Jammed under the Top Cover

5.  Press the [Test Paper Feed/Resume] key.

Printing starts.

❍     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.
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Troubleshooting > Paper Jam > Removing Paper Jammed around the Guide Board

Removing Paper Jammed around the Guide Board

Follow the procedure below to remove paper jammed around the guide board.

1.  Move the duplex unit locks to the unlocked position, and then detach the duplex unit.

2.  Unlock the guide board by moving the tabs on both sides toward the middle, and then open the guide 

board.

3.  Turn the paper feed wheel to release paper from the feed belt.

Removing Paper Jammed around the Guide Board
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Removing Paper Jammed around the Guide Board

Release paper from the roller to make it removable.

4.  Insert your finger between the paper and the roller, and then remove the paper slowly.

❍     Do not touch the feed belt.

5.  Close the guide board.

❍     Push the PUSH area on both sides of the guide board until it firmly closes.

6.  Attach the duplex unit, and then move the duplex unit locks to the locked position.
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Removing Paper Jammed around the Guide Board

7.  Press the [Test Paper Feed/Resume] key.

Printing starts.

❍     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

●     Paper Is Not Fed or Delivered Normally
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Duplex Unit

Follow the procedure below to remove paper jammed in the duplex unit.

1.  Press the duplex unit cover button, and then open the duplex unit.

2.  Remove jammed paper.

3.  Close the duplex unit cover.

Removing Paper Jammed in the Duplex Unit
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Removing Paper Jammed in the Duplex Unit

4.  Press the [Test Paper Feed/Resume] key.

Printing starts.

❍     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Output Tray

Removing Paper Jammed in the Output Tray

Follow the procedure below to remove paper jammed in the output tray.

1.  Remove jammed paper.

2.  Press the [Test Paper Feed/Resume] key.

Printing starts.

❍     Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.
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Removing Paper Jammed in the Output Tray
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Troubleshooting > Print Results Are Not Satisfactory

Print Results Are Not Satisfactory

If there is a problem with the quality of the printing such as dirty or faint and patchy prints, first check the condition of 
the printer.

Check the following:

Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position ; for 

everything else, set the lever to the forward position . See Printing on Various Paper Types.

Has the printer not been used for a long time?

The ink may be dry or the nozzles of the print-heads may be clogged. Print the nozzle check test pattern and clean the 

print-heads as necessary. See Nozzle Check and Clean Print-heads (Normal).

Has the nozzle check test pattern been printed?

Print the nozzle check test pattern and check whether the print-heads are clogged. Clean the print-heads as necessary. 

See Nozzle Check and Clean Print-heads (Normal).

Have the print-heads been aligned?

If the image is fuzzy or lines are doubled, align the print-heads. If the problem persists, print the nozzle check test 

pattern and clean the print-heads as necessary. See Adjust Print-head Positions, Nozzle Check, and Clean Print-heads 

(Normal).

Is there a problem with the printer's location?

Make sure that the printer is level. Place the printer in a location where it will not be subject to shaking or excessive 

force.

Related topics

Printing Is Uneven, Too Heavy, or Too Light 

Dirty or Blotted Prints 
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Troubleshooting > Print Results Are Not Satisfactory > Printing Is Uneven, Too Heavy, or Too Light

Printing Is Uneven, Too Heavy, or Too Light

If there is a problem with the quality of the printing such as uneven printing or an inappropriate amount of ink being 
used, the following questions should be addressed.

Is an old Print cartridge being used?

Print cartridges should be opened before their expiration date and used within six months of being opened.

Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various 

Paper Types.

Are you printing on the wrong side of the paper?

Check which side should be printed on when using inkjet plain paper. If you print on the wrong side, the quality of the 

printing may be lower and the inside of the printer may get dirty. See Paper Handling Precautions.

Is the setting of the envelope selector suitable?

The printed side may become worn depending on the type of image. If this happens, set the envelope selector to the 

rear position .

Is the brightness of the image suitable?

If the printing is being smeared even when the envelope selector is set to the rear position , the density of the 

printing may be too high. Increase the brightness of the image.

Is the [Duplex/Booklet] check box selected?

Duplex printing tends to produce fainter prints than single-sided printing. When performing single-sided printing, 

make sure the [Duplex/Booklet] check box is not selected. 
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Troubleshooting > Print Results Are Not Satisfactory > Dirty or Blotted Prints

Dirty or Blotted Prints

If prints are dirty or blotted, the following questions should be addressed.

Is the paper being used too thick or thin?

Check if the paper is compatible. If extremely thick or thin paper is used, the print-heads will rub the paper and ink 

will leak. See Compatible Paper.

Does the print-heads rub when plain paper is used?

Set the envelope selector to the rear position .

Have you touched the printed side of paper?

Avoid touching the printed side of paper. Particularly, avoid touching semi-gloss photo paper and inkjet transparency 

that have just been printed because the ink takes time to dry. Remove them one at a time from the output tray without 

touching the printed side, and then let them dry fully. See Paper Handling Precautions.

Is the inside of the printer dirty?

If the leading edge or back side of printed paper is dirty, the inside of the printer may be dirty. Also, if black vertical 

lines appear on the printed side of paper, the delivery rollers may be dirty. Turn the power off, and then while pressing 

the [Test Paper Feed/Resume] key, press and hold down the [Power] key for over three seconds. A blank sheet of 

paper will be delivered to clean the delivery rollers. Repeat this operation multiple times.

Is the paper loaded in the correct orientation?

Some paper cannot be loaded lengthwise depending on the size of the paper. Check the orientation in which the paper 

is loaded. See Compatible Paper Sizes.

Is a genuine Print cartridge being used?

Using a cartridge other than a genuine Print cartridge or using a cartridge refilled with ink will lower the print quality 

and could cause a breakdown. Use a genuine Print cartridge. See Recommended Consumables.

Are you printing densely colored images on both sides of paper?

When a large amount of ink is used to completely cover a side, one-sided printing is recommended.

When duplex printing, after printing one side of a sheet, does the machine wait for the ink to dry before 

printing the other side?

Depending on the type of paper, the ink may not have enough time to dry properly and so may smear or rub off. Using 

Dirty or Blotted Prints
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Dirty or Blotted Prints

the printer driver, specify how long to wait for the ink to dry between printing each side. For details, see the printer 

driver Help.Opening the Printer Properties Dialog Box
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Troubleshooting > Print Results Do Not Match the Displayed Image

Print Results Do Not Match the Displayed Image

If there are differences between the print results and the displayed image, first check the printer driver.

Check the following:

Does the printer driver of the printer support the application used?

Check if an application other than a Windows operating system application is being used.

Is the printer driver of the printer being used?

Make sure that the printer you want to use for printing is selected. See Opening from an Application.

Does data from a failed print job or canceled print job remain in memory?

Check whether data from a failed print job or canceled print job remains in memory. See Canceling Printing.

Related topics

Characters and Colors Do Not Match the Displayed Image 

Positions Do Not Match the Displayed Image 

Top Previous Next
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Troubleshooting > Print Results Do Not Match the Displayed Image > Characters and Colors Do Not Match the Displayed Image

Characters and Colors Do Not Match the Displayed Image

If there are differences between the characters and colors of the print results and the displayed image, the following 
questions should be addressed.

Has the hue of colors been adjusted?

Since printed colors and screen colors are produced by different methods, a color printed and a color displayed on a 

screen can have different hues even though they are the "same" color. Use the color matching function to make the 

hue of printed colors and displayed colors closer. See Changing the Color Profiling Pattern.

Has the nozzle check been performed?

The print-heads may be clogged and the amount of ink may not be able to be regulated. Print the nozzle check test 

pattern and clean the print-heads as necessary. See Clean Print-heads (Normal) and Nozzle Check.

Was printing done in black and white?

Check the color setting of the application and the color print setting of the printer driver. See Printing in Black and 

White.

Have the print quality settings been made?

Set the printing resolution to an appropriate level. See Printing Using Preset Print Quality Settings.

Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various 

Paper Types.

Have you tried printing with inkjet plain paper?

Try printing with inkjet plain paper. The print results should be clearer. See Printing on Various Paper Types.
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Troubleshooting > Print Results Do Not Match the Displayed Image > Positions Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

If the position of printed items differs from the position of displayed items, the following questions should be 
addressed.

Have the settings for page layout been made?

Check whether page layout settings have been made with the application.

Does the paper size setting match?

Make sure that the paper size selected in the [Printout paper size:] list of the printer properties dialog box matches the 

size of the paper loaded.

Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position ; for 

everything else, set the lever to the forward position . See Printing on Various Paper Types.

Have the print-heads been aligned?

When bidirectional printing is performed, and lines and characters are blurred, align the print-heads. If the problem 

persists, print the nozzle check test pattern and clean the print-heads as necessary. See Adjust Print-head Positions, 

Nozzle Check, and Clean Print-heads (Normal).
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Troubleshooting > Printer Status Monitor Does Not Open

Printer Status Monitor Does Not Open

If the Printer Status monitor does not open for a shared printer, the following questions should be addressed.

Are the share settings correct?

Check the share settings of the printer. The printer driver must also be installed on the client computer. See Setting Up 

a Server and Setting Up a Client Computer.

Does your Web browser support Printer Status Monitor?

Internet Explorer version 4.0 or later is required to display Printer Status Monitor and the dialog boxes displayed from 

the [Maintenance] tab of the printer driver.
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Troubleshooting > Printer Status Monitor Errors

Printer Status Monitor Errors

If an error occurs with the printer, Printer Status Monitor displays an error message. Click [User Guide...] to display 
the page corresponding to the error where you can check how to solve the problem in more detail.

Related topics

No Response from Printer 

No Paper/Tray Not Detected (Bypass Tray) 

No Paper/Tray Not Detected (Tray 1) 

No Paper/Tray Not Detected (Tray 2) 

Paper Size Mismatch (Bypass Tray) 

Paper Size Mismatch (Tray 1) 

Paper Size Mismatch (Tray 2) 

Cover Open 

Duplex Unit Not Detected 

Print Cartridge(s) Not Detected 

Paper in Bypass Tray 

Cartridge End 

Ink End 

Out of Printable Temperature Range 

Printer Error 
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Troubleshooting > Printer Status Monitor Errors > No Response from Printer

No Response from Printer

Follow the procedure below to check the port settings and the connection between the printer and computer.

1.  Check that the power of the printer is on.

2.  Make sure that the computer and printer are properly connected using a USB cable.

3.  Open the printer properties dialog box.

4.  Click the [Details] tab.

5.  Check that USB is selected in the [Print to the following port:] list.

❍     Under Windows 2000/XP or Windows Server 2003, check that USB is selected in the list on the [Port] tab.

●     Opening from the Start Menu

Top Previous Next
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Bypass Tray)

No Paper/Tray Not Detected (Bypass Tray)

If no paper is ready to be fed in the bypass tray, this message appears. Follow the procedure below to insert paper into 
the bypass tray.

1.  Slide the bypass tray guides into position according to the paper size.

2.  Insert a sheet of paper into the bypass tray with the print side face up.

❍     Support the sheet with your hands to keep it from sliding out and dropping.

❍     Insert the sheet straight into the bypass tray.

3.  Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

No Paper/Tray Not Detected (Bypass Tray)
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No Paper/Tray Not Detected (Bypass Tray)

Printing starts.
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 1)

No paper is loaded in tray 1 or paper is not loaded properly. Follow the procedure below to load paper properly.

1.  Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

2.  Hold both sides of tray 1, and pull it toward you.

❍     Tray 1 cannot be detached. Do not pull it forcefully.

3.  Squeeze the paper guide release, and then slide the side paper guides into position according to the paper 

size.

No Paper/Tray Not Detected (Tray 1)
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No Paper/Tray Not Detected (Tray 1)

❍     If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges. 

Check that the position of the paper guides and the front end guide match the paper size.

❍     Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4.  Load paper with the print side face down but not over the limit mark.

5.  Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

6.  Hold both sides of tray 1, and push it gently in until it stops.
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No Paper/Tray Not Detected (Tray 1)

7.  Lower the output tray.

8.  Press the [Test Paper Feed/Resume] key.

Printing starts.
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Tray 2)

No Paper/Tray Not Detected (Tray 2)

No paper is loaded in tray 2 (optional) or paper is not loaded properly. Follow the procedure below to load paper 
properly.

1.  Hold both sides of tray 2, lift it slightly, and pull it toward you.

❍     Pull tray 2 completely out. Take care not to drop it.

2.  Lift off the cover.

3.  Squeeze the paper guide release, and then slide the paper guides into position according to the paper size.

No Paper/Tray Not Detected (Tray 2)
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No Paper/Tray Not Detected (Tray 2)

❍     If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges. 

Check that the position of the paper guides and the front end guide match the paper size.

4.  Load paper with the print side face down but not over the limit mark.

5.  Re-attach the cover.

6.  Hold both sides of tray 2, and push it gently in until it stops.
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No Paper/Tray Not Detected (Tray 2)

7.  Press the [Test Paper Feed/Resume] key.

Printing starts.

❍     Loading Paper Larger than A4 (Letter)

Top Previous Next
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Bypass Tray)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper 
size in the printer properties settings.

1.  Open the printer properties dialog box from the application.

2.  Click the [Page Settings] tab.

3.  In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the 

paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

❍     If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then 

select the correct sizes.

❍     If paper of the incorrect size is loaded, proceed to the next step.

4.  Slide the bypass tray guides into position according to the paper size.

5.  Insert a sheet of paper into the bypass tray with the print side face up.

Paper Size Mismatch (Bypass Tray)
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Paper Size Mismatch (Bypass Tray)

❍     Support the sheet with your hands to keep it from sliding out and dropping.

❍     Insert the sheet straight into the bypass tray.

6.  Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

Printing starts.

●     Opening from an Application

●     Canceling Printing
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 1)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper 
size in the printer properties settings.

1.  Open the printer properties dialog box from the application.

2.  Click the [Page Settings] tab.

3.  In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the 

paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

❍     If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then 

select the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.

4.  Lift the output tray.

When the output tray is lifted, tray 1 will pop out slightly.

5.  Hold both sides of tray 1, and pull it toward you.

Paper Size Mismatch (Tray 1)
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Paper Size Mismatch (Tray 1)

❍     Tray 1 cannot be detached. Do not pull it forcefully.

6.  Remove loaded paper.

7.  Squeeze the paper guide release, and then slide the side paper guides into position according to the paper 

size.

❍     The front end paper guide may also need to be adjusted.

8.  Load paper with the print side face down but not over the limit mark.

9.  Squeeze the front end paper guide, and then slide it to meet the edge of the paper.
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Paper Size Mismatch (Tray 1)

10.  Hold both sides of tray 1, and push it gently in until it stops.

11.  Lower the output tray.

12.  Press the [Test Paper Feed/Resume] key.
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Paper Size Mismatch (Tray 1)

Printing starts.

●     Opening from an Application

●     Canceling Printing
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Tray 2)

Paper Size Mismatch (Tray 2)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper 
size in the printer properties settings.

1.  Open the printer properties dialog box from the application.

2.  Click the [Page Settings] tab.

3.  In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the 

paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

❍     If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then 

select the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.

4.  Hold both sides of tray 2, lift it slightly, and pull it toward you.

❍     When the output tray is lifted, tray 2 will pop out slightly. Pull tray 2 completely out. Take care not to drop it.

5.  Lift off the cover.

Paper Size Mismatch (Tray 2)
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Paper Size Mismatch (Tray 2)

6.  Remove loaded paper.

7.  Squeeze the paper guide release, and then slide the paper guides into position according to the paper size.

8.  Load paper with the print side face down but not over the limit mark.

9.  Re-attach the cover.
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Paper Size Mismatch (Tray 2)

10.  Hold both sides of tray 2, and push it gently in until it stops.

11.  Press the [Test Paper Feed/Resume] key.

Printing starts.

●     Loading Paper Larger than A4 (Letter)

●     Opening from an Application

●     Canceling Printing
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Paper Size Mismatch (Tray 2)
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Troubleshooting > Printer Status Monitor Errors > Cover Open

Cover Open

A cover is open. Close the cover.

Follow the procedure below to close the top cover or duplex unit cover.

1.  Close the cover.

❍     Check that the duplex unit is correctly attached and the duplex unit cover is closed.

2.  If the [Test Paper Feed/Resume] key lights, press that key.

Cover Open
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Cover Open
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Troubleshooting > Printer Status Monitor Errors > Duplex Unit Not Detected

Duplex Unit Not Detected

The duplex unit is not attached correctly. Follow the procedure below to attach the duplex unit correctly.

1.  Re-attach the duplex unit.

2.  Move the duplex unit locks to the locked position.

3.  If the [Test Paper Feed/Resume] key lights, press that key.

❍     Even if you are not duplex printing, the duplex unit must be attached. Otherwise printing will not start.

Top Previous Next
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Duplex Unit Not Detected
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Troubleshooting > Printer Status Monitor Errors > Print Cartridge(s) Not Detected

Print Cartridge(s) Not Detected

A Print cartridge is not installed correctly. Follow the procedure below to install the Print cartridge correctly.

1.  Open the right front cover.

2.  Push in the cartridge using the PUSH area.

3.  Close the right front cover.

Print Cartridge(s) Not Detected
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Print Cartridge(s) Not Detected

●     If the error persists, take the Print cartridge out once, and then install it again. The procedure above should be performed only once.
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Troubleshooting > Printer Status Monitor Errors > Paper in Bypass Tray

Paper in Bypass Tray

This appears if paper is set before printing from the bypass tray starts. Follow the procedure below to remove the 
paper in the bypass tray.

1.  Remove paper.

2.  Press the [Test Paper Feed/Resume] key.

❍     The [Test Paper Feed/Resume] key stops blinking and stays lit.

3.  Insert a sheet of paper into the bypass tray with the print side face up.

Paper in Bypass Tray
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Paper in Bypass Tray

❍     Support the sheet with your hands to keep it from sliding out and dropping.

❍     Insert the sheet straight into the bypass tray.

4.  Press the [Test Paper Feed/Resume] key, and then push the sheet into the printer a little.

Printing starts.
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Paper in Bypass Tray

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/t0019.htm (3 of 3)2005/10/05 11:27:20



Troubleshooting > Printer Status Monitor Errors > Cartridge End

Cartridge End

A Print cartridge is empty. Printing can continue using ink remaining in the printer; however, no ink is left in the Print 
cartridge. Check which color of cartridge needs to be replaced, and then replace it.

Checking ink color

●     Checking using the Printer Status monitor

❍     In the illustration above, the cyan Print cartridge is empty.

●     Checking the low ink indicators

❍     Blinking

In the illustration above, the cyan Print cartridge is empty.

❍     From left to right, the low ink indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print 

cartridges.

Cartridge End
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Cartridge End

❍     Since solid color printing on semi-gloss photo paper consumes a lot of ink of that color, printing may stop in the middle of 

the printing process because ink of that color is depleted.

❍     Do not perform a normal head cleaning or a full head cleaning unless it is necessary. Ink may run out making printing 

impossible.

❍     If you turn the power off and then on again, ink adjustment is performed in the printer which may result in the ink running 

out.

●     Replacing a Print Cartridge

●     Displaying the Printer Status
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Troubleshooting > Printer Status Monitor Errors > Ink End

Ink End

The ink is completely depleted. Printing cannot be performed. Replace the Print cartridge.

Checking ink colors

●     Checking using the Printer Status monitor

❍     In this illustration, the cyan Print cartridge has completely run out.

●     Checking the low ink indicators

❍     Lit

In this illustration, the cyan Print cartridge has completely run out.

❍     From left to right, the low ink indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print 

cartridges.

Ink End
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Ink End

❍     Head cleaning cannot be performed.

●     Replacing a Print Cartridge

●     Displaying the Printer Status
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Troubleshooting > Printer Status Monitor Errors > Out of Printable Temperature Range

Out of Printable Temperature Range

Follow the procedure below to relocate the printer when the temperature inside the printer is inappropriate, extremely 
high or low, for printing.

1.  Turn off the power of the printer.

2.  Place the printer in a 10 to 32°C (50 to 89.6°F) environment.

3.  Turn on the power of the printer.

●     If humidity is more than 54%, the high end of the appropriate temperature range will be lower than usual.

●     Even after the power is turned on, the printer may remain in the standby mode until it acclimates to the room temperature. If this happens, 

wait until the [Power] key stops blinking and stays lit.

●     For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation 

Area", the Setup Guide.
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Out of Printable Temperature Range
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Troubleshooting > Printer Status Monitor Errors > Printer Error

Printer Error

An error has occurred in the printer. Turn the power off once, and then turn it back on.

●     If the printer is relocated from a cold area to a warm area or the printer is placed in a room where the temperature varies greatly, 

condensation may form inside the printer causing errors. If this happens, an error might not clear if the power is turned off and then on. Wait 

until the printer acclimates and the condensation disappears. This should take about one hour.

●     If the error still does not clear after the printer acclimates to room temperature and the power is turned back on, contact your sales or service 

representative.
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Printer Error
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Troubleshooting > Adjusting the Printer

Adjusting the Printer

Adjust the printer from the [Maintenance] tab in the printer properties dialog box.

●     Clean Print-heads (Normal)

●     Clean Print-heads (Full)

●     Adjust Print-head Positions

●     Registration

●     Adjust Paper Feed
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Adjusting the Printer

file:///E|/pdf_file/5/printer/g500/opmanual/g700/Op_Guide/acc/0135.htm2005/10/05 11:27:26

Contents Previous Next Settings

javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();


Troubleshooting > Error Indicator Summary

Error Indicator Summary

You can check the status of the printer using the lit or blinking indicators on the control panel.

1.  Low ink indicators

2.  [Power] key

3.  [Test Paper Feed/Resume] key

4.  [Cancel] key

Status of Indicators Status/Solutions

A low ink indicator is lit.

(The [Power] key may be lit or blinking at the same time.)

The printer has completely run out of the indicated ink.

(In the illustration, the printer has run out of cyan ink.)

Further printing is impossible. Check the color 
indicated, and replace the corresponding print cartridge 
immediately.

Ink End.

Error Indicator Summary
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Error Indicator Summary

A low ink indicator is blinking.

(The [Power] key may be lit or blinking at the same time.)

The corresponding print cartridge has run out of ink.

(In the illustration, the cyan print cartridge has run out 
of ink.)

Printing can continue with the ink remaining in the 
printer, but there is no more ink in the print cartridge. 
Check the color indicated, and replace the 
corresponding print cartridge.

Cartridge End.

All the low ink indicators are lit.

(The [Power] key may be lit or blinking at the same time.)

The print cartridges are not installed or are not installed 
correctly.

Install the print cartridges correctly.

Print Cartridge(s) Not Detected.

All the indicators are blinking.

A maintenance error has occurred.

Turn the power off, and then on.

If that does not clear the error, contact your sales or 
service representative.

Where to Inquire.

The [Test Paper Feed/Resume] key is lit.

(The [Power] key may be lit or blinking at the same time.) There may be a problem with feeding paper.

Check the printer and paper, and then press the [Test 
Paper Feed/Resume] key.

Paper Is Not Fed or Delivered Normally.
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Error Indicator Summary

The paper tray may be empty.

Load the paper tray, and then press the [Test Paper 
Feed/Resume] key.

Loading Paper.

The [Power] key is blinking.

The printer is either warming up or receiving print data.

(If the blinking is slow, the printer is in standby mode 
with its main power off.)

If the blinking continues, the temperature inside the 
printer may be outside of the operating temperature 
range.

Turn the power off, move the printer to a location 
where the temperature is within the range 10-32°C (50-
89.6°F), and then turn the power on.

Out of Printable Temperature Range.

The [Test Paper Feed/Resume] key is blinking.

(The [Power] key may be lit or blinking at the same time.)

The duplex unit may not be installed correctly.

Install the duplex unit correctly, and then press the 
[Test Paper Feed/Resume] key.

Duplex Unit Not Detected.

A cover may be open.

Close the cover, and then press the [Test Paper Feed/
Resume] key.

Cover Open.

Paper may be jammed.

Remove the jammed paper, and then press the [Test 
Paper Feed/Resume] key.

Paper Jam.

The temperature inside the printer may have gone 
outside of the operating temperature range while the 
power was on, or the temperature may be outside of the 
operating temperature range now.

Turn the power off, move the printer to a location 
where the temperature within the range 10-32°C (50-
89.6°F), and then turn the power on.

Out of Printable Temperature Range.
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Error Indicator Summary

Paper of the correct size may not be loaded.

Load paper of the correct size, or change the printer 
driver settings.

Paper Size Mismatch (Bypass Tray),Paper Size 

Mismatch (Tray 1), and Paper Size Mismatch (Tray 2).

●     For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation 

Area", the Setup Guide.
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Replacing a Print Cartridge > Checking the Remaining Ink

Checking the Remaining Ink

Follow the procedure below to check when to replace Print cartridges using the Printer Status monitor or the low ink 
indicators.

Checking using the Printer Status monitor

1.  Open the printer properties dialog box.

2.  Click the [Maintenance] tab.

3.  Click [Printer Status].

The Printer Status monitor dialog box appears.

4.  Check the ink level illustration.

In the illustration above, the cyan Print cartridge is empty.

If the background of the image in the top left corner of dialog box is yellow, the indicated cartridge is empty. 
Replace the cartridge.

Checking the Remaining Ink
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Checking the Remaining Ink

In this illustration, the cyan ink has completely run out.

If the background of the image in the top left corner of dialog box is red, the printer has run out of the indicated 
ink. Replace the cartridge.

Checking the low ink indicators of the printer

●     Blinking

In the illustration above, the cyan Print cartridge is empty.

●     Lit

In the illustration above, the cyan ink has completely run out.

●     From left to right, the low ink indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print cartridges.

●     Opening the Printer Status Monitor

Top Previous Next
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Checking the Remaining Ink
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Replacing a Print Cartridge > Replacing a Print Cartridge

Replacing a Print Cartridge

Follow the procedure below to replace an empty Print cartridge.

Clear any errors, such as when there is a paper jam or when no paper is loaded, before replacing a Print cartridge.

1.  Remove the Print cartridges' packaging.

❍     If multiple cartridges are empty, replace all the empty cartridges. You can shorten the time for needed replacement.

2.  Open the right front cover.

3.  Take out the empty cartridges.

4.  Check the cartridges' orientation, and then install them gently.

Install in the following order from the left: black, cyan, magenta, and yellow.

❍     Take care to install the cartridges in the correct position.

5.  Push in the cartridge using the PUSH area.

Replacing a Print Cartridge
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Replacing a Print Cartridge

6.  Close the right front cover.

●     Recommended Consumables
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Replacing a Print Cartridge > Handling Print Cartridges

Handling Print Cartridges

Important points about handling Print cartridges are explained.

 
●     If ink comes into contact with your eyes, rinse immediately in running water. For other symptoms, consult a doctor.

 
●     If ink is ingested, induce vomiting by drinking a strong saline solution. Consult a doctor immediately.

 
●     If your skin comes into contact with ink, immediately wash the affected area with water or soap and water.

 
●     Keep the ink or ink container out of reach of children.

About Print cartridges

●     Print cartridges comply with the manufacturer's safety specifications. To ensure safety and reliability, 
use genuine Print cartridges.

●     When using the printer for the first time, install the Print cartridges supplied with the printer.

Using Print cartridges

●     Print cartridges should be opened before their expiration date and used within six months of being 
opened.

●     Do not open the package of a Print cartridge until the cartridge will be installed in the printer.

●     Do not touch the ink supply port of Print cartridges.

●     Do not shake Print cartridges strongly. Ink may leak out. 

●     Do not take apart Print cartridges.

●     Do not open the right front cover except when installing Print cartridges. Do not turn off the power or 
unplug the power cord during the process of installing the cartridges.

●     Always confirm the color of a Print cartridge before installing it.

●     Do not remove a Print cartridge once it has been installed unless necessary.

●     Do not remove a Print cartridge while printing is being performed. Printing will stop.

Storing Print cartridges

●     Avoid storing Print cartridges in hot or freezing places.

Ink consumption

●     In addition to printing, ink is consumed when the power is turned on, head cleaning is performed, or 
Print cartridges are installed.

Handling Print Cartridges
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Handling Print Cartridges
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Sharing the Printer > Setting Up a Server

Setting Up a Server

Follow the procedure below to set up a print server so that the printer can be shared by users.

●     Configure a computer connected to the printer as the print server.

●     The print server is a computer used to manage the shared printer on the network.

1.  On the [Start] menu, point to [Settings], and then click [Control Panel].

2.  Double-click [Network].

3.  Click [File and Print Sharing...].

4.  Select the [I want to be able to allow others to print to my printer(s).] check box.

5.  Click [OK].

6.  Install the printer driver.

7.  On the [Start] menu, point to [Settings], and then click [Printers].

❍     Under Windows XP Professional, click [Printers and Faxes] on the [Start] menu.

❍     Under Windows XP Home Edition, click [Control Panel] on the [Start] menu. Click [Printers and Other Hardware], and then click 

[Printers and Faxes].

8.  Click the icon of the printer, and then click [Sharing...] on the [File] menu.

9.  Click [Shared as:], and then enter a name in the [Shared as:] box.

10.  Click [OK].

●     Configure a computer connected to the network, where the print server is connected, as a client computer.

●     For details about installing the printer driver, see "Installing the Printer Driver", the Setup Guide.

●     Setting Up a Client Computer
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Sharing the Printer > Setting Up a Client Computer

Setting Up a Client Computer

Follow the procedure below to configure a computer as a client computer and connect it to the shared printer. Make 
this setting when installing the printer driver from the CD-ROM provided.

●     For Windows 2000/XP, Windows Server 2003, and Windows NT 4.0, log on as an administrator (a user with an administrator right).

●     Configure a computer connected to the network where the print server is connected.

1.  Start Windows, and then insert the "Drivers & Manual" CD-ROM into the CD-ROM drive.

❍     Quit all other applications currently running.

❍     When starting Windows, a wizard for adding new hardware may open. If this happens, click [Cancel]. Check again that the power is 

off, and then proceed to step 2..

❍     When the CD-ROM is inserted, the [Drivers and Manual] dialog box appears. If it does not, double-click the CD-ROM drive icon 

under [My Computer] or [Explorer], and then double-click [SETUP.EXE].

2.  Select a language for the interface, and then click [OK].

The following languages are available:

Deutsch (German), English (English), Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands 
(Dutch) The default interface language is English.

3.  Click [Printer Driver].

4.  Read the license agreement, and then click [I accept the agreement.].

5.  Click [Next >].

6.  Click [Connected via LAN].

7.  Click [Next >].

8.  Click the plus mark next to a printer name.

9.  Click [Port:] under [Printer Name:].

10.  Click [Add].

The [Add Port] dialog box appears.

11.  Click [Network Printer].

12.  Click [OK].

13.  Select a shared printer.

14.  Click [OK].

15.  Check that [<\\servername\sharedprintername>] appears after [Port:].

Installation starts.

Setting Up a Client Computer
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Setting Up a Client Computer

16.  Click [Finish].

17.  Check the installation result, and then click [Finish].

❍     If the message prompting you to restart the computer appears, restart the computer.

●     For details about installing the printer driver, see "Installing the Printer Driver", the Setup Guide.

●     Setting Up a Server
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Inquiries and Consumables > Where to Inquire

Where to Inquire

For inquiries, contact your sales or service representative.
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Inquiries and Consumables > Recommended Consumables

Recommended Consumables

Consumables recommended for this printer are listed.

Purchase necessary consumables before your supply runs out.

For information about consumables, contact your sales or service representative.

Print cartridges

●     Large capacity type

●     Regular type

Top Previous Next
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Inquiries and Consumables > Option and Consumables

Option and Consumables

The optional PAPER FEED UNIT TYPE700 is available. If installed, a large number of prints can be made at one 
time using plain paper.

●     For information about options and consumables, contact your service representative.
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Additional Information > Color Guide

Color Guide

The RGB and CMYK color models are explained.

Related topics

Color Printing Mechanism 

Color Production Method of Printers 
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Additional Information > Color Guide > Color Printing Mechanism

Color Printing Mechanism

The three primary colors of light (RGB) and the three primary colors of Pigment (CMY)

All light can be produced using a mixture of three colors known collectively as RGB. R stands for red, G for 
green, and B for blue. When mixed in the same proportion, white light is created.

●     The three RGB colors are called the primary colors of light. The RGB colors are also used to produce the colors displayed on the 

screen of a computer.

Printed colors are produced using a mixture of the three CMY colors. C stands for cyan, M for magenta, and Y 
for yellow. When mixed in the same proportion, black is created.

●     The CMY colors are called the primary colors of pigment. Printers use CMY colored ink plus K (black) colored ink to print in full 

color.

The primary colors of light (RGB) can be mixed to produce the secondary colors of cyan, magenta, and yellow. 
Conversely, the primary colors of pigment (CMY) can be mixed to produce red, green, and blue. When two 
primary colors are mixed, the resulting color is the complimentary color of the remaining primary color. Red 
and cyan, green and magenta, and blue and yellow are pairs of complementary colors.
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Color Printing Mechanism
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Additional Information > Color Guide > Color Production Method of Printers

Color Production Method of Printers

Printers use cyan (C), magenta (M), and yellow (Y) colored ink plus black (K) colored ink to print in full color.

●     If equal proportions of the three CMY colors are mixed, in theory, pure black should be produced. In practice, the resulting printed color is 

not pure black and has an inferior feel due to the limitations of printing. In order to reproduce a distinct black color, normally black ink is 

used when printing color images.

For example, a cyan image can be printed using only cyan ink without any complications; however, a full color image 
can be made up of over 16 million subtlety different colors. These complicated colors are produced by translating 
them into proportions of CMYK ink dots per unit area.

In addition, the same color in an image can have lighter and darker parts. These shades of color are produced by 
varying the amount of ink dots per unit area.
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Additional Information > Guide to Components

Guide to Components

The names and functions of parts of the printer body, control panel, and options are explained.

Related topics

Printer Body 

Printer Rear 

Control Panel 

Option 
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Additional Information > Guide to Components > Printer Body

Printer Body

1.  Top cover

Keep this cover closed during printing. If you cannot locate paper jams, or jammed paper cannot be removed easily, you 
can check the condition of paper from the top of the printer.

2.  Envelope selector

For envelopes, set the lever to the rear position ; for everything else, set the lever to the forward position .

3.  Print cartridge (yellow)

4.  Print cartridge (magenta)

5.  Print cartridge (cyan)

6.  Print cartridge (black)

7.  Right front cover

Open to install or replace Print cartridges.

8.  Tray 1

Load paper here.

9.  Output tray extension

Pull out when using paper larger than A4 to keep the printed paper from falling.

10.  Output tray

Prints are delivered to this tray.

When using paper larger than A4, pull out the output tray extension.
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Additional Information > Guide to Components > Printer Rear

Printer Rear

1.  USB slot

Connect the USB cable from the computer here.

2.  Duplex unit cover button

Press to open the duplex unit cover.

3.  Bypass tray

Insert paper by hand here. Insert thick paper and label paper.

4.  Power cord

Plug the power cord into a wall outlet.

Connect the grounding wire attached to the power plug directly to a grounding terminal.

5.  Duplex unit locks

Use to lock or unlock the duplex unit when attaching or detaching it.

6.  Duplex unit cover

Open to remove paper jammed inside the duplex unit.

7.  Vent

Air is vented here to prevent the inside of the printer from getting too warm. Do not lean anything against the vent or block 
it in any way. If the inside of the printer gets too warm, a breakdown could occur.

8.  Guide board

Open to remove paper jammed inside the printer.

9.  Paper feed wheel

Printer Rear
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Printer Rear

Use to wind out paper jammed around the guide board.

10.  Bypass tray guides

Slide the left and right guides in to match the size of paper being used in the bypass tray.

11.  Bypass tray extension

Pull this out when printing using the bypass tray.

12.  Duplex unit

Turns the paper over when performing duplex printing.
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Additional Information > Guide to Components > Control Panel

Control Panel

1.  Low ink indicators

❍     The indicators correspond to the positions of the Print cartridges. From left to right, the low ink indicators display 
the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print cartridges.

❍     When an indicator is blinking, the corresponding Print cartridge is empty. Printing can continue using the ink 
remaining in the printer, but the Print cartridge should be replaced soon.

❍     When an indicator is lit, the ink of the corresponding color has completely run out. Printing cannot be performed. 
The Print cartridge should be replaced immediately.

❍     When all ink indicators are lit, a Print cartridge is not installed or is incorrectly installed. Make sure that the Print 
cartridges are correctly installed.

2.  [Power] key

❍     Press to turn the power on and off.

❍     To turn the power on, press the key for one second until it lights.

❍     After the power is turned on, the [Power] key will blink until the printer is ready for printing at which point the key 
will stop blinking and stay lit.

❍     The [Power] key will also blink when the printer is processing data.

❍     When the power is turned off, the key will blink slowly until the printer has completely shut down at which point 
the key will be dark.

❍     When the power is off, while holding down the [Cancel] key and the [Test Paper Feed/Resume] key, press and hold 
down the [Power] key for over three seconds. The low ink indicators will light once and a print sample will be 
delivered.

❍      means "standby".

3.  [Test Paper Feed/Resume] key

❍     Press to resume printing after dealing with an error.

❍     This key lights or blinks when paper runs out or a paper jam or error occurs.

❍     When using the bypass tray, press this key to start printing after inserting paper.

❍     When the power is off, while holding down the [Test Paper Feed/Resume] key, press and hold down the [Power] 
key for over three seconds. The low ink indicators will light once and a blank sheet will be delivered.

4.  [Cancel] key

❍     Press to cancel printing.

❍     If the [Cancel] key is pressed and held down for over three seconds, the [Power] key will blink and head cleaning 

Control Panel
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Control Panel

will be performed for all four colors.

❍     When the power is off, while holding down the [Cancel] key, press and hold down the [Power] key for over three 
seconds. The low ink indicators will light once and the nozzle check test pattern will be printed.
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Additional Information > Guide to Components > Option

Option

PAPER FEED UNIT TYPE700

1.  Tray 2

Load plain paper here.

2.  Tray 2 rear cover

Open to remove paper jammed in tray 2.

3.  Tray cover

This is attached to tray 2.

Take this cover off when loading paper.
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Additional Information > Cleaning

Cleaning

Clean the outside of the printer regularly to maintain the condition of the printer.

 
●     To avoid hazardous electric shock, do not remove any covers or screws other than those specified in this manual. When 

the machine needs to be checked, adjusted, or repaired, contact your service representative.

●     Do not take apart or attempt any modifications to this machine. There is a risk of fire, electric shock, explosion or loss 
of sight.

To clean the exterior of the printer, wipe it with a soft, dry or damp cloth. If the dirt does not come off, wipe the 
printer first with a cloth moistened with a neutral detergent, then with a damp cloth, and finally with a dry cloth.

●     Do not use volatile chemicals like benzene or thinner, or insecticides on the printer. Using these chemicals could deform, crack, or change 

the color of the printer.

●     When wiping the printer with a cloth moistened with detergent, be sure to wipe only the exterior.
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Additional Information > Moving

Moving

The precautions when moving the printer a short distance or long distance are explained.

Related topics

Moving a Short Distance 

Moving a Long Distance 
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Additional Information > Moving > Moving a Short Distance

Moving a Short Distance

The precautions when moving the printer a short distance or long distance are explained.

 
●     The printer weighs approximately 11 kg (24.3 lb.).

●     When moving the machine, hold the machine by the bottom below the two indentations. Lift the machine slowly in 
order to avoid straining your body. Lifting the machine without sufficient strength or assistance or handling it roughly 
and dropping it could cause an injury.

 
●     Unplug the power cord from the wall outlet before you move the machine. While moving the machine, you should take 

care that the power cord will not be damaged under the machine.

 
●     When you disconnect the power plug from the wall outlet, always pull the plug (not the cable).

1.  Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet.

❍     To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching 

off in any other way may leave the print heads uncapped, possibly leading to printing problems.

2.  Hold the bottom of the printer below the indents on the lower sides of the printer, and then slowly lift 

and move the printer without tilting it.

Moving a Short Distance
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Additional Information > Moving > Moving a Long Distance

Moving a Long Distance

1.  Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet.

❍     To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching 

off in any other way may leave the print heads uncapped, possibly leading to printing problems.

2.  Pack the printer for transport when moving it a long distance such as when changing office or residence. 

Disconnect all cables, place the printer in the box it was in when purchased, and transport in a level 

manner.

Contact sales or service representative for details.

●     The inside of the printer may become dirty if the printer is not level when transported.
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Additional Information > When Not Using for a Long Period of Time

When Not Using for a Long Period of Time

When the printer will not be used for a long period of time, turn the power off, disconnect the USB cable, and unplug 
the power cable from the wall outlet.

Be careful of the following:

●     The nozzles of the print-heads may dry out and become clogged. To prevent this, periodically print something. 
Even if you do not print anything, turn the printer on for a few minutes once a month.

●     If you do not use the printer for a long period of time, always check if the nozzles are clogged by printing a 
nozzle check test pattern. Clean the print-heads as necessary, and then begin printing.

●     If you do not use the printer for a long period of time, printing may not be performed normally even if head 
cleaning is performed multiple times. If this happens, turn the power off and leave the printer alone for a while. 
Then, turn the power on again and perform the nozzle check and head cleaning.

●     After head cleaning is performed multiple times, clogged ink will dissolve over time, and normal printing may become possible.

●     If there is no improvement after performing the steps above, contact sales or service representative.

●     Where to Inquire

●     Nozzle Check

●     Clean Print-heads (Normal)

●     Clean Print-heads (Full)
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Additional Information > Specifications

Specifications

Specifications of the printer and options are listed.

Related topics

Printer Body 

Option (Paper Feed Unit) 
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Additional Information > Specifications > Printer Body

Printer Body

Print speed

Measurements according to the manufacturer's measurement system

Black draft: 20 ppm

Black standard (speed priority): 19 ppm

Color draft: 20 ppm

Color standard (speed priority): 18 ppm

Depending on the operating environment, printing may take longer than normal.

Print direction

Supports bidirectional, minimum distance printing

Print resolution

Max 3600 × 1200 dpi equivalent

Nozzles

Black: 384 nozzles

Cyan, magenta, and yellow: 384 nozzles per color

Paper sizes (Tray 1 : standard)

A4 (portrait), B5 (portrait), A5 (landscape), A6 (portrait), Legal (portrait), Letter (portrait), 5 1/2"×8 

1/2" (landscape), Exective (portrait) (184.2 mm × 266.7 mm (7.3 × 10.5 inches)), F (portrait) (203.2 mm × 330.2 

mm (8.0 × 13.0 inches)), Foolscap (F4) (portrait) (215.9 mm × 330.2 mm (8.5 × 13.0 inches)), Folio (portrait) 
(209.5 mm × 330.2 mm (8.3 × 13.0 inches)),

Custom paper sizes: 148-356 mm (length) × 90-216 mm (width), (5.9-14.1 inches (length) × 3.6-8.5 inches 
(width))

Paper sizes (Bypass tray)

Standard paper size: A4 (portrait), B5 (portrait), A5 (landscape), A6 (portrait), Legal (portrait), Letter (portrait), 

5 1/2"×8 1/2" (landscape), Exective (portrait) (184.2 mm × 266.7 mm (7.3 × 10.5 inches)), F (portrait) (203.2 

mm × 330.2 mm (8.0 × 13.0 inches)), Foolscap (F4) (portrait) (215.9 mm × 330.2 mm (8.5 × 13.0 inches)), 
Folio (portrait) (209.5 mm × 330.2 mm (8.3 × 13.0 inches)), Com10 (portrait) (104.8 mm × 241.3 mm (4.2 × 
9.5 inches)), Monarch (portrait) (98.4 mm × 190.5 mm (3.9 × 7.5 inches)), C6 (portrait) (114 mm × 162 mm 
(4.5 × 6.4 inches)), C5 (portrait) (162 mm × 229 mm (6.4 × 9.1 inches)), DL Env (portrait) (110 mm × 220 mm 
(4.4 × 8.7 inches))

Custom paper sizes: 148-1295.4 mm (length) × 90-216 mm (width), (5.9-51.0 inches (length) × 3.6-8.5 inches 
(width))

Paper sizes (Duplex unit)

A4 (portrait), B5 (portrait), A5 (horizontal), A6 (portrait), Letter (portrait), 5 1/2"× 8 1/2" (horizontal), Exective 

(portrait)

Paper type

Plain paper

Recycled paper

Color paper

Printer Body
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Printer Body

Inkjet plain paper

Semi-gloss photo paper

Inkjet transparency

Paper weight

Tray 1/optional tray: 60-105 g/m2 (114.7-198.5 lb.)

Bypass tray: 60-163 g/m2 (114.7-297.7 lb.)

Paper capacity

Tray 1: 200 sheets

Bypass tray: 1 sheet

Maximum paper capacity

700 sheets (with the optional tray installed)

Output tray capacity

150 sheets

The capacity may be less depending on the images printed.

Power supply

220-240 V, 0.4 A, 50/60 Hz (when fully equipped)

Power consumption

Average power consumption while printing: 30 W or less (not including options)

less than 39 W (when fully equipped)

Energy Saver mode: less than 6 W

When power is off: 0.3 W or less

To avoid any power consumption, disconnect the power plug from the wall outlet.

(Disconnect the power plug after turning the power off with the [Power] key.)

Operating environment

Temperature: 10 to 32°C (50 to 89.6°F))

Humidity: 15-80% RH (maximum wet-bulb temperature: 25°C (77°F) )

Printing may stop to protect the printer for conditions outside those described above.

Storage environment

Temperature: -20 to 43°C (-4 to 109.4°F)

Humidity: 15-80% RH

External dimensions

(W × D × H) 490 × 469 × 218 mm (19.3 × 18.5 × 8.6 inches)

Weight

Approximately 11 kg (24.3 lb.) (printer body with consumables)

Noise emission

Approximately 49 dB (high quality mode)

Interface

USB 2.0 high speed

Printer language

RPCS Raster

Print cartridges

Types and yields measured using A4 (Letter) 5% chart printed in standard (speed priority) mode.

Two kinds of Print cartridges with different yields can be used.

Print cartridge black: approximately 1450 sheets
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Printer Body

Print cartridge cyan: approximately 1000 sheets

Print cartridge magenta: approximately 1150 sheets

Print cartridge yellow: approximately 1150 sheets

Print cartridge black, large capacity type: approximately 2900 sheets

Print cartridge cyan, large capacity type: approximately 2000 sheets

Print cartridge magenta, large capacity type: approximately 2300 sheets

Print cartridge yellow, large capacity type: approximately 2300 sheets

The printing yields of Print cartridges vary depending on the number of times head cleaning is performed.Also, 
the printing yields of the Print cartridges packaged with the printer are lower than the yields of the Print 
cartridges available for purchase separately.
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Additional Information > Specifications > Option (Paper Feed Unit)

Option (Paper Feed Unit)

PAPER FEED UNIT TYPE700

Paper sizes

A4 (portrait), B5 (portrait), Legal (portrait), Letter (portrait), Exective (portrait) (184.2 mm × 266.7 mm 
(7.3 × 10.5 inches)), F (portrait) (203.2 mm × 330.2 mm (8.0 × 13.0 inches)), Foolscap (F4) (portrait) 
(215.9 mm × 330.2 mm (8.5 × 13.0 inches)), Folio (portrait) (209.5 mm × 330.2 mm (8.3 × 13.0 inches))

Paper type

Plain paper

Recycled paper

Color paper

Paper weight

60-105 g/m2 (114.7-198.5 lb.)

Paper capacity

500 sheets

External dimensions

(W × D × H) 485 × 468 × 115 mm (19.1 × 18.5 × 4.6 inches)

Weight

Approximately 4 kg (8.9 lb.)
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Additional Information > Electromagnetic Interference

Electromagnetic Interference

If another electronic device is placed next to the printer, each will influence the other negatively. In the case of a 
television or radio, noise may be generated. If this happens, do the following:

●     Move the television or radio as far as possible from the printer.

●     Change the position of the antenna of the television or radio.

●     Use a different wall outlet on a different circuit.
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Additional Information > About NetBSD

About NetBSD

For software installed on this printer such as a controller, the NetBSD operating system is used.

1.  Copyright Notice of NetBSD

For all users to use this product:

This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its 
authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright 
notice applicable for each of the files/binaries, the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/.

Copyright (c) 1999, 2000 The NetBSD Foundation, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:

1.Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met:

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS ``AS 
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

2.  Authors Name List

All product names mentioned herein are trademarks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned in this 
document:

This product includes software developed by Jonathan R. Stone for the NetBSD Project.

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

This product includes software developed by Manuel Bouyer.

This product includes software developed by Charles Hannum.

This product includes software developed by Charles M. Hannum.

About NetBSD
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About NetBSD

This product includes software developed by Christopher G. Demetriou.

This product includes software developed by TooLs GmbH.

This product includes software developed by Terrence R. Lambert.

This product includes software developed by Adam Glass and Charles Hannum.

This product includes software developed by Theo de Raadt.

This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD Project.

This product includes software developed by the University of California, Lawrence Berkeley Laboratory and 
its contributors.

This product includes software developed by Christos Zoulas.

This product includes software developed by Christopher G. Demetriou for the NetBSD Project.

This product includes software developed by Paul Kranenburg.

This product includes software developed by Adam Glass.

This product includes software developed by Jonathan Stone.

This product includes software developed by Jonathan Stone for the NetBSD Project.

This product includes software developed by Winning Strategies, Inc.

This product includes software developed by Frank van der Linden for the NetBSD Project.

This product includes software developed for the NetBSD Project by Frank van der Linden

This product includes software developed for the NetBSD Project by Jason R. Thorpe.

The software was developed by the University of California, Berkeley.

This product includes software developed by Chris Provenzano, the University of California, Berkeley, and 
contributors.

Copyright (c) 1993 by Sun Microsystems, Inc. All rights reserved.

Developed at SunPro, a Sun Microsystems, Inc. business.

Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is 
preserved.

Copyright (c) 1995 Carnegie-Mellon University.

All rights reserved.

Author: Chris G. Demetriou

Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided 
that both the copyright notice and this permission notice appear in all copies of the software, derivative works 
or modified versions, and any portions thereof, and that both notices appear in supporting documentation.

CARNEGIE MELLON ALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" ONDITION. 
CARNEGIE MELLON DISCLAIMS ANY LIABILITY OF ANY KIND FOR ANY DAMAGES 
WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE.

Carnegie Mellon requests users of this software to return to

Software Distribution Coordinator or Software.Distribution@CS.CMU.EDU

School of Computer Science

Carnegie Mellon University

Pittsburgh PA 15213-3890

any improvements or extensions that they make and grant Carnegie the rights to redistribute these changes.
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Additional Information > Trademarks

Trademarks

Adobe and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries.

Pentium is a registered trademark of Intel Corporation.

Netscape is a registered trademark of Netscape Communication Corporation in the U.S. and/or other countries.

Macromedia and Flash are either registered trademarks or trademarks of Macromedia, Inc. in the U.S. and/or other 
countries.

Microsoft, Windows, Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the U.
S. and/or other countries.

Other product names used herein are for identification purposes only and might be trademarks of their respective 
companies. We disclaim any and all rights to those marks.

●     The product name of Windows® 95 is Microsoft® Windows® 95.

●     The product name of Windows® 98 is Microsoft® Windows® 98.

●     The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).

●     The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

●     The product names of Windows® XP are as follows:

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Professional

●     The product names of Windows ServerTM 2003 are as follows:

Microsoft® Windows ServerTM 2003 Standard Edition

Microsoft® Windows ServerTM 2003 Enterprise Edition

Microsoft® Windows ServerTM 2003 Web Edition

●     The product names of Windows NT® 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0
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